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DEPARTMENT 188 - COMMISSION ON LEGAL COUNSEL FOR INDIGENTS 

2025-27 BASE-LEVEL BUDGET 
 

Base Budget - Summary 
 Base Level 
Commission on legal counsel for indigents $23,022,372 
Total all funds $23,022,372 
Less other funds 2,023,067 
Total general fund $20,999,305 
Full-time equivalent (FTE) positions 41.00 

 
Selected Base Budget Information 

  General 
Fund 

 Other 
Funds 

  
Total 

1. Includes funding for the Commission on Legal Counsel for Indigents, 
primarily relating to salaries and benefits for 41 FTE positions 
($9,432,916), temporary salaries ($279,788), travel ($290,998), rent 
($490,308), contracted legal services ($11,625,054), and information 
technology costs ($579,950) 

$20,999,305  $2,023,067  $23,022,372 

 
Continuing Appropriations 

Indigent defense administration fund - North Dakota Century Code Sections 29-07-01.1 and 29-26-22 - Funding is from a 
$35 nonrefundable fee for court-appointed defense services and from a $100 court administration fee in all criminal cases except 
infractions. The first $750,000 collected is used for indigent defense services, the next $460,000 is used for court facilities, and 
additional amounts are deposited equally into the two funds. For the 2021-23 biennium, the fund had $1,481,223 of revenues, 
$1,506,163 of expenditures, and a June 30, 2023, fund balance of $712,404. 
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Historical Appropriations Information 
 

Agency Appropriations and FTE Positions 
 

Agency Funding (Millions) FTE Positions 

  

Ongoing General Fund Appropriations 
 2015-17 2017-19 2019-21 2021-23  2023-25  
Ongoing general fund appropriations $16,982,909 $17,983,876 $18,384,627 $19,294,363 $20,999,305 
Increase (decrease) from previous 
biennium 

N/A $1,000,967 $400,751 $909,736 $1,704,942 

Percentage increase (decrease) 
from previous biennium 

N/A 5.9% 2.2% 4.9% 8.8% 

Cumulative percentage increase 
(decrease) from 2015-17 biennium 

N/A 5.9% 8.3% 13.6% 23.6% 

 
Major Increases (Decreases) in Ongoing General Fund Appropriations 

2017-19 Biennium  
1. Increased funding for operating expenses $130,919 
2. Increased funding for professional fees due to increased caseloads to provide a total of $10,227,500 

for professional fees 
$500,000 

2019-21 Biennium  
 None $0 

2021-23 Biennium   
1. Added funding to provide legal counsel to juveniles $325,000 

2023-25 Biennium  
1. Added funding for 1 FTE investigator position $137,781 
2. Added funding to reduce employee turnover $150,000 
3. Added funding to increase the legal fee rate from $75 per hour to $80 per hour $630,453 

 
One-Time General Fund Appropriations 

 2015-17 2017-19 2019-21 2021-23  2023-25 
One-time general fund appropriations $122,275 $0 $0 $0 $0 

 
Major One-Time General Fund Appropriations 

2017-19 Biennium  
 None $0 

2019-21 Biennium  
 None $0 
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2021-23 Biennium   
 None $0 

2023-25 Biennium   
 None $0 

 



  January 17, 2025 

 

Commission on Legal Counsel for Indigents 
Department No. 188 
2025 Senate Bill No. 2022 
 

EXECUTIVE BUDGET RECOMMENDATION 
2025-27 BIENNIUM 

 
Budget Summary 

 FTE Positions General Fund  Other Funds Total 
Executive budget recommendation 43.00 $24,815,568 $2,054,262 $26,869,830 
Base level 41.00 20,999,305 2,023,067 23,022,372 
Increase (decrease) 2.00 $3,816,263 $31,195 $3,847,458 
Percentage increase (decrease) 4.9% 18.2% 1.5% 16.7% 

 
NOTE: 
More detailed information on the executive budget recommendation is attached as Appendix A. 

A copy of the draft appropriations bill reflecting the executive budget recommendation is attached as Appendix B. 
 

Selected Highlights 
• Salary increases of up to 4 percent effective July 1, 2025, and 3 percent effective July 1, 2026 

• Health insurance increase of $250 per month (15.2 percent), from $1,643 to $1,893, per employee 

• Adds $362,120 of ongoing funding from the general fund for 2 new FTE private investigator positions 

• Adds $805,000 of ongoing funding from the general fund for salary equity increases to implement a 
compensation strategy 

• Adds $1.5 million of ongoing funding from the general fund to increase the rate paid to contract attorneys 
 

Deficiency Appropriations 
There are no deficiency appropriations for this agency. 
 

Significant Audit Findings 
There are no significant audit findings for this agency. 
 

Agency Fees 
As reported to the Legislative Management pursuant to North Dakota Century Code Section 54-35-27, this agency 
did not have any fees. 
 

Major Related Legislation 
Senate Bill No. 2057 - Court fees - Increases the court administration fee from $100 to $200, a portion of which is 
deposited in the indigent defense fund. 
 
NOTE: 
Please see the Fiscal Impact Report for additional information regarding bills under consideration which contain 
either a state revenue impact, an appropriation, or a state fiscal impact. 
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                  Commission on Legal Counsel for Indigents - Budget No. 188
                  Agency Worksheet - Senate Bill No. 2022

FTE
Positions

General
Fund

Other
Funds Total

2025-27 Biennium Base Level 41.00 $20,999,305 $2,023,067 $23,022,372

2025-27 Ongoing Funding Changes
Salary increase $461,575 $13,170 $474,745
Health insurance increase 252,222 6,005 258,227
Adds private investigator FTE positions 2.00 362,120 362,120
Adds funding to implement a new compensation
     strategy

805,000 805,000

Adds funding to increase the contract rate paid to
     attorneys

1,500,000 1,500,000

Adds funding to replace the 2023-25 new FTE pool 137,781 137,781
Adds funding to replace the 2023-25 vacant FTE
     pool

253,594 7,134 260,728

Adds funding for information technology rate
     increases

43,971 4,886 48,857

Total ongoing funding changes 2.00 $3,816,263 $31,195 $3,847,458

One-Time Funding Items
No one-time funding items $0

Total one-time funding changes 0.00 $0 $0 $0

Total Changes to Base Level Funding 2.00 $3,816,263 $31,195 $3,847,458

2025-27 Total Funding 43.00 $24,815,568 $2,054,262 $26,869,830
Federal funds included in other funds $0

Total ongoing changes - Percentage of base level 4.9% 18.2% 1.5% 16.7%
Total changes - Percentage of base level 4.9% 18.2% 1.5% 16.7%

Other Sections in Commission on Legal Counsel for Indigents - Budget No. 188

FTE positions
Section Description

Executive Budget

Executive Budget
Section 2 would authorize the agency to increase or decrease FTE
positions as needed, subject to the availability of funds.

mberndt
Text Box
APPENDIX A



 
Sixty-ninth 
Legislative Assembly 
of North Dakota 
 

SENATE BILL NO. 2022 
(Governor’s Recommendation) 

 
Introduced by 
 

Appropriations Committee 
 

(At the request of the Governor) 
 
A bill for an Act to provide an appropriation for defraying the expenses of the commission on legal counsel for 
indigents and to provide an exemption. 
 
BE IT ENACTED BY THE LEGISLATIVE ASSEMBLY OF NORTH DAKOTA: 
 

SECTION 1. APPROPRIATION. The funds provided in this section, or so much of the funds as may be 
necessary, are appropriated out of any moneys in the general fund in the state treasury, not otherwise 
appropriated, and from special funds derived from other income, to the commission on legal counsel for indigents 
for the purpose of defraying the expenses of the commission on legal counsel for indigents, for the biennium 
beginning July 1, 2025 and ending June 30, 2027, as follows: 

 

   Adjustments or   

 Base Level  Enhancements  Appropriation 

Commission on Legal Counsel $23,022,372  $3,847,458  $26,869,830 

Total All Funds $23,022,372  $3,847,458  $26,869,830 

Less Estimated Income    2,023,067         31,195     2,054,262 

Total General Fund $20,999,305  $3,816,263  $24,815,568 

Full-time Equivalent Positions 41.00  2.00  43.00 
 
  
 SECTION 2. EXEMPTION – FULL-TIME EQUIVALENT POSITION ADJUSTMENTS.  Notwithstanding 
any other provisions of law, the legal counsel for indigents may increase or decrease authorized full-time 
equivalent positions as needed, subject to the availability of funds, during the biennium beginning July 1, 2025, 
and ending June 30, 2027.  The legal counsel for indigents shall report to the office of management and budget 
and legislative council any adjustments made pursuant to this section. 
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Commission on Legal Counsel for Indigents 
Department No. 188 
2025 Senate Bill No. 2022 
 

REVISED EXECUTIVE BUDGET RECOMMENDATION 
2025-27 BIENNIUM 

 
Budget Summary 

 FTE 
Positions 

General 
Fund  

Other 
Funds Total 

Burgum budget recommendation 43.00 $24,815,568 $2,054,262 $26,869,830 
Revisions - Increase (decrease) 0.00 415,748 (2,405) 413,343 
Armstrong budget recommendation 43.00 $25,231,316 $2,051,857 $27,283,173 
Base level 41.00 20,999,305 2,023,067 23,022,372 
Increase (decrease) 2.00 $4,232,011 $28,790 $4,260,801 
Percentage increase (decrease) 4.9% 20.2% 1.4% 18.5% 

 
NOTE: 
More detailed information on the executive budget recommendation is attached as appendix. 
 

Selected Highlights 
• Salary increases of up to 3 percent effective July 1, 2025, and 3 percent effective July 1, 2026 

• Health insurance increase of $250 per month (15.2 percent), from $1,643 to $1,893, per employee 

• Adds $362,120 of ongoing funding from the general fund for 2 new FTE private investigator positions 

• Adds $805,000 of ongoing funding from the general fund for salary equity increases to implement a 
compensation strategy 

• Adds $2 million of ongoing funding from the general fund to increase the rate paid to contract 
attorneys 

 
Deficiency Appropriations 

There are no deficiency appropriations for this agency. 
 

Significant Audit Findings 
There are no significant audit findings for this agency. 
 

Agency Fees 
As reported to the Legislative Management, pursuant to North Dakota Century Code Section 54-35-27, this agency 
did not have any fees. 
 

Major Related Legislation 
House Bill No. 1310 - Defendant reimbursement - Removes authorization for the court to order the defendant to 
reimburse indigent defense costs as a condition of probation. 

Senate Bill No. 2057 - Court fees - Increases the court administration fee from $100 to $200, a portion of which is 
deposited in the indigent defense fund. 

Senate Bill No. 2226 - Legal counsel - Appropriates funding to provide legal counsel services for incarcerated 
individuals at initial appearances. 
 
NOTE: 
Please see the Fiscal Impact Report for additional information regarding bills under consideration which contain 
either a state revenue impact, an appropriation, or a state fiscal impact. 
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                  Commission on Legal Counsel for Indigents - Budget No. 188
                  Agency Worksheet - Senate Bill No. 2022

FTE
Positions

General
Fund

Other
Funds Total

2025-27 Biennium Base Level 41.00 $20,999,305 $2,023,067 $23,022,372

2025-27 Ongoing Funding Changes
Salary increase $377,323 $10,765 $388,088
Health insurance increase 252,222 6,005 258,227
Adds private investigator FTE positions 2.00 362,120 362,120
Adds funding to implement a new compensation 
strategy

805,000 805,000

Adds funding to increase the contract rate paid to 
attorneys

2,000,000 2,000,000

Adds funding to replace the 2023-25 new FTE pool 137,781 137,781
Adds funding to replace the 2023-25 vacant FTE 
pool

253,594 7,134 260,728

Adds funding for information technology rate 
increases

43,971 4,886 48,857

Total ongoing funding changes 2.00 $4,232,011 $28,790 $4,260,801

One-Time Funding Items
No one-time funding items $0

Total one-time funding changes 0.00 $0 $0 $0

Total Changes to Base Level Funding 2.00 $4,232,011 $28,790 $4,260,801

2025-27 Total Funding 43.00 $25,231,316 $2,051,857 $27,283,173
Federal funds included in other funds $0

Total ongoing changes - Percentage of base level 4.9% 20.2% 1.4% 18.5%
Total changes - Percentage of base level 4.9% 20.2% 1.4% 18.5%

Armstrong Executive Budget

nadamski
Text Box
APPENDIX



2025 SENATE STANDING COMMITTEE MINUTES 

Appropriations - Government Operations Division 
Red River Room, State Capitol 

SB 2022 
1/13/2025 

A BILL for an Act to provide an appropriation for defraying the expenses of the 
commission on legal counsel for indigents 

9:30 a.m. Chairman Wanzek opened the hearing.  

Members present: Chairman Wanzek, Vice-Chair Dwyer, Senator Burckhard, Senator 
Erbele, and Senator Sickler. 

Discussion Topics: 
• Agency overview
• Agency mission
• Distribution of state offices
• Cooperation with private law offices
• Case assignment management
• Federal case-load standards
• Management of Felony cases
• Juvenal cases
• Employee turnover rate
• Agency accomplishments and challenges
• Full Time Employee Vacancy rate
• Investigative services
• Budget requests
• Federal grants
• Salary parity
• Duties of investigators

9:31 a.m. Travis Finck, Director, Agency for Legal Counsel for Indigents, testified in favor 
and submitted testimony #28523, # 28522, #28524, #28525, and #28730. 

10:16 a.m. Zachary Pellam, Chairman of the ND Commission of Legal Counsel for 
Indigents, testified in favor. 

10:27 a.m. Tony Weiler, Executive Director, ND State Bar Association, testified in favor. 

10:29 a.m. Jonathan Byers, Attorney, ND States Attorney Association, testified in favor. 

10:32 a.m. Omid Kardoust, Attorney for the Western District of Counsel for Indigents, testified 
in favor. 

10:41 a.m. Jonathan Vanderhoff, Investigator, ND Counsel for Indigents Agency Investigator, 
testified in favor. 



Senate Appropriations Government Operations Division 
SB 2022 
1/13/25 
Page 2  

10:46 a.m. Chairman Wanzek adjourned the meeting. 

Carol Thompson, Committee Clerk 



One Page Itemized Listing of Requested Changes from Executive Budget Recommendation  
Senate Appropriations – Government Operations Division 

SB 2022 
January 13, 2025 

 
Current 2023-

2025 biennium 

level 

Requested level 

in 2025-2027 

budget 

Burgum 

Recommendation 

Armstrong 

Recommendation 

Commission 

Recommendation 

after executive 

budget 

41 Full Time 

Employees 

Increase 5 FTE 

$905,300 

Increase 2 FTE 

$362,120 

Not yet released Increase 5 FTE to 46 

FTE 

This is important to 

give us an 

investigator in each 

public defender office 

Implement Step 

program to be 

competitive 

$805,000 for 

employee 

increases 

$805,000 for 

employee increases 

Not yet released No Change from 

Executive 

Recommendation 

Pay increase for 

contract 

attorneys 

Increase to 60% 

of CJA Rate at 

cost of 

$5,255,134 

Increase of 

$1,500,000 from 

General Fund to 

increase pay rate of 

contracted attorneys  

Not yet released Gov. Burgum 

proposed 1,500,000 

this biennium and 

more next biennium 

for a gradual 

increase, we prefer 

the money now given 

our struggles to 

recruit against CJA 

We request the 

$5,255,134 

 
Governor Burgum in his Executive Budget recommended restoring vacant/new FTE funds in the amount of 
$391,375 in General Funds and $7,134 in Special Funds.  We would agree with the governor’s recommendation on 
this. 

#28522



SB 2022
N.D. Comm. on Legal Counsel for Indigent

Senate Appropriations: Government Operations Division 
Budget Presentation

January 13, 2025

Travis W. Finck
Executive Director

#28523
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Presentation Notes
Animated tipping scales
(Difficult)


To reproduce the shape effects on this slide, do the following:
On the Home tab, in the Slides group, click Layout, and then click Blank.
On the Home tab, in the Drawing group, click Shapes, and under Basic Shapes select Oval (first row, second option from the left). Press and hold SHIFT and on the slide, drag to draw a circle.
Select the oval. Under Drawing Tools, on the Format tab, in the Size group, do the following:
In the Shape Height box enter 2.16”.
In the Shape Width box enter 2.16”.
With the oval still selected, on the Home tab, in the bottom right corner of the Drawing group, click the Format Shape dialog box launcher. In the Format Shape dialog box, click Fill in the left pane, and in the Fill pane, do the following:
Select Solid fill.
Click the button next to Color, and then under Theme Colors select White, Background 1, Darker 25% (fourth row, first option from the left).
Also in the Format Shape dialog box, click Line Color in the left pane, and in the Line Color pane click No line.
Also in the Format Shape dialog box, click 3-D Format in the left pane, and in the 3-D Format pane do the following:
Under Bevel, in the Top list, under Bevel select Angle (second row, first option from the left).
Next to the Top list, in the Width box enter 5.5 pt. and in the Height box enter 9.5 pt.  
Under Depth, in the Depth box enter 3.5 pt.
Also in the Format Shape dialog box, click 3-D Rotation in the left pane, and in the 3-D Rotation pane, under Rotation do the following:
In the X box enter 297.8°. 
In the Y box enter 298.9°. 
In the Z box enter 65.2°.
Also in the Format Shape dialog box, click Shadow in the left pane, and in the Shadow pane do the following:
In the Transparency box enter 60%.
In the Size box enter 105%. 
In the Blur box  enter 15 pt. 
In the Angle box enter 120°. 
In the Distance box enter 9 pt.
Select the circle and position towards the bottom of the slide. On the Home tab, in the Drawing group, click Arrange, and then under Position Objects, point to Align and select Align Center. 
On the Home tab, in the Drawing group, click Shapes, and under Rectangles select Rounded Rectangle (second option from the left). On the slide, drag to draw a rounded rectangle.
Drag the yellow adjustment diamond to the right to create a rounded top.
Select the rectangle. Under Drawing Tools, on the Format tab, in the Size group, in the Shape Height box enter 4.2” and in the Shape Width box enter 0.18”.
On the Home tab, in the Drawing group, click the Format Shape dialog box launcher. 
In the Format Shape dialog box, in the left pane click Fill tab, and in the Fill pane do the following:
Click Solid fill. 
In the Color list, under Theme Colors select White, Background 1, Darker 15% (third row, first option from the left).
Also in the Format Shape dialog box, in the left pane click Line Color, and in the Line Color tab click No line.
Also in the Format Shape dialog box, in the left pane click 3-D Format, and in the 3-D Format pane do the following:
Under Bevel, in the Top list select Circle. 
Next to the Top list, in the Width box enter 10 pt. and in the Height box enter 10 pt. 
Position the bottom of rectangle so that it slightly overlaps the oval.
Select the rounded rectangle. On the Home tab, in the Drawing group, click Arrange, and then under Position Objects, point to Align and select Align Center. 
With the rounded rectangle still selected, on the Home tab, in the Clipboard group, click the arrow to the right of Copy, and then click Duplicate.
Select the second rounded rectangle. Under Drawing Tools, on the Format tab, in the Size group, do the following:
In the Shape Height box enter 4.35”.
In the Shape Width box enter 0.13”.
With the second rounded rectangle still selected, on the Home tab, in the Drawing group, click Arrange, and then under Position Objects, point to Rotate and select Rotate Left 90°. 
Position the second (horizontal) round rectangle so that it slightly overlaps the top of the first, vertical round rectangle.
Select the second (horizontal) round rectangle. On the Home tab, in the Drawing group, click Arrange, under Position Objects, point to Align and select Align Center. 
Select the first (vertical) round rectangle. On the Home tab, in the Clipboard group, click the arrow to the right of Copy, and then click Duplicate.
Select the third (vertical) rounded rectangle. Under Drawing Tools, on the Format tab, in the Size group, do the following:
In the Shape Height box enter 0.32”.
In the Shape Width box enter 0.32”.
Position the third, smaller round rectangle at the intersection at the top of the first (vertical) and second (horizontal) round rectangles.
Select the third smaller round rectangle. On the Home tab, in the Drawing group, click Arrange, under Position Objects, point to Align and select Align Center. 
Press and hold SHIFT and select the second (horizontal) and third (smaller) round rectangles. On the Home tab, in the Drawing group, click Arrange, and under Group Objects select Group.
Select the oval. On the Home tab, in the Clipboard group, click the arrow to the right of Copy, and then click Duplicate.
Select the second oval. Under Drawing Tools, on the Format tab, in the Size group, do the following:
In the Shape Height box enter 1.93”.
In the Shape Width box enter 1.93”.
On the Home tab, in the bottom right corner of the Drawing group, click the Format Shape dialog box launcher. On the Format Shape dialog box, click Fill in the left pane, and in the Fill pane do the following:
Click Solid fill.
Click the button next to Color, and then under Theme Colors select White, Background 1, Darker 15% (third row, first option from the left).
Also in the Format Shape dialog box, click Shadow in the left pane, and in the Shadow pane, in the Presets list select No Shadow. 
Also in the Format Shape dialog box, click 3-D Format in the left pane, and in the 3-D Format pane do the following:
Under Bevel, in the Top list, under Bevel, select Slope (second row, fourth option from the left).
Next to the Top list, in the Width box enter 5.5 pt and in the Height box enter 5 pt. 
Under Bevel, in the Bottom list, under Bevel, select Angle (second row, the first option from the left). 
Next to the Bottom list, in the Width box enter 11 pt and in the Height box enter 5 pt.
Also in the Format Shape dialog box, click 3-D Rotation in the left pane, and in the 3-D Rotation pane, under Rotation do the following:
In the X box enter 287.8°.
In the Y box enter 297.1°.
In the Z box enter 74.1°.
Position this oval (or dish) on the left side of the slide, approximately 2.5 inches below the horizontal round rectangle
On the Home tab, in the Drawing group, click Shapes, and under Lines select Line (first option from the left). On the slide, drag to draw a line from left edge of the horizontal rectangle and to the bottom left edge of the dish.
Select the line. On the Home tab, in bottom right corner of the Drawing group, click the Format Shape dialog box launcher. In the Format Shape dialog box, click Line Color in the left pane, and in the Line Color pane do the following:
Click Solid line. 
Click the button next to Color, and then under Theme Colors select White, Background 1, Darker 25% (fourth row, first option from the left).
Also in the Format Shape dialog box, click Line Style in the left pane, and in the Line Style pane do the following:
In the Width box enter 3.75 pt. 
In the Dash type list select Round Dot (second option). 
In the Cap type list select Round. 
In the Join type list select Round. 
Select the line. On the Home tab, in the Clipboard group, click the arrow to the right of Copy, and then click Duplicate.
Select the second line. On the Home tab, in the Drawing group, click Arrange, and then under Position Objects, point to Rotate and select Flip Horizontal. 
Position duplicate line so the top point is at the same position as the top point on the first line. Position the end point is on the right edge of the dish.
On the Home tab, in the Drawing group, click Arrange, and then under Order Objects select Send to Back. 
Press and hold CTRL and select both lines and the dish. On the Home tab, in the Drawing group, click Arrange, and under Group Objects select Group. 
Select the group of (the two dotted lines and the dish). On the Home tab, in the Clipboard group, click the arrow to the right of Copy, and then click Duplicate. 
Position  the second group on the right side of the slide.
Press and hold CTRL and select both left and right groups. On the Home tab, in the Drawing group, click Arrange, and then do the following:
Under Position Objects, point to Align and select Align Selected Objects.
Under Position Objects, point to Align and select Align Top.
Under Order Objects select Send to Back.


To reproduce the animation effects on this slide, do the following:
Select top horizontal bar group. On the Animations tab, in the Advanced Animation group, click Add Animation, and then under Emphasis click Spin.
Also on the Animation tab, in the Animation group, click the Effect Options dialog box launcher. In the Spin dialog box, do the following:
On the Effect tab, do the following:
In the Amount list, in the Custom box enter 10 and press ENTER.
Also in the Amount list, select Clockwise.
Clear the Smooth Start box.
Clear the Smooth End box.
On the Timing tab, do the following:
In the Speed list select Fast.
In the Start list select With Previous.
Click OK.
Select the left dish group. Also on the Animations tab, in the Advanced Animation group, click Add Animation, and then click More Motion Paths. In the Add Motion Path dialog box, under Lines & Curves, click Up.
Also on the Animations tab, in the Animation group, click the Effect Options dialog box launcher. In the Up dialog box, do the following:
On the Timing tab, in the Start list, select With Previous, and then in the Speed list, select Fast.
On the Effect tab, clear the Smooth Start and Smooth End boxes.
Click OK.
Select the motion path on the slide. Press and hold the SHIFT key and drag the end point (red arrow) down to shorten the motion path (approximately .33” length). �(Note: If needed, zoom in to see the objects. On the View tab, in the Zoom group, click Zoom, and in the Zoom dialog box, in the Percent box enter 200%. After editing, on the View tab, in the Zoom group click Fit to Window to return to the slide to its original size.)
Select right dish group. Also on the Animations tab, in the Advanced Animation group, click Add Animation, and then click More Motion Paths. In the Add Motion Path dialog box, under Lines & Curves, click Down.
Also on the Animations tab, in the Animation group, click the Effect Options dialog box launcher. In the Down dialog box, do the following:
On the Timing tab, in the Start list, select With Previous, and then in the Speed list, select Fast.
On the Effect tab, clear the Smooth Start and Smooth End boxes.
Click OK.
Select the down motion path on the slide. Press and hold SHIFT and the drag end point  (red arrow) upwards to shorten path (approximately .33” length).
Select the top horizontal bar group. On the Animations tab, in the Advanced Animation group, click Add Animation, and then under Emphasis click Spin.
Also on the Animation tab, in the Animation group, click the Effect Options dialog box launcher. In the Spin dialog box, do the following:
On the Effect tab, do the following:
In the Amount list, in the Custom box enter 20 and press ENTER.
Also in the Amount list, select Counterclockwise.
Clear the Smooth Start box.
Clear the Smooth End box.
On the Timing tab, do the following:
In the Speed list select Fast.
In the Start list select With Previous.
Click OK.
Select the left dish group. Also on the Animations tab, in the Advanced Animation group, click Add Animation, and then click More Motion Paths. In the Add Motion Path dialog box, under Lines & Curves, click Down.
Also on the Animations tab, in the Animation group, click the Effect Options dialog box launcher. In the Down dialog box, do the following:
On the Timing tab, in the Start list, select With Previous, and then in the Speed list, select Fast.
On the Effect tab, clear the Smooth Start and Smooth End boxes.
Click OK.
Select the down motion path on the slide. Press and hold SHIFT and the drag end point  (red arrow) upwards to shorten path (approximately .66” length).
Select the Down motion path for the right dish on the slide. Press and hold SHIFT and drag the start point (green arrow) to meet end point (red arrow) from the first Up motion path.
Select the right dish group. Also on the Animations tab, in the Advanced Animation group, click Add Animation, and then click More Motion Paths. In the Add Motion Path dialog box, under Lines & Curves, click Up.
Also on the Animations tab, in the Animation group, click the Effect Options dialog box launcher. In the Up dialog box, do the following:
On the Timing tab, in the Start list, select With Previous, and then in the Speed list, select Fast.
On the Effect tab, clear the Smooth Start and Smooth End boxes.
Click OK.
Select the motion path on the slide. Press and hold the SHIFT key and drag the end point (red arrow) down to shorten the motion path (approximately .66” length). 
Select the Up motion path for the right dish on the slide. Press and hold SHIFT and drag the start point (green arrow) to meet end point (red arrow) from the first Down motion path.


To reproduce the background effects on this slide, do the following:
Right-click the slide background area, and then click Format Background. 
In the Format Background dialog box, click Fill in the left pane, select Gradient fill in the right pane, and then do the following:
In the Type list, select Linear.
In the Direction list, click Linear Down (first row, second option from the left).
Under Gradient stops, click Add gradient stops or Remove gradient stops until two stops appear in the slider.
Also under Gradient stops, customize the gradient stops as follows:
Select the first stop in the slider, and then do the following:
In the Position box, enter 65%.
Click the button next to Color, and then click under Theme Colors select White, Background 1 (first row, the first option from the left).
Select second stop in the slider, and then do the following: 
In the Position box, enter 96%.
Click the button next to Color, and then click under Theme Colors select Black, Text 1, Lighter 50% (second row, the second option from the left).



Purpose of Agency and North Dakota Century Code Implicated:

 - The Commission operating statute is N.D.C.C. 54-61

The Statutory responsibilities of the Commission are found in NDCC 54-61-02
 - The Commission is tasked with developing standards governing the delivery of 

   indigent services.  54-61-02(1)(a)
 - The Commission is tasked with implementing a process of contracting for legal  

  services for indigents.  54-61-02 (1)(b)
 - The Commission is tasked with establishing public defender offices in regions of 

  the state as it considers necessary and appropriate.  54-61-02 (1)(c)
 - The Commission is tasked with establishing a method for accurately tracking and 

  monitoring caseloads of contract counsel and public defenders.  54-61-02 (1)(d)
 - The Commission is tasked with approving and submitting a biennial budget to the 

  Office of Management and Budget.  54-61-02 (1)(e)

 -  The Commission is further given statutory authority to do the following:
  - Enter into agreements with a County or City to provide services in which 

    the County or city would have to provide. 54-61-02(2)
  - Adopt rules for the exercise of its authority.  54-61-02(3)
  - Request records from other agencies to verify indigence.  54-61-02(4)
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The Purpose of the Agency’s Various Programs 
- The Commission is the agency which provides the attorneys and related services to indigent 

persons when there is a constitutional, statutory, or rule-based right to counsel at public 
expense. 

- 54-61-01 provides that the Commission was “established for the purpose of developing and 
monitoring a process for the delivery of state-funded legal counsel services for indigents 
which are required under the Constitution of North Dakota and the United States 
Constitution and any applicable statute or court rule.  The commission shall provide indigent 
defense services for indigent individuals determined by the court to be eligible for and in 
need of those services pursuant to standards and policies of the commission governing 
eligibility for such services.”

- The North Dakota Commission on Legal Counsel for Indigents' mission is to provide high 
quality, professional, and effective legal representation to eligible clients, consistent with the 
guarantees of the constitutions of the United States and North Dakota, and applicable North 
Dakota statutes and rules, at reasonable cost to the community.

- The Commission consists of 7 members: 1 member of the legislature from each house, 2 
appointed by the Governor (one must be from a county of not more than 10 thousand), 2 
appointed by the Chief Justice (one must be from a county with a population of not more 
than 10 thousand) and one member appointed by the Board of Governors, State Bar Assoc.

- The Commission has 7 total offices: 6 regional public defender offices and the administrative 
office in Jamestown.  

NOR T H 

Dakota I Commission on Legal Counsel far Indigents 
Be Legendary.~ 



Delivery of Services
 The Commission is administered through the Administrative Office located in Jamestown
 We oversee 6 Regional public defender offices with a supervising attorney in each location:
 Williston Public Defender Office: Mr. Eric Lundberg
 Dickinson Public Defender Office: Mr. Kevin McCabe
 Bismarck-Mandan Public Defender Office: Mr. Justin Balzer
 Fargo Public Defender Office: Mr. Monty Mertz
 Grand Forks Public Defender Office: Mr. David Ogren
 Minot Public Defender Office: Mr. Eric Baumann
 We also contract with Private law firms to provide public defender services.
 North Dakota Century Code section 54-61-02.1 mandates the Commission “shall contract for 

public defender services at a minimum level of fifty percent of its biennial caseload.” During 
fiscal year 2024, 73% of case assignments were handled by private contractors with 27% 
handled by full time public defenders. 

Case Assignments
 Case assignments need to be limited to allow an attorney to provide a constitutionally effective defense
 Recently, new public defense workload standards were released, and we are nowhere near where we 

should be.  We use 1973 NACC standards, and even with those antiquated standards 66% of our 
attorneys or contractors exceeded case limits last fiscal year.

 Fiscal year 2023 remained high with a slight increase over Fiscal Year 2022.  Fiscal Year 2024 was our 
highest year ever with more of an increase then we predicted, outpacing the slight growth we had seen.
 One Concerning trend we have noticed is we are providing representation on more felonies than 

misdemeanors.
 Felony representation takes more time, and the more serious the felony, the more time the case 

assignment demands.  See Graph 1 NOR T H 
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Report on financial audit findings and actions taken
 The last audit of the Commission did not have any findings or recommendations.

Accomplishments
 Our Attorneys, Staff and Contractors handled a record number of case assignments and 

continue to do incredible work against all odds and for less pay than their counterparts
 Commission continues to work with Pre-Trial Services from the Dept. Of Corrections and 

Rehabilitation to expand that important program
 The Commission continues to be involved on committees and workgroups working to make 

the criminal and juvenile legal systems better in our great state.
 The Commission continues to give the state a presence on the national level. 
 Continued work with other public defense leaders across the country to insure we are 

providing the best possible services within our limitations.

Challenges
 The biggest challenges we face are the same we have been presenting to the Legislature 

since I have been in administration
 Continually our two biggest challenges are employee turnover due to lack of compensation 

and resource parity with other government entities and contractor rate of pay
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Challenges: Employee turnover due to lack of compensation and resources
- The American Bar Association’s 10 Principles of a Public Defense Delivery System provide 10 

black letter rules for an efficient public defense system. 
- Principle 2 provides “Full-time public defender salaries and benefits should be no less 

than the salaries and benefits for full-time prosecutors”
- This does not exist in North Dakota. the six largest counties in the state appropriate 

$38,975,578 for prosecutors whereas our biennial budget for the whole state is 
$22,620,120.  Thus, we are not at parity, we are being funded at 53% of the six largest 
counties.  Graph 2

- With the limited resources, we are not able to pay the same as prosecutors and suffere 
unsustainable annual turnover.  Graph 3

- When our agency is fully staffed, we have 20 FTE attorneys.  Right now I have 5 vacant 
positions, with 25% of our attorney positions being vacant.  As I will show later, this 
doesn’t save us any money.

- The most frustrating part of this job is listening to employees in exit interviews talk 
about how they love their job but are leaving because they can make more money 
elsewhere, significantly more. 

Challenges: Contractor Rate of Pay
- Our statute requires us to use contractors on a minimum of 50% of case load.  Because of our 
high turnover, this is currently closer to 73%.  However, it is becoming harder to find persons 
willing to contract
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Challenges: Contractor Rate of Pay
- The 68th Legislative Assembly gave us funds to move from $75/hour on contract to $80.  
- For Comparison, the Federal Criminal Justice Act paid contract attorney’s $172/hour in 

calendar year 2024.  Thus, even though we got an increase, we fell further behind.  Graph 4
Challenges: Investigative Services 
- The Commission is tasked with not only providing an attorney when there is a right to 

counsel, but providing the necessary services to the attorney to effectuate a constitutionally 
adequate defense.

- As such, the National Association of Public Defenders recommended in 2020 public 
defenders should have access to investigators and “inadequate investigation is the most 
frequent reason courts find ineffective assistance of counsel.”

- American Bar Association 10 Principles of a Public Defense Delivery System, Principle 9 
provides “public defenders should have the assistance of investigators, social workers, 
mitigation specialists, experts and other professionals necessary to meet public defense 
needs”

- At this point we are only asking for the investigators and future plans will deal with 
social workers and mitigation specialists.

- Historically the Commission has relied on private sector investigators, however, the rate we 
can pay them does not lend itself to being able to procure services.

- Thus, we asked the 68th Legislative Assembly to start an investigator program in house asking 
for three FTE.  We received 1 FTE, we did hire that FTE and I believe you will hear about the 
effectiveness of that program.
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Next Biennum Plan and Goals to Address Challenges

- We requested $805,000 to implement a step program for payment of classified employees 
like those used by the Judicial Branch and County Governments

- To achieve this Goal, we developed a reclassification plan to go along with our budget asks.  
We have successfully worked on reclassifications with only one remaining.  Attachment 5.

- We developed a plan to have a benchmark for contractor compensation where all future 
budgets will be set at a percentage of the Federal CJA rate.  The Commission settled at 60% 
and we submitted a budget request ask to increase contractor compensation to $103/hr.

- We addressed the staffing and investigative requirements by asking for 5 additional FTE, 
which would be investigators.  This would place one investigator in each office.

Priori ty Form Name General Fund 

18800 - Commission on Legal 
7,608,474 t"ftun•al #ftp 

01 
Restore cut to General Fund 

643,040 
7,165 

FUND THE AGENCY TO 
IMPLE ENT TH E 

02 COMMISSIO 'S 805,000 
corv PENSAT ION STRATEGY 
7, 166 

3) SET A MOVING RATE OF 
THE FEDERAL 

03 GOVERNM T CO T RACT 5 ,255,134 
RATE AND FU D 
ACCORDINGLY 7,168 

04 Add Private Investigators 7,232 905,300 

State of North Dakota 

Dec•lslon Package Summary 

Biennium 2025-27 
Commission on Legal Counsel for Indigents 

2025-27 Agency Request 

Federal Spe<:ia l Tota l FTE 

- - 7,608,474 5.00 

. . 643,040 -

- - 805,000 -

- - 5,255,134 -

- - 905,300 5 ,00 

NOR TH 

2025-27 Ex.ecutive Recommendatio n 

General Fund Federal Special Total FTE 

3,337,648 - - 3,337,648 2.00 

643,040 - . 643,040 -

805,000 - - 805,000 -

1,500,000 - - 1,500,000 -

389,608 - - 389 ,608 2,00 
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Agency Request/Recommendations Totals compared to current.
Current 2023-2025 biennium level Requested level in 2025-2027 

budget

Burgum Recommendation Armstrong Recommendation

41 Full Time Employees 46 Full Time Employees 43 Full Time employees Not yet released

Implement Step program to be 

competitive

$805,000 for employee increases $805,000 for employee increases Not yet released

Pay increase for contract attorneys, 

currently at $80 per hour

Increase to 60% of CJA Rate at cost 

of $5,255,134

Increase of $1,500,000 from General Fund 

to increase pay rate of contracted 

attorneys 

Not yet released

Total funding levels

$21,137,085.88

General fund

$2,023,067 

Special fund

$28,400,805 General Fund

$2,035,087 in Special Fund spending 

authority

$24,815,568 

General Fund

$2,054,262 in 

Special Fund spending authority

Not yet released
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Funding 
- The Commission is funded through one line 
- The one line consists of the general fund and the Indigent defense administration fund (282)
- Fund 282 is funded through the collection of statutory fees assessed in criminal cases:

1) A $35 indigent defense application fee pursuant to NDCC 29-07-01.1; and
2) A portion of the $100 court administration/indigent defense fee pursuant to NDCC 29-26-

22(2). This fee is split pursuant to statute between the indigent defense administration fund 
and the court facilities improvement and maintenance fund, with the first $750,000 collected 
per biennium going to the indigent defense administration fund, the next $460,000 going to 
the court facilities improvement and maintenance fund, and any additional collections are 
split equally between the two

- The fee’s are collected by the Judiciary and deposited with the State Treasurer.
- The Court may also order Attorney Fee reimbursement which is deposited in the general fund
 The Spending Authority out of the special fund has outpaced the collections.  Thus, there is 
concern we will not collect from fees the level of spending authority governor Burgum proposed. 
Expenses
- The Agency is a single line and must pay for all expenses out of the single line. 
- The major components making up the expenses for the Commission are salaries and benefits, 

professional fees and services (legal fees), ITD expense, and rent of office space
- As of November 2024, these totaled 96.5 % of our expenditures for the biennium. 
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New Positions Approved in 2023-2025 Biennium and Transfers from New FTE Pool
- The 68th Legislative Assembly provided the Commission with one additional full-time 

employee
- The position was hired as the Lead Investigator and was filled with a starting date of 

September 18, 2023.
- $137,781 was originally appropriated for the position and then was removed into the 

vacant/new FTE pool at the end of the last legislative session.
- We did transfer the $137,781 from the pool and anticipate spending all the appropriated 

amount.
Employee Turnover and The Number of Vacant Positions
- Employee turnover has been continually around 25% of our workforce over the last several 

calendar years
- During the 2023-2025 biennium we have turned over 18 full time employees of 41 FTE

- This is 43.9% of our agency has turned over so far this biennium.
- Of the 18 FTE that left our employ so far this biennium, 10 of those were attorneys.

- Forced to reassign all open cases
- Usually have to get a contractor to cover those cases at additional compensation as our 

other offices are too short or overwhelmed to cover
- When administrative staff leaves, our attorneys often end up doing administrative tasks and 

can not take as many cases, so we end up paying for additional contracts
- Governor Burgum restored any monies from the New/Vacant FTE pool seemingly recognizing 

it doesn’t work for our agency.
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Funding in Each Program/Line
- We are a one-time budget and do not have separate programs.
One Time Funding Requests
- The Commission did not submit any one-time funding requests in this budget.
Fees Charged by the Agency, Appropriateness of the Fees, and Amounts Deposited
- The Commission has three fees associated:
 1) A $35 indigent defense application fee pursuant to N.D.C.C. § 29-07-01.1; 
 2) The Commission's portion of a $100 court administration fee (the indigent   

    defense/facility improvement fee) pursuant to N.D.C.C. § 29-26-22(2). This fee is 
    split pursuant to statute between the indigent defense administration fund and the    
    court facilities improvement and maintenance fund, with the first $750,000   
    collected per biennium going to the indigent defense administration fund, the next 
    $460,000 going to the court facilities improvement and maintenance fund, and any 
    additional collections are split equally between the two; and

 3) The Judge may order reimbursement of attorney fees pursuant to N.D.C.C. § 29-07-
     01.1(2).  However, any fees collected pursuant to a judicial order to reimburse cost 

    of representation are deposited in the general fund.
- Collections of the fees are done by the clerk of court.  Collections from Fees 1 and 2 above 

are deposited in Fund 282 according to statutory scheme, Fee number three is deposited in 
the general fund

- Deposits are not keeping pace with spending authority and will need to be replaced with 
general fund dollars
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Fees Charged by the Agency, Appropriateness of the Fees, and Amounts Deposited
2019-2021 Biennium 2021-2023 

Biennium

2023-2025 

Biennium to date (End of November 

2024)

Collections 1,587,113.58 1,481,223.21 1,014,721.77

Amount expended 1,701,676.20 1,506,162.83 1,225,825.73

Spending Authority 1,990,035 1,994,850 2,011,220

The appropriateness of the collection of fees is an unsettled question.  The Commission has 

not yet taken a position on the fees and leaves it to the legislature for determination of 

appropriateness.  However, public defense is one of the only, if not THE only constitutionally 

guaranteed right given to individuals in which they are required to pay a fee.  When law 

enforcement wants to search your home, you don’t have to pay a fee to require them to get a 

warrant exercising your fourth amendment rights.  Likewise, when you want to say something at 

a legislative hearing as a citizen, you don’t need to pay a fee to exercise your first amendment 

right. NOR T H 
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Federal State Fiscal Relief Funds Remaining to Be Spent
- We did not receive any federal funds

Need for Other Sections to be Added to the Bill
- Ability to receive and spend federal and other grant funds

- IV-E Funds for families in Juvenile Court
- Subgrantee of other Formula Grants the State already receives

- Byrne Jag Grant

Other Bills Being Considered and Potential Budgetary Impact
- Any bills dealing with penalty and punishment enhancements or decreases

- Increased penalties we have found leads to more trials, costing more money and 
expenses

- Senate Bill 2028 has mandatory service time is sentenced to prison, which will likely 
cause more cases to go to trial

- Change to the Collection of Fees mentioned above
- Senate Bill 2057 increases the Court Administration/Indigent Defense Fee from $100 - 

$200
- Re-Entry study looking at the elimination of fees.

- If fees are eliminated, those dollars will need to be replaced with general funds
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Case type percentages have remained fairly consistent over the years.
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Current Job Title Current Class Current Grade Proposed Class and Job title Proposed Grade Court Grade
Admin. Asst. I Admin Svc III 103 

(2951-4918)
Admin Svcs IV
Admin Asst. - office

104 
(3508-5847)

10
(4158-6106)

Admin. Asst II Admin Svc IV 104
(3508-5847)

Adm Svcs IV
Adm Asst – Office

104
(3508-5847)

10
(4158-6106)

Admin. Asst. II Admin. Svc IV 104
(3508-5847)

Adm Svcs IV
Adm Asst – Executive

104
(3508-5847)

11
(4480-6594)

Legal Asst. II Admin. Svcs V 105
(4163-6938)

Admn. Svcs. V – 
Legal Assistant

105
(4163-6938)

12
(4803-7087)

Admin. Staff Officer I Admin. Svcs V 105
(4163-6938)

Admin. Svcs. V
Admin. Staff Officer

105
(4163-6938)

12
(4803-7087)

Admin. Offcr II Admin. Svcs V 105
(4163-6938)

Admin. Svcs. V
Admin. Officer II

105
(4163-6938)

12
(4803-7087)

Investigator Lead Protective Svcs. III 105
(4163-6938)

Protective Svcs. III. 105
(4163-6938)

12
(4803-7087)

Attorney I Pro. Svcs II 106
(4971-8285)

Pro. Svcs III –
 Attorney

107
(5973-9955)

19
(7072-10,099)

Attorney II Pro. Svcs III 107
(5973-9955)

Pro. Svcs III –
 Attorney

107
(5973-9955)

19
(7072-10,099)

ACCT SPEC. III Fiscal Svcs V 106
(4971-8285)

Fiscal Svcs VI – 
Finance Director

107
(5973-9955)

19
(7072-10,099)

ATTORNEY III Pro. Svcs. IV 108
(7146-11909)

Pro. Svcs. IV –
Supervising Atty

108
(7146-11909)

21
(7743-11603)

Position 1 2 3 4 5 6 7 8 9 10 11
Attorney – 

Public Defender
7,355 7,658 7,973 8,304 8,642 8,999 9,378 9,762 10,166 10,558 11,027

Supervising 
Attorney

7,743 8,062 8,394 9,103 9,467 9,856 10,266 10,687 11,130 11,592 12,067

Admin Asst. – 
PD Office

4,324 4,491 4,670 4,847 5,038 5,236 5,441 5,652 5,878 6,110 6,350

Admin Asst. – 
Exec. office

4,659 4,842 5,032 5,226 5,434 5,648 5,871 6,102 6,343 6,595 6,858

Legal Asst. - 
paralegal

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370

Investigator -PD 
Office

4,659 4,842 5,032 5,226 5,434 5,648 5,871 6,102 6,343 6,595 6,858

Investigator - 
Lead

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370

Admin Officer/ 
Admn Staff 

Officer

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370

Accounting 
Manager

7,015 7,299 7,596 7,907 8,240 8,575 8,929 9,299 9,681 10,084 10,503
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SB 2022 
Senate Appropriations  

Government Operations Division 
 January 13, 2025 

Testimony of Travis W. Finck, Executive Director, NDCLCI 
 

Good Morning. Chairman Wanzek, members of the Committee, my name is Travis 

Finck and I am the Executive Director of the North Dakota Commission on Legal Counsel 

for Indigents (hereinafter "the Commission"). 

I. PURPOSE OF AGENCY AND AGENCY STATUTORY RESPONSIBILITIES. 

The Commission is the agency which provides the attorneys and related services to 

indigent persons when there is a constitutional, statutory, or rule-based right to counsel at 

public expense. The Commission is governed by North Dakota Century Code Chapter 54-

61. Section 54-61-01 provides the Commission was "established for the purpose of 

developing and monitoring a process for the delivery of state-funded legal counsel services 

for indigents which are required under the Constitution of North Dakota and the United 

States Constitution and any applicable statute or court rule. The Commission shall provide 

indigent defense services for indigent individuals determined by the court to be eligible for 

and in need of those services pursuant to standards and policies of the commission 

governing eligibility for such services." 

The Commission has established Guidelines to Determine Eligibility for Indigent 

Defense Services (hereinafter "Guidelines").  For a person to have counsel provided by the 

Commission, the person must apply for services, be found to be "indigent" and it must be a 

type of case in which one has a right to counsel at public expense.  Most of the services 

provided by the Commission are in circumstances in which an individual is charged with a 

crime and jail time is a possible sanction, in juvenile matters, post-conviction matters and 

appeals of all the above. 

There are a few exceptions to which an individual is presumed to be eligible for our 

services.  All children are presumed indigent, regardless of their income or the income of 

their parents, in all matters arising out of the Juvenile Court Act.  Additionally, an 

individual who has an attorney at the trial court level, need not reapply for counsel if they 

wish to appeal.  The trial attorney files the notice of appeal and request for transcript on 

behalf of the indigent person.  In other situations, an application must be filled out and filed 

#28525
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with the court.   

When an individual desires counsel or services, application for services is to be 

made on the Commission's standard forms.  However, the Commission does not make the 

determination of whether a specific applicant is eligible for services.  Pursuant to the statute, 

the court makes the determination of eligibility based upon the Guidelines of the 

Commission. 

Under the Guidelines, indigency is determined by looking at income resources, non 

income resources (assets) of the applicant's household, and exceptional factors that might 

otherwise justify a finding of indigency.  Income guidelines are set at 125% of the federal 

poverty level threshold as defined by the U.S. Department of Health and Human Services.  

The mission of the Commission is "to provide high quality, professional, and effective legal 

representation to eligible clients at reasonable cost to the community." Services should be 

provided only to those persons who are eligible. It continues to be the policy of the 

Commission to seek additional screening and review of applications by the court in 

questionable cases. Additional screening and review are also sought when it appears 

that a person may no longer be eligible, such as when someone who was in jail and 

temporarily unemployed, has bonded out and is now likely employed, and would no 

longer be considered indigent. To help ensure that services are provided only to eligible 

individuals, the Commission also provides training to those persons who make the 

eligibility determinations. However, this is not done as frequently in the past due to 

shortness of staff time and constantly advertising, interviewing and attempting to fill 

positions. 

DELIVERY OF SERVICES 

 The Commission is administered through the administrative office in 

Jamestown. The administrative office coordinates the delivery of indigent defense 

services, assigns counsel, contracts with private attorneys to provide services, staffs the 

public defender offices, provides support services, and provides training to agency 

attorneys and staff.  Attorneys and indigent defense services are provided through full-

time state public defenders in six offices across the state and through private 

contractors.  The public defender offices are led by a supervising/lead attorney who 

reports directly to the Deputy Director. The Deputy Director then reports to the 
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Director. All staff in the public defender offices report to the supervising/lead attorney 

in that office. Our supervising/lead attorneys are provided below: 

Williston Public Defender Office: Mr. Eric Lundberg 
Dickinson Public Defender Office: Mr. Kevin McCabe 
Bismarck-Mandan Public Defender Office: Mr. Justin Balzer 
Fargo Public Defender Office: Mr. Monty Mertz 
Grand Forks Public Defender Office: Mr. David Ogren 
Minot Public Defender Office: Mr. Eric Baumann 
 
The Commission also provides services through contracts with private firms.  

This is achieved in the form of monthly contracts for a specified number of cases for a 

predetermined amount of compensation.  In addition, the agency contracts with conflict 

contractors who take conflict cases on a case assignment by case assignment basis. The 

current hourly rate for contractors is $80 per hour.   

 North Dakota Century Code section 54-61-02.1 mandates the Commission “shall 

contract for public defender services at a minimum level of fifty percent of its biennial 

caseload.” During fiscal year 2024, 73% of case assignments were handled by private 

contractors with 27% handled by full time public defenders.  
CASE ASSIGNMENTS 

 
 The Commission uses the term "case assignment" rather than "case" when 

referring to assignments and has defined the term based on case type (such as criminal, 

probation revocation, juvenile delinquency, etc.). "Case assignment" is used so that 

assignment numbers from different areas of the state will mean the same thing across 

the state. For example, a criminal case assignment includes all cases arising from the 

same event whether the prosecution has charged the defendant in multiple complaints, 

each with its own case number, or whether the defendant has been charged in one 

complaint with multiple counts, but one case number. A criminal case assignment that 

includes a felony is a felony assignment, even if some of the charges in the assignment are 

misdemeanors. Thus, it is one felony case assignment where the attorney represents a 

person charged with a felony DUI and with a misdemeanor driving under suspension 

charge, both arising from the same traffic stop. 

 The number of case assignments the agency handles has rebounded from the 

pandemic when courts and cases were slowed.  FY 2021 case assignments rebounded from 
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the COVID low and set a new historical high.  FY 2022 remained at a similar level to FY 

2021.  FY 2023 saw a slight increase, whereas FY 2024 set an all-time record for number of 

cases handled in a fiscal year.  We have also seen an increase over the normal number of 

case assignments in the first few months of the current fiscal year. Furthermore, we have 

noticed a significant increase in the number of violent crime case assignments. The 

increased severity of a case assignment correlates directly with increased cost, as they often 

require investigators, experts, more attorney time, etc.  See Graph 1. 

 It is always difficult to forecast what the case assignment numbers will be in the 

future. The Commission has no control over the number of crimes committed and 

investigated, the number of persons charged, the charges filed and the number of persons 

who apply for services and are found eligible.  One trend we have noticed is the increase in 

the number of felony case assignments compared to misdemeanor case assignments.  

Felony case assignments take more time and thus are more expensive to handle.  See Graph 

1. 

II. AUDIT FINDINGS.  

 The last audit of the Commission did not have any recommendations or findings. 

III. CURRENT BIENNIUM ACCOMPLISHMENTS AND NEXT BIENNIUM 

GOALS AND PLANS. 

ACCOMPLISHMENTS 

 Our attorneys, staff, and contractors continue to do incredible work against all odds 

and for less pay than their counterparts. The ability to present this budget is an honor and a 

privilege to represent such a dedicated group of individuals.   

 The Commission has been able to accomplish some amazing things this current 

biennium thanks to the tireless dedication of the employees and contractors of the 

Commission. The Commission continues to partner with local, state, and national partners 

to provide high quality training for our public defenders, law firms who contract to provide 

services, and criminal defense attorneys across the state.   

 The Commission has also played a major role in the expansion of the pretrial service 

program housed within the Department of Corrections. The Commission did not receive 

any increase funding in relation to the program but has been able to successfully find 
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attorneys to appear at initial appearances with clients.  Additionally, my assignment staff 

have spent numerous extra hours fitting into their already tight assignment schedules the 

assignment of counsel. We have worked with the Court and the Pre-Trial service division of 

DOCR Parole and Probation to streamline a method of screening individuals applying for 

counsel. We have worked out orders in each pilot district to allow for earlier application, 

determination, and appointment of counsel.  The Commission also trains all new pre-trial 

service agents on the guidelines for eligibility for public defense services. 

 The Commission has served on several committees and workgroups to make the 

criminal and juvenile legal systems in North Dakota better.  We have continued to work on 

our state’s response to the mental health crisis.  We have continued to work on issues 

surrounding juveniles and promoting rehabilitation as part of all programming.  Further, we 

have continued to look at ways to better provide services to our clients to meet our 

constitutional mandate without the assistance of any additional state funding. 

 The Commission continues give North Dakota a presence on the national level.  The 

undersigned has been elected to the Board of Directors for the National Association of 

Criminal Defense Lawyers, becoming the first lawyer from North Dakota to serve in that 

capacity.  Further, we continue to consult with other states and leaders in public defense to 

make sure the Commission provides the most constitutionally effective services we can. 

CHALLENGES 

I would like to point out our challenges continue to be the same as they have since I 

have been in administration since 2016.  Continually, our two biggest challenges are the 

employee turnover due to compensation and contractor rate of pay.  We can no longer afford 

to continue to turn a blind eye to these two issues as we are near a state of constitutional failure.    

We have consistently brought information to this legislative body indicating we are vastly 

behind our counterparts in county government prosecutor offices in attorney salaries.  

Additionally, our staff continue to lag similarly classified staff in other government agencies or 

branches.  This is no longer sustainable.  The American Bar Association’s 10 Principles of a 

Public Defense Delivery System provide 10 black letter rules for an efficient system.  Principle 

2 provides “Full-time public defender salaries and benefits should be no less than the salaries 

and benefits for full-time prosecutors”.  This currently does not exist in North Dakota.  We 
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continue to lose qualified lawyers to prosecutor offices who offer higher salaries with their 

additional funding.  In fact, the six largest counties in the state appropriate $38,975,578 for 

prosecutors whereas our biennial budget for the whole state is $22,620,120.  Thus, we are not at 

parity, we are being funded at 53% of the six largest counties. 

Given the lack of funding compared to prosecutors, we have been unable to recruit or 

retain qualified attorneys to our positions based upon salaries we can pay.  We currently have 5 

vacancies out of 20 total full-time attorneys, this is a 25% vacancy.  We were once again forced 

to close one of our offices because we were unable to recruit and staff the attorney position.  In 

closing the office, we reallocated the FTE positions to better serve the public.  Quite simply, it 

is not sustainable to turn over 25% of your workforce on an annual basis.  Graph 2.   

  The next challenge we face is the inability attract private firms to provide contract 

services for the Commission.  Our statute requires the use of private attorneys to serve as 

contractors to handle cases for the Commission. Our current rate of compensation for 

contractors is $80 per hour.  Federal Criminal Justice Act appointments in calendar year 

2024, federal court version of contract public defense, was at the rate of $172/hour, more 

than double the rate we can offer. Last session the Legislative Assembly did fund the 

agency to raise our rate from $75 to $80 an hour, however, the Commission’s increase was 

not the same as the CJA rate increase and we have fallen even further behind. Graph 3. 

  An additional challenge the Commission faces is not having access to  qualified 

investigators to serve clients.  Since the inception of the agency, the Commission has relied 

upon using investigators in the private sector to provide services to full-time attorneys and 

contractors.  A lawyer has a duty to investigate all cases to which they are assigned.  We 

have consistently paid $65 per hour to investigators as not to exceed the rate paid to 

attorneys.  It has become increasingly more difficult to find investigators in the private 

sector willing to perform work for the Commission at this rate.  The National Association 

of Public Defenders issued a position paper in May of 2020 on Public Defense Staffing for 

meaningful representation in which it notes “adequate investigation is the most frequent 

reason courts find ineffective assistance of counsel.”  To remedy this problem, the 

Commission did request three FTE positions last session.  The 68th Legislative Assembly 

provided funding for 1 FTE.  This investigator was placed in the Bismarck Office, and you 
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will hear testimony from an attorney in that office as it relates to the effectiveness of having 

an investigator on staff. 

PLANS TO ADDRESS CHALLENGES 

  The first decision package the Commission recommended to the Governor’s office 

was to restore the 3% cut.  Governor Burgum had requested all agencies prepare a budget at 

a 3% cut.  However, this is not feasible for the Commission with an increase in case 

numbers, an increase in the severity of cases and the inability to provide constitutionally 

mandated services within the current budget. 

The Commission did submit as part of our budget a plan to move to a step program for 

classified employees like that used by the Judicial Branch and most county governments.  This 

would put the director salary equal to a district court judge, the deputy director at a rate of a 

magistrate judge, and then equivalent positions would line up according to where they would 

fall on the Courts scale.  A copy of this classification strategy is attached.  Attachment 4. 

Some of the work to meet this goal has already been achieved.  To be competitive with 

the Court and other like governmental agencies, we have had to reclassify several positions.  As 

you can see in Attachment 4, we have begun the process of reclassifying positions and will 

continue to do so.  To fully implement the strategy, we requested an additional $805,000.  

However, since the time we submitted the budget, the Court increased the rate paid to attorneys 

and our request to the Governor is insufficient to put on par with the Court.  This serves to 

demonstrate the inability to compete the Commission has been placed in.  For those reasons, 

we are requesting the legislature fund the compensation schedule we have proposed along with 

adding the increases to be given to all state employees.   

The third plan we put in with this budget is an attempt to make us competitive with 

other legal systems, primarily the federal government, in competing for private firms willing to 

do contract public defense work.  Currently, we are discussing this contract rate every budget 

cycle.  The uncertainty associated with the low contract rate makes our request to private firms 

unappealing in comparison with the federal government.  To combat this, we have prepared a 

budget request to fund an increase to the hourly rate at a benchmark of the federal government.  

The Commission approved the rate to be sixty (60) percent of the federal criminal justice act 
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rate.  For this budget cycle, the federal rate when preparing the budget was $172 per hour.  

Sixty percent of $172 would have our rate be at $103.20.  Thus, we submitted a request for $5, 

255, 134 to increase our hourly contract rate to $103 per hour.  In the event the legislative 

assembly agrees with this approach.  We will have 60% as the benchmark and all future 

budgets will be requested accordingly. 

The final plan we put in place is to address the support staff requirements of an effective 

public defense delivery system.  We have a goal of having a full-time investigator in each 

public defender office.  The American Bar Association (ABA) 10 Principles of a Public 

Defense Delivery System, Principle 9 provides “public defenders should have the assistance 

of investigators, social workers, mitigation specialists, experts and other professionals 

necessary to meet public defense needs.”  In preparation for this budget, I spoke with each 

office, and it is abundantly clear, there is a not enough investigators in the private market 

willing to take our reduced rate to meet our need.  The only way we can provide 

constitutionally mandated effective representation is to have investigators on staff. 

We have had our lead investigator on staff for nearly a year, and the returns have 

been as expected.  The attorneys in that office have praised the ability to have an 

investigator assist in interviewing clients, reviewing discovery looking for defenses, 

locating and interviewing witnesses, preparing for trial, taking photos, etc.  We need an 

investigator in each office given the attorney rules of professional conduct conflict rules 

associated with non-lawyer legal assistants.  With only one investigator on staff, he has 

been tasked with covering the entire state and taking cases in Dickinson, Bismarck, Minot 

and Fargo.   
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IV. AGENCY REQUESTS/ RECOMMENDATIONS TOTALS, INCLUDING 

FULL TIME EMPLOYEE REQUESTS COMPARED TO CURRENT 

BIENNIUM. 

Current 2023-

2025 biennium 

level 

Requested level 

in 2025-2027 

budget 

Burgum 

Recommendation 

Armstrong 

Recommendation 

41 Full Time 

Employees 

46 Full Time 

Employees 

43 Full Time 

employees 

Not yet released 

Implement Step 

program to be 

competitive 

$805,000 for 

employee 

increases 

$805,000 for 

employee increases 

Not yet released 

Pay increase for 

contract 

attorneys, 

currently at $80 

per hour 

Increase to 60% 

of CJA Rate at 

cost of 

$5,255,134 

Increase of 

$1,500,000 from 

General Fund to 

increase pay rate of 

contracted attorneys  

Not yet released 

Total funding 

levels 

$21,137,085.88 

General fund 

$2,023,067  

Special fund 

$28,400,805 

General Fund 

$2,035,087 in 

Special Fund 

spending 

authority 

$24,815,568  

General Fund 

$2,054,262 in  

Special Fund 

spending authority 

Not yet released 

 

AGENCY FUNDING 

Traditionally, the Commission has been funded from two sources: the general fund 

and "fund 282" (the indigent defense administration fund). The indigent defense 

administration fund is funded through collection of two statutory fees paid by criminal 

defendants and collected by the Courts: 

1) A $35 indigent defense application fee pursuant to N.D.C.C. § 29-07-01.1; and 
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2) The Commission's portion of a $100 court administration fee (the indigent defense/facility 

improvement fee) pursuant to N.D.C.C. § 29-26-22(2). This fee is split pursuant to statute 

between the indigent defense administration fund and the court facilities improvement and 

maintenance fund, with the first $750,000 collected per biennium going to the indigent 

defense administration fund, the next $460,000 going to the court facilities improvement 

and maintenance fund, and any additional collections are split equally between the two.   

The District Courts also have the authority to order reimbursement of attorney fees 

pursuant to NDCC 29-07-01.1 (2).  However, any attorneys' fees that are recouped go into 

the general fund, not fund 282. Those funds are not collected by the Commission, they are 

collected and accounted for by the Court.  The collection of the application fee and indigent 

defense/facility improvement fees is not guaranteed. District Judges, who impose the fees, 

have the discretion to impose or waive the fees in any case.  The spending authority 

authorized by the legislature is more than is biennially collected.  Current biennium 

spending authority will outpace collections and consume any carryover balance from 

previous biennium.  Given this trend, there needs to be a shift from reliance upon fees to 

fund indigent defense to general fund dollars.  

EXPENSES 

The major components making up the expenses for the Commission are salaries and 

benefits, professional fees and services (legal fees), ITD expense, and rent of office space. 

As of November 2024, these totaled 96.5 % of our expenditures for the biennium.  These 

expenses do not account for such things as statutorily mandated training, expenses related 

to representation of an individual in a case assignment such as an expert, or other 

unexpected expenses.  Thus, any increases in case assignments such as the increase we are 

currently seeing this biennium places an extreme challenge to our ability to fund all 

requests for services. 

V. NEW POSITIONS APPROVED IN 2023-25 BIENNIUM. 

The 68th Legislative Assembly provided the Commission with one additional full-

time employee.  The FTE was given to start an on-staff investigator program within the 

agency.  The position was hired as the Lead Investigator and was filled with a starting date 
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of September 18, 2023.  $137,781 was originally appropriated for the position and then was 

removed into the vacant/new FTE pool at the end of the last legislative session.  We did 

transfer the $137,781 from the pool upon filling the position and will spend all the amount 

appropriated for the position.  We anticipate we will be requesting the remaining amount 

taken from the budget for the vacant FTE pool given the lack of savings by having vacant 

FTE. 

VI. EMPLOYEE TURNOVER AND THE NUMBER OF VACANT POSITIONS 

TO DATE COMPARED TO SAVINGS REMOVED FROM BUDGET IN 23-

25 BUDGET. 

 Employee turnover has been continually around 25% of our workforce over the last 

several calendar years.  During the 2023-2025 biennium we have turned over 18 full time 

employees of 41 FTE.  This is 43.9% of our entire agency turned over so far this biennium.  

However, as reported to OMB quarterly for the last biennium, vacant FTE spots do not save 

us money.  Of the 18 FTE that left our employ so far this biennium, 10 of those were 

attorneys.  When attorneys leave our agency, we have to reassign all of their open cases.  

Due to increased case loads stemming from higher case assignment numbers and fewer 

contract and full-time public defenders, we are having to reassign more cases then in the 

past due to turnover.  Typically, these cases are assigned to private contractors who agree to 

take extra cases for extra compensation.  Assigning a case to a contract attorney costs more 

money than if it can be handled by a full-time public defender within the office.  

Furthermore, if any expenses were spent on the case by the leaving attorney, the new 

attorney may have a new strategy incurring new expenses. 

 Eight of the remaining positions were administrative staff.  When administrative 

staff leave our employ, we are forced to have attorneys cover some of their duties within the 

offices.  This is inefficient and does not save money as we have to assign more cases to 

contractors because attorneys are covering administrative duties.  The new and vacant FTE 

pool did not save the Commission any funds.  Governor Burgum in his executive 

recommendation noted the deficiency in the new and vacant FTE pool as it relates to our 

Commission and recommended restoring $391, 375 from the general fund and $7,134 from 
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the special fund that was removed in 2023-25 budget. 

VII. FUNDING IN EACH PROGRAM/LINE. 

The Commission does not have separate program lines. 

VIII. ONE TIME FUNDING REQUESTS. 

 The Commission did not submit any one-time funding request in this budget.  Our 

budget is focused on meeting the bare minimums to pass constitutional challenge to our 

public defense delivery system in North Dakota. 

IX. IDENTIFY AND JUSTIFY NEED FOR ANY ONE TIME FUNDING 

REQUESTED. 

This is not applicable to our agency. 

X. FEES ASSOCIATED WITH THE AGENCY, APPROPRIATENESS OF THE 

FEES, AND AMOUNTS DEPOSITED. 

The Commission has three main fees associated with our services:   

1) A $35 indigent defense application fee pursuant to N.D.C.C. § 29-07-01.1;  

2) The Commission's portion of a $100 court administration fee (the indigent 

defense/facility improvement fee) pursuant to N.D.C.C. § 29-26-22(2). This 

fee is split pursuant to statute between the indigent defense administration 

fund and the court facilities improvement and maintenance fund, with the 

first $750,000 collected per biennium going to the indigent defense 

administration fund, the next $460,000 going to the court facilities 

improvement and maintenance fund, and any additional collections are split 

equally between the two; and 

3) The Judge may order reimbursement of attorney fees pursuant to N.D.C.C. § 

29-07-01.1(2).  However, any fees collected pursuant to a judicial order to 

reimburse cost of representation are deposited in the general fund. 

Collections of fees 1 and 2 above are deposited in the Indigent Defense Administration 
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fund, or fund 282.  The collections, as mentioned above, have not kept pace with spending 

fund authority.  The table below summarizes collections and expenditures. 

 2019-2021 

Biennium 

2021-2023  

Biennium 

2023-2025  

Biennium to date (End 

of November 2024) 

Collections 1,587,113.58 1,481,223.21 1,014,721.77 

Amount expended 1,701,676.20 1,506,162.83 1,225,825.73 

Spending Authority 1,990,035 1,994,850 2,011,220 

The appropriateness of the collection of fees is an unsettled question.  The 

Commission has not yet taken a position on the fees and leaves it to the legislature for 

determination of appropriateness.  However, public defense is one of the only, if not THE 

only constitutionally guaranteed right given to individuals in which they are required to pay 

a fee.  When law enforcement wants to search your home, you don’t have to pay a fee to 

require them to get a warrant exercising your fourth amendment rights.  Likewise, when 

you want to say something at a legislative hearing as a citizen, you don’t need to pay a fee 

to exercise your first amendment right. 

XI. FEDERAL STATE FISCAL RELIEF FUNDS REMAINING TO BE SPENT. 

We did not receive any Federal Funds in the last biennium. 

XII. NEED FOR OTHER SECTIONS TO BE ADDED TO THE BILL. 

 The Commission is consistently reviewing ways in which we can assist the 

legislature in providing public defense services.  One way that has been identified is the 

potential of using federal funds to pay for reimbursement of costs associated with providing 

legal counsel to families in juvenile court.  We have worked with the Department of Health 

and Human Services, Children and Family Services Division, to develop a plan by which 

we would have access to federal title IV-E funds to assist with providing more holistic 

public defense services.  ND DHHS has included in their budget funds to start this program 

since they are the federal pass through for federal IV-E funds.  If funded, we will be 
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executing a memorandum of understanding with ND DHHS to create the contracts for those 

public defense services, with the bills to be paid by the Department.  Therefore, it should be 

noted in our budget we have the ability to spend federal funds. 

 Additionally, the Commission must begin to seek alternative funding sources to 

implement our vision of providing holistic services.  This would require the ability to apply 

for and receive federal grants and to be subgrantees on formula grants already given to the 

State of North Dakota.  One such grant that has been identified is the Byrne Jag Formula 

Grant that flows through the Attorney General’s office.  The federal bureau sponsoring 

those grants has indicated the funds may be used for court systems of which certain public 

defense systems would be appropriate subgrantees.  In fact, many state and other 

governmental level public defender offices receive these grants in their respective 

governments.  We do not have an amount submitted with our budget but the use of potential 

grants and alternative fundings sources would need to be approved by the legislature.  At 

this time, we would be requesting a blanket approval to receive and expend other funds for 

the provision of public defender services. 

XIII. OTHER BILLS BEING CONSIDERED AND POTENTIAL BUDGETARY 

IMPACT. 

There are several bills working their way through the legislative process possessing 

the ability to affect the budget of the Commission.  There are several bills dealing with 

penalty and punishment.  Any increase in penalty or punishment may result in defendant’s 

choosing to exercise their right to a trial versus pleading guilty.  If a case goes to trial, there 

is more time associated with the case and more time means more money expended.  One 

bill that has been released that could case fiscal implications is Senate Bill 2128.   

Additionally, there are several bills dealing with the amount charged for the fees 

discussed above.  Senate Bill 2057 would increase the Court Administration/Indigent 

Defense Fee from $100 to $200.  However, we are unable to determine a fiscal impact as 

the fee can be waived and it is impossible to ascertain if increasing this fee will lead to any 

further collections.  There was also a re-entry study in the interim legislative process that 

considered eliminating the $35 application fee and the Court Administration/Indigent 
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Defense fee of $100.  If this were to be filed, we would be filing a fiscal note requesting the 

loss appropriations be replaced with general fund dollars.   

XIV. ADDITIONAL INFORMATION. 

The Commission is an integral part of the criminal, juvenile and civil legal system in 

the great state of North Dakota.  To continue the administration of the court system in the 

state, the budget we submitted is not a want budget, it is a survival budget.  In my time as 

director of this agency, we have consistently requested to be on a level playing field with 

prosecutors as required by the American Bar Association.  However, with the increases 

prosecutors have received from their respective county governments, we are not even in the 

arena.  Thus, we are at least trying to be competitive with other governmental agencies 

whose budgets are completed by this legislative assembly.  We have been and will always 

continue to be good stewards of the monies entrusted to us.  To meet the challenges of the 

day, we must work together. 

CLOSING 

I want to thank the Committee for your time.  I ask you consider the position in which the 

state finds itself regarding Indigent Defense.  The time is now to fully fund the agency to provide 

constitutionally required services. 

 
 

               Respectfully submitted: 
 
 
 

      _________________________________ 
             Travis W. Finck, Director 
             N.D.  Comm. on Legal Counsel for Indigents 
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Government Operation Divisions 
January 13, 2025 

Testimony of Travis W. Finck, Executive Director, NDCLCI 

GRAPH 4
Current Job 

Title 
Current Class Current 

Grade 
Proposed Class and Job 

title 
Proposed 

Grade 
Court Grade 

Admin. Asst. I Admin Svc III 103 
(2951-4918) 

Admin Svcs IV 
Admin Asst. - office 

104 
(3508-5847) 

10 
(4158-6106) 

Admin. Asst II Admin Svc 
IV 

104 
(3508-5847) 

Adm Svcs IV 
Adm Asst – Office 

104 
(3508-5847) 

10 
(4158-6106) 

Admin. Asst. II Admin. Svc 
IV 

104 
(3508-5847) 

Adm Svcs IV 
Adm Asst – Executive 

104 
(3508-5847) 

11 
(4480-6594) 

Legal Asst. II Admin. Svcs 
V 

105 
(4163-6938) 

Admn. Svcs. V – 
Legal Assistant 

105 
(4163-6938) 

12 
(4803-7087) 

Admin. Staff 
Officer I 

Admin. Svcs 
V 

105 
(4163-6938) 

Admin. Svcs. V 
Admin. Staff Officer 

105 
(4163-6938) 

12 
(4803-7087) 

Admin. Offcr II Admin. Svcs 
V 

105 
(4163-6938) 

Admin. Svcs. V 
Admin. Officer II 

105 
(4163-6938) 

12 
(4803-7087) 

Investigator 
Lead 

Protective 
Svcs. III 

105 
(4163-6938) 

Protective Svcs. III. 105 
(4163-6938) 

12 
(4803-7087) 

Attorney I Pro. Svcs II 106 
(4971-8285) 

Pro. Svcs III – 
 Attorney 

107 
(5973-9955) 

19 
(7072-10,099) 

Attorney II Pro. Svcs III 107 
(5973-9955) 

Pro. Svcs III – 
 Attorney 

107 
(5973-9955) 

19 
(7072-10,099) 

ACCT SPEC. 
III 

Fiscal Svcs V 106 
(4971-8285) 

Fiscal Svcs VI –  
Finance Director 

107 
(5973-9955) 

19 
(7072-10,099) 

ATTORNEY 
III 

Pro. Svcs. IV 108 
(7146-
11909) 

Pro. Svcs. IV – 
Supervising Atty 

108 
(7146-11909) 

21 
(7743-11603) 

Compensation Strategy for Classified Positions 
North Dakota Commission on Legal Counsel for Indigents

The Commission understands compensation for employment is not a one-time discussion and every year 
employees become more valuable to the agency and its mission due to their increase in skill and knowledge.  
Knowing how and when you may receive salary increases is a key factor in planning your future.  We believe 
consistently rewarding performance strengthens the employment relationship. 

Utilizing a step system for classified positions allows the Commission to hire at entry level, train employees 
while they earn a fair wage, and continuously reward employees for longevity and satisfactory performance.  
This allows for a fair, unbiased and transparent compensation system.  It further allows the Commission to 
compete with other public entities in recruiting and retaining candidates for employment. 

Unless there is a market exception, all new hires start at step one.  Employees who provide satisfactory 
performance are eligible to advance to the next step every odd year on the employee’s anniversary date in pay 
grade.  In addition, if the Legislature provides funding for employee increase, the Commission will adjust the 
step system to maintain market competitiveness.  When this happens, employees will receive the Legislative 
increase on July 1.  Generally, it will take 19 years to reach the final step, step 11. 

The example below shows how the compensation for a typical employee would change over the first 5 years 
of employment with the Commission. 

Attorney 



 

Employment Start Date of August 1, 2024 
Pay Grade 107 
(5973-9955) 

Step Date Salary Explanation 
1 8/1/2024 $7,355/month Hire step/Employment start date/Anniversary Date 
2 3/1/2025 $7,658/month  1st odd year step increase given on Completion of 

Probationary Period 

2 7/1/2025 $7,658 Legislative 4% increase 

2 7/1/2026 $7,964 (Legislative increase based upon 2025 session) 4% for 
example purposes only 

2 7/1/2027 $8,283 (Legislative increase based upon 2025 session) 4% for 
example purposes only 

3 8/1/2027  2nd odd year step increase given on anniversary date in 
pay grade 

3 7/1/2027  (Legislative increase based upon 2027 session) 
3 7/1/2028  (Legislative increased based upon 2027 session) 

4 8/1/2028  3rd odd year step increase given on anniversary date in 
pay grade 

Position 1 2 3 4 5 6 7 8 9 10 11 
Attorney – 

Public 
Defender 

7,355 7,658 7,973 8,304 8,642 8,999 9,378 9,762 10,166 10,558 11,027 

Supervising 
Attorney 

7,743 8,062 8,394 9,103 9,467 9,856 10,266 10,687 11,130 11,592 12,067 

Admin 
Asst. – PD 

Office 

4,324 4,491 4,670 4,847 5,038 5,236 5,441 5,652 5,878 6,110 6,350 

Admin 
Asst. – 
Exec. 
office 

4,659 4,842 5,032 5,226 5,434 5,648 5,871 6,102 6,343 6,595 6,858 

Legal Asst. 
- paralegal 

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370 

Investigator 
-PD Office 

4,659 4,842 5,032 5,226 5,434 5,648 5,871 6,102 6,343 6,595 6,858 

Investigator 
- Lead 

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370 

Admin 
Officer/ 

Admn Staff 
Officer 

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370 

Accounting 
Manager 

7,015 7,299 7,596 7,907 8,240 8,575 8,929 9,299 9,681 10,084 10,503 

 

 
 



#28730

STATE OF NORTH DAKOTA 
RESOLUTION 

NORTH DAKOTA JUDICIAL CONFERENCE 

WHEREAS, the North Dakota Judicial Conference is established by statute for the purpose of soliciting, 

receiving, and evaluating suggestions relating to the improvement of the administration of justice; 

considering and making recommendations to the Supreme Court for changes in rules, procedures, or any 

matter pertaining to the judicial system; coordinating continuing judicial education efforts for judges and 

support staff; and establishing methods for reviewing proposed legislation, which may affect the 

operation of the judicial branch; and 

WHEREAS, the Judicial Conference is charged with suggestions relating to the improvement of the 

administration of justice; and 

WHEREAS, the North Dakota Commission on Legal Counsel for Indigents {CLCI) is a critical component to 

administration of justice in North Dakota Courts; and 

WHEREAS, CLCI is charged with developing and monitoring a process for the delivery of state-funded 

legal counsel services for indigents; and 

WHEREAS, the right to counsel is guaranteed in the U.S. and North Dakota Constitutions; the right to 

counsel attaches in criminal, juvenile and some civil cases; and 

WHEREAS, significant challenges remain within the North Dakota indigent defense system despite 

significant progress made by CLCI; and 

WHEREAS, there are vast discrepancies between pay and resources for prosecutors/other government 

attorneys and the CLCI; and 

WHEREAS, the CLCI continues to struggle in recruiting and retaining qualified employees because of the 

discrepancies resulting in an average turnover exceeding 25% in the last four years1; and 

WHEREAS, the issue is even more acute in rural counties; 

NOW THEREFORE, BE IT RESOLVED, the North Dakota Judicial Conference recommends the Legislature: 

1) Fund public defense in North Dakota at levels allowing pay and resources comparable to 

prosecutors and other government agencies employing attorneys; 

2) Appropriate monies to allow CLCI to employ on staff investigators; 

3) Appropriate money to increase the hourly rate of contractor compensation; and 

4) Allow the agency to pursue federal funds to help increasyepresentation for indigent clients. 

~L4~ 
Hon. Stephannie Stiel 
Chair, N.D. Judicial Conference 

1 FTE Turnover for calendar year 2021 was 37.5%, calendar year 2022 was 20%, calendar year 2023 was 27.5% and 

calendar year 2024 so far is at 24.4%. 



2025 SENATE STANDING COMMITTEE MINUTES 

Appropriations - Government Operations Division 
Red River Room, State Capitol 

SB 2022 

1/20/2025 

A BILL for an Act to provide an appropriation for defraying the expenses of the 
commission on legal counsel for indigents 

3:23 p.m. Chairman Wanzek opened the hearing. 

Members present were Chairman Wanzek, Vice-Chair Dwyer, Senator Burckhard, Senator 
Erbele, and Senator Sickler.  

Discussion Topics: 
• Comparison of Governor Burgum and Governor Armstong budgets
• Salary parity comparisons
• Classified / non-classified positions
• Contractor services / agency services
• Investigator positions
• Special funds collections

3:25 p.m. Senior Fiscal Analyst Adam Mathiak submitted testimony #44439. 

3:28 p.m. Travis Fink, Director of the Agency for Legal Counsel for Indigents, provided 
neutral testimony #31102.  

4:02 p.m. Chairman Wanzek closed the meeting.  

Carol Thompson, Committee Clerk 



Position Start Date Current date Years of service Current Wage Proposed
Professional Srvcs. IV - Supervising attorney 10/1/2018 1/15/2025 06 9066.69 9108
Professional Srvcs. IV - Supervising attorney 3/16/2006 1/15/2025 18 11012.67 11909
Professional Srvcs. IV - Supervising attorney 11/15/2008 1/15/2025 16 10535.38 11611
Professional Srvcs. IV - Supervising attorney 3/15/2007 1/15/2025 17 10435.98 11611
Professional Srvcs. IV - Supervising attorney 4/1/2006 1/15/2025 18 9895.45 10707
Professional Srvcs. IV - Supervising attorney 12/4/2023 1/15/2025 01 9103.5 8730

1/15/2025
1/15/2025

Professional Srvcs. II - Attorney I 5/8/2023 1/15/2025 01 6519.08 8021
Professional Srvcs. III - Attorney II 3/25/2024 1/15/2025 00 8047.49 8695
Professional Srvcs. III - Attorney II 4/15/2024 1/15/2025 00 7068.6 8021
Professional Srvcs. II - Attorney I 10/10/2022 1/15/2025 02 6845.9 8021
Professional Srvcs. III - Attorney II 9/18/2023 1/15/2025 01 8205.29 9053
Professional Srvcs. II - Attorney I VACANT 1/15/2025 00 6125 8021
Professional Srvcs. III - Attorney II 10/15/2021 1/15/2025 03 8205.29 8695
Professional Srvcs. III - Attorney II 11/15/2021 1/15/2025 03 7214.16 8021
Professional Srvcs. II - Attorney I VACANT 1/15/2025 00 6250 8021
Professional Srvcs. II - Attorney I VACANT 1/15/2025 00 6250 8021
Professional Srvcs. II - Attorney I VACANT 1/15/2025 6450 8021
Professional Srvcs. III - Attorney II 1/17/2014 1/15/2025 10 8423.28 9053
Professional Srvcs. III - Attorney II 7/18/2019 1/15/2025 05 8404.4 9053
Professional Srvcs. III - Attorney II 2/27/2012 1/15/2025 12 8907.96 9428

1/15/2025
Adm. Svcs. IV - Admin Asst. II 4/2/2024 1/15/2025 00 4284 4491
Adm. Svcs. IV - Admin Asst. II 11/4/2024 1/15/2025 00 3800 4491
Adm. Svcs. IV - Admin Asst. II 9/4/2015 1/15/2025 09 4584.32 5236
Adm. Svcs. IV - Admin Asst. II 8/17/2023 1/15/2025 01 4189.5 4491
Adm. Svcs. IV - Admin Asst. II 4/1/2007 1/15/2025 17 4932.72 6110
Adm. Svcs. IV - Admin Asst. II 7/5/2011 1/15/2025 13 4858.88 5652
Adm. Svcs. IV - Admin Asst. II 2/11/2020 1/15/2025 04 4351.36 4847
Adm. Svcs. IV - Admin Asst. II 7/1/2015 1/15/2025 00 4149.6 4491
Adm. Svcs. IV - Admin Asst. II 3/11/2024 1/15/2025 00 4200 4491

1/15/2025

#31102
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Adm. Svcs. IV - Admin Asst. II 8/12/2015 1/15/2025 09 4858.88 5648
Adm. Svcs. IV - Admin Asst. II 3/28/2022 1/15/2025 02 4338.88 5032

1/15/2025
Admn. Svcs. V - Legal Asst. II 6/25/2007 1/15/2025 17 5508.36 6938
Admn. Svcs. V - Legal Asst. II 3/20/2012 1/15/2025 12 5270.82 6290
Admn. Svcs. V - Legal Asst. II 10/7/2013 1/15/2025 11 5049.2 6051
Admn.  Svcs. V - Admin. Staff Officer I 7/29/2024 1/15/2025 00 4450 5391
Admn.  Svcs. V - Admin. Staff Officer I 7/22/2024 1/15/2025 00 4450 5391
Admn. Svcs. V - Admin Officer II 12/15/2014 1/15/2025 10 5795.92 6051
Pro. Svcs. III - Lead Investigator 9/18/2023 1/15/2025 01 4849.84 5391

1/15/2025
Fiscal Svcs. V - Acct. Budget Spec. 11/2/2009 1/15/2025 15 8161.92 9681

1/15/2025
non classified 1/27/2014 1/15/2025 10 11188.02 12833.47
non classified - appointed 4/15/2009 1/15/2025 15 13113.36 14259.41

Total for biennium wage only -1028913.98

.l J 



Difference Exceptions to placement
-41.31

-896.33 Reaches the top of the current omb scale
-1075.62
-1175.02

-811.55
373.5

Total for supervisors
-3626.33

-1501.92
-647.51 Increased step to 4 based on prior PD exp

-952.4
-1175.1
-847.71 increased to step 5 based upon experience

-1896
-489.71 Increased step to 4 based on prior PD exp
-806.84

-1771
-1771
-1571

-629.72
-648.6 Increased to step 5 based upon experience

-520.04
Total for Attorneys -15228.55

-207
-691

-651.68
-301.5

-1177.28
-793.12
-495.64

-341.4
-291



-789.12
-693.12

Total for Admin. Asst -6431.86
-1429.64 Reaches the top of the current omb scale
-1019.18

-1001.8 Step 5 time in position
-941
-941

-255.08
-541.16

-1519.08
Total for Other -7647.94

-1645.45
-1146.05

Total for Exec -2791.5

Total for ALL -35726.18
Total per m with tax -42871.42
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I\ Commission on Legal Counsel for Indigents -Budget No.188 
11.egisialiveCounal~ Agency Worksheet - Senate Bill No. 2022 

2025-27 Biennium Base Level 

2025-27 Onaoina Funding Chanaes 
Base payroll changes 
Salarv increase 
Health Insurance increase 
Adds Private investiaator FTE Positions 
Adds funding to implement a new compensation 
strateav 
Adds funding to increase the contract rate paid to 
attorneys 
Adds funding to replace the 2023-25 new FTE pool 
Adds fundinQ to replace the 2023-25 vacant FTE 
Adds funding for information technology rate 
increases 

Total ongoing funding changes 

One-Time Funding Items 
No one-time funding items 

Total one-time funding changes 

Total Changes to Base Level Funding 
2025-27 Total Funding 

Federal funds included m other funds 

Total ongoing changes - Percentage of base level 
Total changes - Percentage of base level 

FTE 
Positions 

41.00 

2.00 

2.00 

0.00 

2.00 

43.00 

4.9% 
4.9% 

Burgum Budget 

General 
Fund 

$20,999,305 

$461,575 
252,222 
362,120 
805,000 

1,500,000 

137,781 
253,594 
43,971 

$3,816,263 

$0 

$3,816,263 

$24,815,568 

11f2% 
18.2% 

Other 
Funds 
$2,023,067 

$13 170 
6 005 

7,134 
4,886 

$31,195 

$0 

$31,195 

$2,054,262 
$0 

1.5% 
1.5% 

,_ 

Total 
$23,022,372 

$0 
474 745 
258,227 
362,120 

805,000 

1,500,000 

137,781 
260,728 
48,857 

$3,847,458 

$0 

$0 

$3,847,458 

$26,869,830 

16.7% 
16.7% 

FTE 
Positions 

41.00 

2.00 

2.00 

0.00 

2.00 

43.00 

4.9% 
4.9% 

Annstrona Budget 

General 
Fund 

$20,999,305 

$377,323 
252,222 
362,120 
805,000 

2,000,000 

137,781 
253 594 
43,971 

$4,232,011 

$0 

$4,232,011 

$25,231,316 

20.2% 
20.2% 

Other 
Funds 
$2,023,067 

$10,765 
6,005 

7,134 
4,886 

$28,790 

$0 

$28,790 

$2,051 ,857 
$0 

1.4% 
1.4% 

Total 
$23,022,372 

$0 
388,088 
258,227 
362,120 
805,000 

2,000,000 

137,781 
~ 0,728 

48,BSf 

$4,260,801 

$0 

$0 

$4,260,801 

$27,283,173 

18.5% 
18.5% 

( 
January 20, 2025 

Armstrong Budget Compared to Burgum Budget 

FTE 
Positions 

0.00 

0.00 

0.00 

0.00 

0.00 

NIA 
NIA 

Increase (Decrease) 
General 

Fund 
$0 

($84,252) 

500,000 

$415,748 

$0 

$415,748 

$415,748 

NIA 
NIA 

Other 
Funds 

$0 

($2,405) 

($2,405) 

$0 

($2,405) 

($2,405) 
$0 

NIA 
NIA 

,_ 
,_ 

Total 
$0 

$0 

J!!S&ffi 
0 - 0 -- 0 

500,000 

0 
ii 
0 

$41 3,343 

$0 
~ " 

$0 

$413,343 

$413,343 

NIA 
NIA 



2025 SENATE STANDING COMMITTEE MINUTES 

Appropriations - Government Operations Division 
Red River Room, State Capitol 

SB 2022 
1/22/2025 

A BILL for an Act to provide an appropriation for defraying the expenses of the 
commission on legal counsel for indigents 

10:13 a.m. Chairman Wanzek opened the hearing. 

Members present: Chairman Wanzek, Vice-Chair Dwyer, Senator Burckhard, Senator 
Erbele, and Senator Sickler. 

Discussion Topics: 
• Employee classification status
• Non-competetive Commission pay

10:14 p.m. Chairman Wanzek will schedule a meeting after Mr. Finck's advisory 
board meeting. 

10:15 p.m. Chairman Wanzek closed the hearing.  

Carol Thompson, Committee Clerk 



2025 SENATE STANDING COMMITTEE MINUTES 

Appropriations - Government Operations Division 
Red River Room, State Capitol 

SB 2022 
1/28/2025 

A BILL for an Act to provide an appropriation for defraying the expenses of the 
commission on legal counsel for indigents 

10:06 a.m. Chairman Wanzek opened the hearing. 

Members present: Chairman Wanzek, Vice-Chair Dwyer, Senator Burckhard, Senator 
Erbele, and Senator Sickler. 

Discussion Topics: 
• New and Vacant Full Time Employee (FTE) Pool
• Employee retention and classification status
• Attorney funding
• Salary parity
• Case-load outsourcing 

10:07 a.m. Brady Larson, Assistant Legislative Budget Analyst, supplied budget information       
and submitted testimony #32154 and #32565. 

10:11 a.m. Travis Fink, Director of the ND Commission on Legal Counsel for Indigents,       
testified in favor. 

10:39 a.m. Senator Dwyer moved to amend SB 2022, removing 805,000 from the       
Armstrong Budget, and adding in the Legislative policy change to declassify the       
attorneys in the Indigent Counsel testimony #32565.

Senator Burckhard seconded the motion. 

      Senators Vote 
Senator Terry M. Wanzek Y 
Senator Randy A. Burckhard Y 
Senator Michael Dwyer Y 
Senator Robert Erbele Y 
Senator Jonathan Sickler Y 

     Motion passed 5-0-0 

     10:45 a.m. Senator Dwyer moved a Do Pass as amended for SB 2022. 
      Senator Burckhard seconded the motion. 

     Senators Vote 
Senator Terry M. Wanzek Y 
Senator Randy A. Burckhard Y 
Senator Michael Dwyer Y 



Senate Appropriations Government Operations Division 
SB 2022 
01/28/25 
Page 2  

Senator Robert Erbele Y 
Senator Jonathan Sickler Y 

      Motion passed 5-0-0 

      Senator Dwyer will carry the bill. 

10:47 a.m. Chairman Wanzek closed the meeting.  

Carol Thompson, Committee Clerk 



Commission on Legal Counsel for Indigents - Budget No. 188 
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Agency Worksheet - Senate Bill No. 2022
IS au,e ncl 

2025-27 Biennium Base Level 

2025-27 Onaoing Fundina Chanaes 
Salarv increase 
Health insurance increase 

Adds private investigator FTE positions 
Adds funding to implement a new compensation 
strategy 

Adds funding to increase the contract rate paid to 
attorneys 

Adds fundinci to replace the 2023-25 new FTE pool 

Adds funding to replace the 2023-25 vacant FTE pool 

Adds funding for information technology rate 
increases 

Total ongoing funding changes 

One-Time Funding Items 

No one-time funding items 

Total one-time funding changes 

Total Changes to Base Level Funding 

2025-27 Total Funding 

Federal funds included in other funds 

Total ongoing changes - Percentage of base level

Total changes - Percentage of base level

FTE 

Positions 

41.00 

2.00 

2.00 

0.00 

2.00 

43.00 

4.9% 

4.9% 

Armstrong Executive Budaet 

General 

Fund 

$20,999,305 

$377,323 
252,222 
362,120 

805,000 

2,000,000 

137,781 
253,594 

43,971 

$4,232,011 

$0 

$4,232,011 

$25,231,316 

20.2% 

20.2% 

Other 

Funds 

$2,023,067 

$10,765 
6,005 

7,134 

4,886 

$28,790 

$0 

$28,790 

$2,051,857 

$0 

1.4% 

1.4% 

Other Sections in Commission on Legal Counsel for Indigents - Budget No. 188 

Section Description Armstrong Executive Budget 

Total 

$23,022,372 

$388,088 

258,227 

362,120 
805,000 

2,000,000 

137,781 

260,728 

48,857 

$4,260,801 

$0 

$0 

$4,260,801 

$27,283,173 

18.5% 

18.5% 

FTE positions Section 2 would authorize the agency to increase or decrease FTE 
positions as needed, subject to the availability of funds. 

FTE 

Positions 

41.00 

0.00 

0.00 

0.00 

41.00 

0.0% 

0.0% 

Senate Version 

General 

Fund 

$20,999,305 

$0 

$0 

$0 

$20,999,305 

0.0% 

0.0% 

Other 

Funds 

$2,023,067 

$0 

$0 

$0 

$2,023,067 

$0 

0.0% 

0.0% 

Senate Version 

'6, 2025 

Total 

$23,022,372 

0 
0 
0 

0 

0 

0 
0 

0 

$0 

$0 

$0 

$0 

$23,022,372 

0.0% 

0.0% 
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#32565

25.0189.01001 
Title. 
Fiscal No. 1 

Sixty-ninth 
Legislative Assembly 
of North Dakota 

Introduced by 

Appropriations Committee 

Prepared by the Legislative Council 
staff for Senate Appropriations -
Government Operations Division 
Committee 

January 28, 2025 

PROPOSED AMENDMENTS TO 

SENATE BILL NO. 2022 

1 A BILL for an Act to provide an appropriation for defraying the expenses of the commission on 

2 legal counsel for indigents: and to create and enact a new subsection to section 54-44.3-20 of 

3 the North Dakota Century Code. relating to categories of positions in the state service. 

4 BE IT ENACTED BY THE LEGISLATIVE ASSEMBLY OF NORTH DAKOTA: 

5 SECTION 1. APPROPRIATION. The funds provided in this section, or so much of the funds 

6 as may be necessary, are appropriated out of any moneys in the general fund in the state 

7 treasury, not otherwise appropriated. and from other funds derived from special funds and 

8 federal funds, to the commission on legal counsel for indigents for the purpose of defraying the 

9 expenses of the commission on legal counsel for indigents, for the biennium beginning July 1, 

10 2025. and ending June 30. 2027, as follows: 

11 Adjustments or 

12 

13 Commission on legal oounsel 

14 for indigents 

15 Total all funds 

16 Less other funds 

17 Total general fund 

18 Full time equivalent positions 

19 Commission on legal counsel 

Base Level 

$23,022.372 

$23,022,372 

2.023.067 

$20,999,30§ 

41.00 

$23.022.372 

Page No. 1 

Enhancements 

$0 

$0 

0 

$0 

0.00 

$2,766.753 

Appropriation 

$23.022.372 

$23,022,372 

2,023.067 

$20,999,30§ 

41 .00 

$25,789.1 25 

25.0189.01001 



Sixty-ninth 
Legislative Assembly 

1 for indigents 

2 New and vacant FTE pool 

3 Total all funds 

4 Less other funds 

5 Total general fund 

6 Full-time equivalent positions 

0 

$23,022,372 

2,023,067 

$20.999,305 

41 .00 

554,757 554,757 

$3,321,510 $26,343,882 

26,149 2,049,216 

$3,295.361 $24.294.666 

2.00 43.00 

7 SECTION 2. NEW AND VACANT FTE POOL· LIMITATION • TRANSFER REQUEST. The 

8 commission on legal counsel for indigents may not spend funds appropriated in the new and 

9 vacant FTE pool line item in section 1 of this Act, but may request the office of management and 

10 budget to transfer funds from the new and vacant FTE pool line item to the commission on legal 

11 counsel for indigents line item in accordance with the guidelines and reporting provisions 

12 included in House Bill No. 1015, as approved by the sixty-ninth legislative assembly. 

13 SECTdON 3. A new subsecti0n to section 54-44_3-20 0f the N0rth Dak0ta Cent1:1ry Code is 

14 clieatee and enacted as follows: 

15 j Attorneys employed by the commission on legal counsel for indigents. 
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Bill No. 2022 Fiscal No. 1 25.0189.01 001 s 

STATEMENT OF PURPOSE OF AMENDMENT: 

Senate Bill No. 2022 - Comm. on Legal Counsel for Indigents - Senate Action 

New and vacant FTE pool 
Comm. on Legal Counsel for 

Indigents 

Total all funds 
Less estimated income 
General fund 

FTE 

Base 
Budget 

$23,022,372 

$23,022,372 
2,023,067 

$20,999,305 

41.00 

Senate 
Changes 

$554,757 
2,766,753 

$3,321,510 
26,149 

$3,295,361 

2.00 

Senate 
Version 

$554,757 
25,789,125 

$26,343,882 
2,049,216 

$24,294,666 

43.00 

Department 188 - Comm. on Legal Counsel for Indigents - Detail of Senate Changes 

New and vacant FTE pool 
Comm. on Legal Counsel for 

Indigents 

Total all funds 
Less estimated income 
General fund 

FTE 

New and vacant FTE pool 
Comm. on Legal Counsel for 

Indigents 

Total all funds 
Less estimated income 
General fund 

FTE 

Adds Funding 
for Salary and Adds 

Benefit Investigator 
lncreases1 FTE Positions1 

$646,315 $362,120 

$646,315 $362,120 
16,770 0 

$629,545 $362,120 

0.00 2.00 

Total Senate 
Changes 

$554,757 
2,766,753 

$3,321,510 
26,149 

$3,295,361 

2.00 

Adds Funding Transfers 
to Replace Funding for Adds Funding 

2023-25 New 2025-27 New to Increase the 
and Vacant and Vacant Contract 
FTE PooJl FTE Pool1 Attorney Rate1 

$554,757 
$398,509 (689,048) $2,000,000 

$398,509 ($134,291) $2,000,000 
7,134 (2,641) 0 

$391,375 ($131,650) $2,000,000 

0.00 0.00 0.00 

01/28/2025 

Adds Funding 
for IT Rate 
Increases' 

$48,857 

$48,857 
4,886 

$43,971 

0.00 

1 The following funding is added for 2025-27 biennium salary adjustments of 3 percent on July 1, 2025, and 3 percent 
~ _J_uly_j, 2026,_ and increa~ s in J:!e~lt_h.J!lsur~!)C~ 12remiums frp_l!l J!,§_43 to $1 ,893 per month: 

General 

Sala increase 
Health insurance increase 
Total 

2 Funding of $362, 120 is added from the general fund for 2 new FTE investigator positions. 

3 Funding is added to replace 2023-25 biennium new and vacant FTE pool funding as follows: 
-- - - ---- ---~-G;~~~al - ~~~~r ·-7- Total - 1 

ositions $253 5 4l 1 4.1 2 72 
itions 3 7 

$391 3 

4 Funding of $689,048 for new FTE positions and estimated savings from vacant FTE positions is removed and 
funding of $554,757 is added for a 2025-27 new and vacant FTE pool line item as follows: 

1 of 2 



Bill No. 2022 

FTE ositions 
nt FTE ositions 

ool line item 
s 

Fiscal No. 1 

General 
nd 

25.0189.01001 s 

5 Funding of $2 million from the general fund is added to increase the contract rate paid to attorneys. 

01/28/2025 

6 Funding of $48,857, including $43,971 from the general fund and $4,886 from other funds, is added for IT rate 
increases. 

This amendment also: 
Adds a section regarding the use of funding in the new and vacant FTE pool line item. 
Adds a new subsection to Section 54-44.3-20 to exempt attorneys employed by the Commission on Legal 
Counsel for Indigents from the employee classification system. 
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2025 SENATE STANDING COMMITTEE MINUTES 

Appropriations Committee 
Harvest Room, State Capitol 

SB 2022 
1/30/2025 

A BILL for an Act to provide an appropriation for defraying the expenses of the 
commission on legal counsel for indigents. 

9:15 a.m. Vice-Chair Erbele opened the hearing. 

Members Present: Vice-Chairman Erbele, and Senators Burckhard, Conley, 
Davison, Dever, Dwyer, Mathern, Schaible, Sickler, Sorvaag, Thomas, Wanzek.  
Members Absent: Chairman Bekkedahl, Senators Magrum, Meyer, Cleary.  

Discussion Topics: 
• Service Improvements
• Committee Action

9:15 a.m. Senator Dwyer introduced the bill. 

9:21 a.m. Senator Dwyer moved to adopt the amendment LC 25.0189.01001 and submitted 
testimony #33042. 

9:22 a.m. Senator Burckhard seconded the motion. 

Senators Vote 
Senator Brad Bekkedahl A 
Senator Robert Erbele Y 
Senator Randy A. Burckhard Y 
Senator Sean Cleary A 
Senator Cole Conley Y 
Senator Kyle Davison Y 
Senator Dick Dever Y 
Senator Michael Dwyer Y 
Senator Jeffery J. Magrum A 
Senator Tim Mathern Y 
Senator Scott Meyer A 
Senator Donald Schaible Y 
Senator Jonathan Sickler Y 
Senator Ronald Sorvaag Y 
Senator Paul J. Thomas Y 
Senator Terry M. Wanzek Y 

Motion Passed 12-0-4. 

9:22 a.m. Senator Dwyer moved a Do Pass as Amended. 



Senate Appropriations Committee  
SB 2022 
01/30/2025 
Page 2  
   
9:22 a.m. Senator Burckhard seconded the motion.  

Senators Vote 
Senator Brad Bekkedahl A 
Senator Robert Erbele Y 
Senator Randy A. Burckhard Y 
Senator Sean Cleary A 
Senator Cole Conley Y 
Senator Kyle Davison Y 
Senator Dick Dever Y 
Senator Michael Dwyer Y 
Senator Jeffery J. Magrum A 
Senator Tim Mathern Y 
Senator Scott Meyer A 
Senator Donald Schaible Y 
Senator Jonathan Sickler Y 
Senator Ronald Sorvaag Y 
Senator Paul J. Thomas Y 
Senator Terry M. Wanzek Y 

 
Motion Passed 12-0-4.  
 
Senator Dwyer will carry the bill.  
 
9:23 a.m. Vice-Chair Erbele closed the hearing.  
 
Elizabeth Reiten, Committee Clerk 
 
 



25.0189.01001 
Title.02000 
Fiscal No. 1 

Sixty-ninth 
Legislative Assembly 
of North Dakota 

Introduced by 

Appropriations Committee 

~ l/3o/]r 
Prepared by the Legislative Council i 
staff for Senate Appropriations - 1 0 '1 
Government Operations Division 
Committee 

January 28, 2025 

PROPOSED AMENDMENTS TO 

SENATE BILL NO. 2022 

1 A BILL for an Act to provide an appropriation for defraying the expenses of the commission on 

2 legal counsel for indigents: and to create and enact a new subsection to section 54-44.3-20 of 

3 the North Dakota Century Code, relating to categories of positions in the state service. 

4 BE IT ENACTED BY THE LEGISLATIVE ASSEMBLY OF NORTH DAKOTA: 

5 SECTION 1. APPROPRIATION. The funds provided in this section, or so much of the funds 

6 as may be necessary, are appropriated out of any moneys in the general fund in the state 

7 treasury, not otherwise appropriated, and from other funds derived from special funds and 

8 federal funds, to the commission on legal counsel for indigents for the purpose of defraying the 

9 expenses of the commission on legal counsel for indigents, for the biennium beginning July 1, 

10 2025, and ending June 30, 2027, as follows: 

11 Adjustments or 

12 

13 Commission on legal counsel 

14 for indigents 

15 Total all funds 

16 Less other funds 

17 Total general fund 

18 Full time equi11alent positions 

19 Commission on legal counsel 

Base Level 

$23,022,372 

$23,022,372 

2.02a,061 

$20,999,305 

41.00 

$23,022,372 

Page No. 1 

Enhancements 

$Q 

$0 

Q 

$0 

0.00 

$2,766,753 

Appropriation 

$23,022.372 

$23,022,372 

2,023,067 

$20,999,305 

41.00 

$25,789,125 

25.0189.01001 



Sixty-ninth 
Legislative Assembly 

1 for indigents 

2 New and vacant FTE pool 

3 Total all funds 

4 Less other funds 

5 Total general fund 

6 Ful l-time equivalent positions 

0 

$23,022,372 

2 023 067 

$20,999,305 

41 .00 

554,757 554,757 

$3,321.510 $26,343,882 

26 149 2 049 216 

$3.295,361 $24,294,666 

2.00 43.00 

7 SECTION 2. NEW AND VACANT FTE POOL - LIMITATION - TRANSFER REQUEST. The 

8 commission on legal counsel for indigents may not spend funds appropriated in the new and 

9 vacant FTE pool line item in section 1 of this Act, but may request the office of management and 

10 budget to transfer funds from the new and vacant FTE pool line item to the commission on legal 

11 counsel for indigents line item in accordance with the guidelines and reporting provisions 

12 included in House Bill No. 1015, as approved by the sixty-ninth legislative assembly. 

13 SECTION 3. A new subsection to section 54-44.3-20 of the North Dakota Century Code is 

14 created and enacted as follows: 

15 Attorneys employed by the commission on legal counsel for indigents. 
----~ 
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Bill No. 2022 Fiscal No. 1 25.0189.01001 s 

STATEMENT OF PURPOSE OF AMENDMENT: 

Senate Bill No. 2022 - Comm. on Legal Counsel for Indigents - Senate Action 

1120 - New and vacant FTE 
pool 

7902 - Comm. on Legal 
Counsel for Indigents 

Total all funds 
Less estimated income 
General fund 

FTE 

Base 
Budget 

$23,022,372 

$23,022.372 
2,023,067 

$20,999,305 

41.00 

Senate 
Changes 

$554,757 

2.766,753 

$3,321 ,510 
26,149 

$3,295,361 

2.00 

Senate 
Version 

$554,757 

25,789,125 

$26,343,882 
2,049,216 

$24,294,666 

43.00 

Department 188 - Comm. on Legal Counsel for Indigents - Detail of Senate Changes 

New and vacant FTE pool 
Comm. on Legal Counsel for 

Indigents 

Total all funds 
Less estimated income 
General fund 

FTE 

New and vacant FTE pool 
Comm. on Legal Counsel for 

Indigents 

Total all funds 
Less estimated income 
General fund 

FTE 

Adds Funding 
for Salary and Adds 

Benefit Investigator 
lncreases1 FTE Positions• 

$646,315 $362,120 

$646,315 $362,120 
16,770 0 

$629,545 $362,120 

0.00 2.00 

Total Senate 
Changes 

$554,757 
2,766,753 

$3,321 ,510 
26,149 

$3,295,361 

2.00 

Adds Funding Transfers 
to Replace Funding for Adds Funding 

2023-25 New 2025-27 New to Increase the 
and Vacant and Vacant Contract 
FTE Pool1 FTE Pooll Attorney Rate> 

$554,757 
$398,509 (689,048) $2,000,000 

$398,509 ($134,291} $2,000,000 
7,134 (2,641) 0 

$391,375 ($131 ,650) $2,000,000 

0.00 0.00 0.00 

01/30/2025 

Adds Funding 
for IT Rate 
lncreases1 

$48,857 

$48,857 
4,886 

$43,971 

0.00 

1 The following funding is added for 2025-27 biennium salary adjustments of 3 percent on July 1, 2025, and 3 percent 
on July 1, 2026, and increases in health insurance premiums from $1 ,643 to $1 ,893 per month: 

Salary increase 
Health insurance increase 
Total 

General 
Fund 

$377,323 
252,222 

$629,545 

Other 
Funds 

$10,765 
6.005 

$16,770 

2 Funding of $362,120 is added from the general fund for 2 new FTE investigator positions. 

3 Funding is added to replace 2023-25 biennium new and vacant FTE pool funding as follows: 

Vacant FTE positions 
New FTE positions 
Total 

General 
Fund 

$253,594 
137.781 

$391,375 

Other 
Funds 

$7,134 
Q 

$7,134 

Total 
$388,088 

258,227 
$646,315 

Total 
$260,728 

137.781 
$398,509 

4 Funding of $689,048 for new FTE positions and estimated savings from vacant FTE positions is removed and 
funding of $554,757 is added for a 2025-27 new and vacant FTE pool line item as follows: 
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Bill No. 2022 

New FTE positions 
Vacant FTE positions 
Total 
Funding pool line item 
Net savings 

Fiscal No. 1 25.0189.01001 s 

General 
Fund 

($362,120) 
(318,126) 

($680,246) 
548.596 

($131 ,650) 

Other 
Funds 

$0 
(8,802) 

($8,802) 
6.161 

($2,641) 

5 Funding of $2 million from the general fund is added to increase the contract rate paid to attorneys. 

01 /30/2025 

Total 
($362,120) 

(326,928) 
($689,048) 

554,757 
($134,291) 

6 Funding of $48,857, including $43,971 from the general fund and $4,886 from other funds, is added for IT rate 
increases. 

This amendment also: 
Adds a section regarding the use of funding in the new and vacant FTE pool line item. 
Adds a new subsection to Section 54-44.3-20 to exempt attorneys employed by the Commission on Legal 
Counsel for Indigents from the employee classification system. 
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25.0189.01001 
Title. 
Fiscai No. 1 

Sixty-ninth 
Legislative Assembly 
of North Dakota 

Introduced by 

Appropriations Committee 

Prepared by the Legislative Council 
staff for Senate Appropriations -
Government Operations Division 
Committee 

January 28, 2025 

PROPOSED AMENDMENTS TO 

SENATE BILL NO. 2022 

1 A BILL for an Act to provide an appropriation for defraying the expenses of the commission on 

2 legal counsel for indigents: and to create and enact a new subsection to section 54-44 .3-20 of 

3 the North Dakota Century Code relating to categories of positions in the state service. 

4 BE IT ENACTED BY THE LEGISLATIVE ASSEMBLY OF NORTH DAKOTA: 

5 SECTION 1. APPROPRIATION. The funds provided in this section, or so much of the funds 

6 as may be necessary, are appropriated out of any moneys in the general fund in the state 

7 treasury, not otherwise appropriated, and from other funds derived from special funds and 

8 federal funds, to the commission on legal counsel for indigents for the purpose of defraying the 

9 expenses of the commission on legal counsel for indigents, for the biennium beginning July 1, 

10 2025, and ending June 30, 2027, as follows: 

11 

12 

13 GommissioA OA legal eo1:msel 

14 fer iAdigeAtS 

15 l'otal all ft:.tAdS 

16 Less other ft:.tAds 

17 Total geAeral fuAd 

18 Full time e4:1ui'taleAt positions 

19 Commission on legal counsel 

Base Level 

$23 022,372 

$23,022,372 

2,023 067 

$20,999,306 

41.00 

$23 022 372 

Page No. 1 

Adjustments or 

Enhancements Appropriation 

$1} $23 022 372 

$0 $23,022,372 

0 2 023 067 

$0 $20,999,306 

0.00 41 .00 

$2 766 753 $25 789 125 

25.0189.01001 



Sixty-ninth 
Legislative Assembly 

~ 
1 for indigents 

2 New and vacant FTE pool 0 554.757 554,757 

3 Total all funds $23,022,372 $3,321.510 $26,343,882 

4 Less other funds 2,023,067 26,149 2,049,216 

5 Total general fund $20,999,305 $3,295,361 $24,294,666 

6 Full-time equivalent positions 41 .00 2.00 43.00 

7 SECTION 2. NEW AND VACANT FTE POOL - LIMITATION - TRANSFER REQUEST. The 

8 commission on legal counsel for indigents may not spend funds appropriated in the new and 

9 vacant FTE pool line item in section 1 of this Act, but may request the office of management and 

10 budget to transfer funds from the new and vacant FTE pool line item to the commission on legal 

11 counsel for indigents line item in accordance with the guidelines and reporting provisions 

12 included in House Bill No. 1015, as approved by the sixty-ninth legislative assembly. 

13 SECTION 3. A new subsection to section 54-44.3-20 of the North Dakota Century Code Is 

14 created and enacted as follows: 

15 I k===~~~~~~~~=====o=m==i=ss=io=n==on::±::!:::le::'-!g=al=c=o=u=ns=e=l::;:fo=r:;:::in=d~ig~e==n=ts::;,, _____ _,1 
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Bill No. 2022 Fiscal No. 1 25.0189.01001 s 

STATEMENT OF PURPOSE OF AMENDMENT: 

Senate Bill No. 2022 - Comm. on Legal Counsel for Indigents - Senate Action 

New and vacant FTE pool 
Comm. on Legal Counsel for 

Indigents 

Total all funds 
Less estimated income 
General fund 

FTE 

Base 
Budget 

$23,022,372 

$23,022,372 
2,023,067 

$20,999,305 

41.00 

Senate 
Changes 

$554,757 
2)66,753 

$3,321,510 
26,149 

$3,295,361 

2.00 

Senate 
Version 

$554,757 
25,789,125 

$26,343,882 
2,049,216 

$24,294,666 

43.00 

Department 188 - Comm. on Legal Counsel for Indigents - Detail of Senate Changes 

New and vacant FTE pool 
Comm. on Legal Counsel for 

Indigents 

Total all funds 
Less estimated income 
General fund 

FTE 

New and vacant FTE pool 
Comm. on Legal Counsel for 

Indigents 

Total all funds 
Less estimated income 
General fund 

FTE 

Adds Funding 
for Salary and Adds 

Benefit Investigator 
lncreases1 FTE Positions! 

$646,315 $362,120 

$646,315 $362,120 
16,770 0 

$629,545 $362,1 20 

0.00 2.00 

Total Senate 
Changes 

$554,757 
2,766,753 

$3,321,510 
26,149 

$3,295,361 

2.00 

Adds Funding Transfers 
to Replace Funding for Adds Funding 

2023-25 New 2025-27 New to Increase the 
and Vacant and Vacant Contract 
FTE PooP FTE Poo~ Attorney Ratel 

$554,757 
$398,509 (689,048) $2,000,000 

$398,509 ($134,291) $2,000,000 
7,134 (2,641) 0 

$391,375 ($131 ,650) $2,000,000 

0.00 0.00 0.00 

01/28/2025 

Adds Funding 
for IT Rate 
Increases! 

$48,857 

$48,857 
4,886 

$43,971 

0.00 

1 The following funding is added for 2025-27 biennium salary adjustments of 3 percent on July 1, 2025, and 3 percent 
on_4_~1y_ 1 L.?.,026_. <!n,9 !Q~f~~~s~ ~~ajt~ inJUrc!Q..C.~J)!e!l)i~IT!!:?f!:.C?m _$1_,§43 to $1 ,893 per month: 

General Other 
Fund Funds 

Sala increase 
Health insurance increase 
otal 

2 Funding of $362,120 is added from the general fund for 2 new FTE investigator positions. 

3 Funding is added to replace 2023-25 biennium new and vacant FTE pool funding as follows: -- - - ·- --- ·------- -- ~-- -· - ··-- -- -- -- ----- -·· - -·· 
General Other 

Fund Funds Total 
Vacant FTE positions $253,59A $7,13-4 $260 72 
New FTE positions 137 781 C 137 781 
!Total $391 ,3n $7,13-1 $398,5m 

4 Funding of $689,048 for new FTE positions and estimated savings from vacant FTE positions is removed and 
funding of $554,757 is added for a 2025-27 new and vacant FTE pool line item as follows: 
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Bill No. 2022 Fiscal No. 1 

General 
Fund 

Other 
Funds 

25.0189.01001 s 

Total 

5 Funding of $2 million from the general fund is added to increase the contract rate paid to attorneys. 

01/28/2025 

6 Funding of $48,857, including $43,971 from the general fund and $4,886 from other funds, is added for IT rate 
increases. 

This amendment also: 
Adds a section regarding the use of funding in the new and vacant FTE pool line item. 
Adds a new subsection to Section 54-44.3-20 to exempt attorneys employed by the Commission on Legal 
Counsel for Indigents from the employee classification system. 

2 of 2 
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2025 HOUSE STANDING COMMITTEE MINUTES 

Appropriations - Government Operations Division 
Brynhild Haugland Room, State Capitol 

SB 2022  
3/7/2025 

 
A BILL for an Act to provide an appropriation for defraying the expenses of the 
commission on legal counsel for indigents; relating to categories of positions in the state 
service. 

 
8:30 a.m. Chairman Monson called the meeting to order.  
 
Members Present: Chairman Monson, Vice Chair Brandenburg, Representatives: Bosch, 
Fischer, Kempenich, Meier, Pyle.  

 
Discussion Topics: 

• North Dakota Commission on Legal Counsel for Indigents Statutory Responsibilities  
• ND Legal Counsel Programs 
• Vacant FTEs  
• Fiscal Year Caseload and Breakdown  
• Qualifications for Public Defenders 
• Recruitment for Law Students  
• Loan Repayment Program  
• Criminal Justice Act  
• Public vs Private Sector Comparison  

 
8:31 a.m. Travis Finck, Executive Director, North Dakota Commission on Legal Counsel for 
Indigents, testified in favor and submitted testimony #39315, #39316, and #39317. 
 
9:47 a.m. Leah Viste, Attorney, Fargo Public Defenders Office, testified in favor.  
 
10:03 a.m. Zach Pelham, Chairman, North Dakota Commission on Legal Counsel for 
Indigents, testified in favor.  

 
Additional written testimony:  
 
Alex Cronquist, Fiscal Analyst, Legislative Council, submitted neutral testimony #39520.  
 
10:08 a.m. Chairman Monson closed the meeting.  
 
Madaline Cooper, Committee Clerk 
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SB 2022 
House Appropriations  

Government Operations Division 
March 7, 2025 

Testimony of Travis W. Finck, Executive Director, NDCLCI 
 

Good Morning. Chairman Monson, members of the Committee, my name is Travis 

Finck and I am the Executive Director of the North Dakota Commission on Legal Counsel 

for Indigents (hereinafter "the Commission"). 

I. PURPOSE OF AGENCY AND AGENCY STATUTORY RESPONSIBILITIES. 

The Commission is the agency which provides the attorneys and related services to 

indigent persons when there is a constitutional, statutory, or rule-based right to counsel at 

public expense. The Commission is governed by North Dakota Century Code Chapter 54-

61. Section 54-61-01 provides the Commission was "established for the purpose of 

developing and monitoring a process for the delivery of state-funded legal counsel services 

for indigents which are required under the Constitution of North Dakota and the United 

States Constitution and any applicable statute or court rule. The Commission shall provide 

indigent defense services for indigent individuals determined by the court to be eligible for 

and in need of those services pursuant to standards and policies of the commission 

governing eligibility for such services." 

The Commission has established Guidelines to Determine Eligibility for Indigent 

Defense Services (hereinafter "Guidelines").  For a person to have counsel provided by the 

Commission, the person must apply for services, be found to be "indigent" and it must be a 

type of case in which one has a right to counsel at public expense.  Most of the services 

provided by the Commission are in circumstances in which an individual is charged with a 

crime and jail time is a possible sanction, in juvenile matters, post-conviction matters and 

appeals of all the above. 

There are a few exceptions to which an individual is presumed to be eligible for our 

services.  All children are presumed indigent, regardless of their income or the income of 

their parents, in all matters arising out of the Juvenile Court Act.  Additionally, an 

individual who has an attorney at the trial court level, need not reapply for counsel if they 

wish to appeal.  The trial attorney files the notice of appeal and request for transcript on 

behalf of the indigent person.  In other situation\s, an application must be filled out and 

#39315
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filed with the court.   

When an individual desires counsel or services, application for services is to be 

made on the Commission's standard forms.  However, the Commission does not make the 

determination of whether a specific applicant is eligible for services.  Pursuant to the statute, 

the court makes the determination of eligibility based upon the Guidelines of the 

Commission. 

Under the Guidelines, indigency is determined by looking at income resources, non- 

income resources (assets) of the applicant's household, and exceptional factors that might 

otherwise justify a finding of indigency.  Income guidelines are set at 125% of the federal 

poverty level threshold as defined by the U.S. Department of Health and Human Services.  

The mission of the Commission is "to provide high quality, professional, and effective legal 

representation to eligible clients at reasonable cost to the community." Services should be 

provided only to those persons who are eligible. It continues to be the policy of the 

Commission to seek additional screening and review of applications by the court in 

questionable cases. Additional screening and review are also sought when it appears 

that a person may no longer be eligible, such as when someone who was in jail and 

temporarily unemployed, has bonded out and is now likely employed, and would no 

longer be considered indigent. To help ensure that services are provided only to eligible 

individuals, the Commission also provides training to those persons who make the 

eligibility determinations. However, this is not done as frequently in the past due to 

shortness of staff time and constantly advertising, interviewing and attempting to fill 

positions. 

DELIVERY OF SERVICES 

 The Commission is administered through the administrative office in 

Jamestown. The administrative office coordinates the delivery of indigent defense 

services, assigns counsel, contracts with private attorneys to provide services, staffs the 

public defender offices, provides support services, and provides training to agency 

attorneys and staff.  Attorneys and indigent defense services are provided through full-

time state public defenders in six offices across the state and through private 

contractors.  The public defender offices are led by a supervising/lead attorney who 

reports directly to the Deputy Director. The Deputy Director then reports to the 
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Director. All staff in the public defender offices report to the supervising/lead attorney 

in that office. Our supervising/lead attorneys are provided below: 

Williston Public Defender Office:  VACANT 
Dickinson Public Defender Office: Mr. Kevin McCabe 
Bismarck-Mandan Public Defender Office: Mr. Justin Balzer 
Fargo Public Defender Office: Mr. Monty Mertz 
Grand Forks Public Defender Office: Mr. David Ogren 
Minot Public Defender Office: Mr. Eric Baumann 
 
The Commission also provides services through contracts with private firms.  

This is achieved in the form of monthly contracts for a specified number of cases for a 

predetermined amount of compensation.  In addition, the agency contracts with conflict 

contractors who take conflict cases on a case assignment by case assignment basis. The 

current hourly rate for contractors is $80 per hour.   

 North Dakota Century Code section 54-61-02.1 mandates the Commission “shall 

contract for public defender services at a minimum level of fifty percent of its biennial 

caseload.” During fiscal year 2024, 73% of case assignments were handled by private 

contractors with 27% handled by full time public defenders.  

CASE ASSIGNMENTS 
 

 The Commission uses the term "case assignment" rather than "case" when 

referring to assignments and has defined the term based on case type (such as criminal, 

probation revocation, juvenile delinquency, etc.). "Case assignment" is used so that 

assignment numbers from different areas of the state will mean the same thing across 

the state. For example, a criminal case assignment includes all cases arising from the 

same event whether the prosecution has charged the defendant in multiple complaints, 

each with its own case number, or whether the defendant has been charged in one 

complaint with multiple counts, but one case number. A criminal case assignment that 

includes a felony is a felony assignment, even if some of the charges in the assignment are 

misdemeanors. Thus, it is one felony case assignment where the attorney represents a 

person charged with a felony DUI and with a misdemeanor driving under suspension 

charge, both arising from the same traffic stop. 

 The number of case assignments the agency handles has rebounded from the 

pandemic when courts and cases were slowed.  FY 2021 case assignments rebounded from 
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the COVID low and set a new historical high.  FY 2022 remained at a similar level to FY 

2021.  FY 2023 saw a slight increase, whereas FY 2024 set an all-time record for number of 

cases handled in a fiscal year.  We have also seen an increase over the normal number of 

case assignments in the first few months of the current fiscal year. Furthermore, we have 

noticed a significant increase in the number of violent crime case assignments. The 

increased severity of a case assignment correlates directly with increased cost, as they often 

require investigators, experts, more attorney time, etc.  See Graph 1. 

 It is always difficult to forecast what the case assignment numbers will be in the 

future. The Commission has no control over the number of crimes committed and 

investigated, the number of persons charged, the charges filed and the number of persons 

who apply for services and are found eligible.  One trend we have noticed is the increase in 

the number of felony case assignments compared to misdemeanor case assignments.  

Felony case assignments take more time and thus are more expensive to handle.  See Graph 

1. 

II. AUDIT FINDINGS.  

 The last audit of the Commission did not have any recommendations or findings. 

III. CURRENT BIENNIUM ACCOMPLISHMENTS AND NEXT BIENNIUM 

GOALS AND PLANS. 

ACCOMPLISHMENTS 

 Our attorneys, staff, and contractors continue to do incredible work against all odds 

and for less pay than their counterparts. The ability to present this budget is an honor and a 

privilege to represent such a dedicated group of individuals.   

 The Commission has been able to accomplish some amazing things this current 

biennium thanks to the tireless dedication of the employees and contractors of the 

Commission. The Commission continues to partner with local, state, and national partners 

to provide high quality training for our public defenders, law firms who contract to provide 

services, and criminal defense attorneys across the state.   

 The Commission has also played a major role in the expansion of the pretrial service 

program housed within the Department of Corrections. The Commission did not receive 

any increase funding in relation to the program but has been able to successfully find 
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attorneys to appear at initial appearances with clients.  Additionally, my assignment staff 

have spent numerous extra hours fitting into their already tight assignment schedules the 

assignment of counsel. We have worked with the Court and the Pre-Trial service division of 

DOCR Parole and Probation to streamline a method of screening individuals applying for 

counsel. We have worked out orders in each pilot district to allow for earlier application, 

determination, and appointment of counsel.  The Commission also trains all new pre-trial 

service agents on the guidelines for eligibility for public defense services. 

 The Commission has served on several committees and workgroups to make the 

criminal and juvenile legal systems in North Dakota better.  We have continued to work on 

our state’s response to the mental health crisis.  We have continued to work on issues 

surrounding juveniles and promoting rehabilitation as part of all programming.  Further, we 

have continued to look at ways to better provide services to our clients to meet our 

constitutional mandate without the assistance of any additional state funding. 

 The Commission continues give North Dakota a presence on the national level.  The 

undersigned has been elected to the Board of Directors for the National Association of 

Criminal Defense Lawyers, becoming the first lawyer from North Dakota to serve in that 

capacity.  Further, we continue to consult with other states and leaders in public defense to 

make sure the Commission provides the most constitutionally effective services we can. 

CHALLENGES 

I would like to point out our challenges continue to be the same as they have since I 

have been in administration since 2016.  Continually, our two biggest challenges are the 

employee turnover due to compensation and contractor rate of pay.  We can no longer afford 

to continue to turn a blind eye to these two issues as we are near a state of constitutional failure.    

We have consistently brought information to this legislative body indicating we are vastly 

behind our counterparts in county government prosecutor offices in attorney salaries.  

Additionally, our staff continue to lag similarly classified staff in other government agencies or 

branches.  This is no longer sustainable.  The American Bar Association’s 10 Principles of a 

Public Defense Delivery System provide 10 black letter rules for an efficient system.  Principle 

2 provides “Full-time public defender salaries and benefits should be no less than the salaries 

and benefits for full-time prosecutors”.  This currently does not exist in North Dakota.  We 
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continue to lose qualified lawyers to prosecutor offices who offer higher salaries with their 

additional funding.  In fact, the six largest counties in the state appropriate $38,975,578 for 

prosecutors whereas our biennial budget for the whole state is $22,620,120.  Thus, we are not at 

parity, we are being funded at 53% of the six largest counties. 

Given the lack of funding compared to prosecutors, we have been unable to recruit or 

retain qualified attorneys to our positions based upon salaries we can pay.  We currently have 5 

vacancies out of 20 total full-time attorneys, this is a 25% vacancy.  We were once again forced 

to close one of our offices because we were unable to recruit and staff the attorney position.  In 

closing the office, we reallocated the FTE positions to better serve the public.  Quite simply, it 

is not sustainable to turn over 25% of your workforce on an annual basis.  Graph 2.   

  The next challenge we face is the inability attract private firms to provide contract 

services for the Commission.  Our statute requires the use of private attorneys to serve as 

contractors to handle cases for the Commission. Our current rate of compensation for 

contractors is $80 per hour.  Federal Criminal Justice Act appointments in calendar year 

2024, federal court version of contract public defense, was at the rate of $172/hour, more 

than double the rate we can offer. Last session the Legislative Assembly did fund the 

agency to raise our rate from $75 to $80 an hour, however, the Commission’s increase was 

not the same as the CJA rate increase and we have fallen even further behind. Graph 3. 

  An additional challenge the Commission faces is not having access to qualified 

investigators to serve clients.  Since the inception of the agency, the Commission has relied 

upon using investigators in the private sector to provide services to full-time attorneys and 

contractors.  A lawyer has a duty to investigate all cases to which they are assigned.  We 

have consistently paid $65 per hour to investigators as not to exceed the rate paid to 

attorneys.  It has become increasingly more difficult to find investigators in the private 

sector willing to perform work for the Commission at this rate.  The National Association 

of Public Defenders issued a position paper in May of 2020 on Public Defense Staffing for 

meaningful representation in which it notes “adequate investigation is the most frequent 

reason courts find ineffective assistance of counsel.”  To remedy this problem, the 

Commission did request three FTE positions last session.  The 68th Legislative Assembly 

provided funding for 1 FTE.  This investigator was placed in the Bismarck Office, and you 
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will hear testimony from an attorney in that office as it relates to the effectiveness of having 

an investigator on staff. 

PLANS TO ADDRESS CHALLENGES 

  The first decision package the Commission recommended to the Governor’s office 

was to restore the 3% cut.  Governor Burgum had requested all agencies prepare a budget at 

a 3% cut.  However, this is not feasible for the Commission with an increase in case 

numbers, an increase in the severity of cases and the inability to provide constitutionally 

mandated services within the current budget. 

The Commission did submit as part of our budget a plan to move to a step program for 

classified employees like that used by the Judicial Branch and most county governments.  This 

would put the director salary equal to a district court judge, the deputy director at a rate of a 

magistrate judge, and then equivalent positions would line up according to where they would 

fall on the Courts scale.  A copy of this classification strategy is attached.  Attachment 4.  The 

Senate did not fund this and we have since lost an additional employee. 

Some of the work to meet this goal has already been achieved.  To be competitive with 

the Court and other like governmental agencies, we have had to reclassify several positions.  As 

you can see in Attachment 4, we have begun the process of reclassifying positions and will 

continue to do so.  To fully implement the strategy, we requested an additional $805,000.  

However, since the time we submitted the budget, the Court increased the rate paid to attorneys 

and our request to the Governor is insufficient to put on par with the Court.  This serves to 

demonstrate the inability to compete the Commission has been placed in.  For those reasons, 

we are requesting the legislature fund the compensation schedule we have proposed along with 

adding the increases to be given to all state employees.  The Senate did add a provision to our 

budget exempt our attorneys from classified state employees.   

The third plan we put in with this budget is an attempt to make us competitive with 

other legal systems, primarily the federal government, in competing for private firms willing to 

do contract public defense work.  Currently, we are discussing this contract rate every budget 

cycle.  The uncertainty associated with the low contract rate makes our request to private firms 

unappealing in comparison with the federal government.  To combat this, we have prepared a 
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budget request to fund an increase to the hourly rate at a benchmark of the federal government.  

The Commission approved the rate to be sixty (60) percent of the federal criminal justice act 

rate.  For this budget cycle, the federal rate when preparing the budget was $172 per hour.  

Sixty percent of $172 would have our rate be at $103.20.  Thus, we submitted a request for $5, 

255, 134 to increase our hourly contract rate to $103 per hour.  In the event the legislative 

assembly agrees with this approach.  We will have 60% as the benchmark and all future 

budgets will be requested accordingly.  The Senate appropriated $2,000,000 to increase 

contractor pay which is insufficient to meet our benchmark. 

The final plan we put in place is to address the support staff requirements of an effective 

public defense delivery system.  We have a goal of having a full-time investigator in each 

public defender office.  The American Bar Association (ABA) 10 Principles of a Public 

Defense Delivery System, Principle 9 provides “public defenders should have the assistance 

of investigators, social workers, mitigation specialists, experts and other professionals 

necessary to meet public defense needs.”  In preparation for this budget, I spoke with each 

office, and it is abundantly clear, there is a not enough investigators in the private market 

willing to take our reduced rate to meet our need.  The only way we can provide 

constitutionally mandated effective representation is to have investigators on staff. 

We have had our lead investigator on staff for nearly a year, and the returns have 

been as expected.  The attorneys in that office have praised the ability to have an 

investigator assist in interviewing clients, reviewing discovery looking for defenses, 

locating and interviewing witnesses, preparing for trial, taking photos, etc.  We need an 

investigator in each office given the attorney rules of professional conduct conflict rules 

associated with non-lawyer legal assistants.  With only one investigator on staff, he has 

been tasked with covering the entire state and taking cases in Dickinson, Bismarck, Minot 

and Fargo.  The Senate approved 2 additional FTE which would be investigators. 
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IV. AGENCY REQUESTS/ RECOMMENDATIONS TOTALS, INCLUDING 

FULL TIME EMPLOYEE REQUESTS COMPARED TO CURRENT 

BIENNIUM. 

Current 2023-

2025 biennium 

level 

Requested 

level in 2025-

2027 budget 

Burgum 

Recommendation 

Armstrong 

Recommendation 

Senate 

41 Full Time 

Employees 

46 Full Time 

Employees 

43 Full Time 

employees 

43 Full Time 

employees 

43 FTE 

Implement Step 

program to be 

competitive 

$805,000 for 

employee 

increases 

$805,000 for 

employee 

increases 

$805,000 for 

employee 

increases 

Didn’t give 

any 

additional 

beyond all 

State 

employees 

Pay increase for 

contract 

attorneys, 

currently at $80 

per hour 

Increase to 

60% of CJA 

Rate at cost 

of $5,255,134 

Increase of 

$1,500,000 from 

General Fund to 

increase pay rate 

of contracted 

attorneys  

Increase of 

2,000,000 from 

General Fund to 

increase pay rate 

of contracted 

attorneys 

$2,000,000 

Total funding 

levels 

$21,137,085.88 

General fund 

$2,023,067  

Special fund 

$28,400,805 

General Fund 

$2,035,087 in 

Special Fund 

spending 

authority 

$24,815,568  

General Fund 

$2,054,262 in  

Special Fund 

spending authority 

$ 25,231,316 

General Funds 

$2,051,857 in 

Special Fund 

spending 

authority 

$ 24, 294,666 

General funds 

$2,049,216 in 

Special Fund 

Spending 

authority 
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AGENCY FUNDING 

Traditionally, the Commission has been funded from two sources: the general fund 

and "fund 282" (the indigent defense administration fund). The indigent defense 

administration fund is funded through collection of two statutory fees paid by criminal 

defendants and collected by the Courts: 

1) A $35 indigent defense application fee pursuant to N.D.C.C. § 29-07-01.1; and 

2) The Commission's portion of a $100 court administration fee (the indigent defense/facility 

improvement fee) pursuant to N.D.C.C. § 29-26-22(2). This fee is split pursuant to statute 

between the indigent defense administration fund and the court facilities improvement and 

maintenance fund, with the first $750,000 collected per biennium going to the indigent 

defense administration fund, the next $460,000 going to the court facilities improvement 

and maintenance fund, and any additional collections are split equally between the two.   

The District Courts also have the authority to order reimbursement of attorney fees 

pursuant to NDCC 29-07-01.1 (2).  However, any attorneys' fees that are recouped go into 

the general fund, not fund 282. Those funds are not collected by the Commission, they are 

collected and accounted for by the Court.  The collection of the application fee and indigent 

defense/facility improvement fees is not guaranteed. District Judges, who impose the fees, 

have the discretion to impose or waive the fees in any case.  The spending authority 

authorized by the legislature is more than is biennially collected.  Current biennium 

spending authority will outpace collections and consume any carryover balance from 

previous biennium.  Given this trend, there needs to be a shift from reliance upon fees to 

fund indigent defense to general fund dollars.  The House passed House Bill 1417 which 

eliminates the $35 application fee and the reimbursement of attorney fees.  This will cost 

the Commission $310,000 in special funds collections which is offset by an appropriation in 

HB 1417 of $310,000 from the General Fund. 

EXPENSES 

The major components making up the expenses for the Commission are salaries and 

benefits, professional fees and services (legal fees), ITD expense, and rent of office space. 

As of November 2024, these totaled 96.5 % of our expenditures for the biennium.  These 
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expenses do not account for such things as statutorily mandated training, expenses related 

to representation of an individual in a case assignment such as an expert, or other 

unexpected expenses.  Thus, any increases in case assignments such as the increase we are 

currently seeing this biennium places an extreme challenge to our ability to fund all 

requests for services. 

V. NEW POSITIONS APPROVED IN 2023-25 BIENNIUM. 

The 68th Legislative Assembly provided the Commission with one additional full-

time employee.  The FTE was given to start an on-staff investigator program within the 

agency.  The position was hired as the Lead Investigator and was filled with a starting date 

of September 18, 2023.  $137,781 was originally appropriated for the position and then was 

removed into the vacant/new FTE pool at the end of the last legislative session.  We did 

transfer the $137,781 from the pool upon filling the position and will spend all the amount 

appropriated for the position.  We anticipate we will be requesting the remaining amount 

taken from the budget for the vacant FTE pool given the lack of savings by having vacant 

FTE. 

VI. EMPLOYEE TURNOVER AND THE NUMBER OF VACANT POSITIONS 

TO DATE COMPARED TO SAVINGS REMOVED FROM BUDGET IN 23-

25 BUDGET. 

 Employee turnover has been continually around 25% of our workforce over the last 

several calendar years.  During the 2023-2025 biennium we have turned over 19 full time 

employees of 41 FTE.  This is 46.3% of our entire agency turned over so far this biennium.  

However, as reported to OMB quarterly for the last biennium, vacant FTE spots do not save 

us money.  Of the 19 FTE that left our employ so far this biennium, 11 of those were 

attorneys.  When attorneys leave our agency, we must reassign all of their open cases.  Due 

to increased caseloads stemming from higher case assignment numbers and fewer contract 

and full-time public defenders, we are having to reassign more cases then in the past due to 

turnover.  Typically, these cases are assigned to private contractors who agree to take extra 

cases for extra compensation.  Assigning a case to a contract attorney costs more money 

than if it can be handled by a full-time public defender within the office.  Furthermore, if 
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any expenses were spent on the case by the leaving attorney, the new attorney may have a 

new strategy incurring new expenses. 

 Eight of the remaining positions were administrative staff.  When administrative 

staff leave our employ, we are forced to have attorneys cover some of their duties within the 

offices.  This is inefficient and does not save money as we have to assign more cases to 

contractors because attorneys are covering administrative duties.  The new and vacant FTE 

pool did not save the Commission any funds.  Governor Burgum in his executive 

recommendation noted the deficiency in the new and vacant FTE pool as it relates to our 

Commission and recommended restoring $391, 375 from the general fund and $7,134 from 

the special fund that was removed in 2023-25 budget. 

VII. FUNDING IN EACH PROGRAM/LINE. 

The Commission does not have separate program lines. 

VIII. ONE TIME FUNDING REQUESTS. 

 The Commission did not submit any one-time funding request in this budget.  Our 

budget is focused on meeting the bare minimums to pass constitutional challenge to our 

public defense delivery system in North Dakota. 

IX. IDENTIFY AND JUSTIFY NEED FOR ANY ONE TIME FUNDING 

REQUESTED. 

This is not applicable to our agency. 

X. FEES ASSOCIATED WITH THE AGENCY, APPROPRIATENESS OF THE 

FEES, AND AMOUNTS DEPOSITED. 

The Commission has three main fees associated with our services:   

1) A $35 indigent defense application fee pursuant to N.D.C.C. § 29-07-01.1;  

2) The Commission's portion of a $100 court administration fee (the indigent 

defense/facility improvement fee) pursuant to N.D.C.C. § 29-26-22(2). This 

fee is split pursuant to statute between the indigent defense administration 
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fund and the court facilities improvement and maintenance fund, with the 

first $750,000 collected per biennium going to the indigent defense 

administration fund, the next $460,000 going to the court facilities 

improvement and maintenance fund, and any additional collections are split 

equally between the two; and 

3) The Judge may order reimbursement of attorney fees pursuant to N.D.C.C. § 

29-07-01.1(2).  However, any fees collected pursuant to a judicial order to 

reimburse cost of representation are deposited in the general fund. 

Collections of fees 1 and 2 above are deposited in the Indigent Defense Administration 

fund, or fund 282.  The collections, as mentioned above, have not kept pace with spending 

fund authority.  The table below summarizes collections and expenditures. 

 2019-2021 

Biennium 

2021-2023  

Biennium 

2023-2025  

Biennium to date (End 

of November 2024) 

Collections 1,587,113.58 1,481,223.21 1,014,721.77 

Amount expended 1,701,676.20 1,506,162.83 1,225,825.73 

Spending Authority 1,990,035 1,994,850 2,011,220 

The appropriateness of the collection of fees is an unsettled question.  The 

Commission supported House Bill 1417 in removing the $35 application fee and 

reimbursement of counsel fee.  The American Bar Association 10 Principles provide states 

should not charge an upfront fee for public defense services.  Public defense is one of the 

only, if not THE only constitutionally guaranteed right given to individuals in which they 

are required to pay a fee.  When law enforcement wants to search your home, you don’t 

have to pay a fee to require them to get a warrant exercising your fourth amendment rights.  

Likewise, when you want to say something at a legislative hearing as a citizen, you don’t 

need to pay a fee to exercise your first amendment right. 
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XI. FEDERAL STATE FISCAL RELIEF FUNDS REMAINING TO BE SPENT. 

We did not receive any Federal Funds in the last biennium. 

XII. NEED FOR OTHER SECTIONS TO BE ADDED TO THE BILL. 

 The Commission is consistently reviewing ways in which we can assist the 

legislature in providing public defense services.  One way that has been identified is the 

potential of using federal funds to pay for reimbursement of costs associated with providing 

legal counsel to families in juvenile court.  We have worked with the Department of Health 

and Human Services, Children and Family Services Division, to develop a plan by which 

we would have access to federal title IV-E funds to assist with providing more holistic 

public defense services.  ND DHHS has included in their budget funds to start this program 

since they are the federal pass through for federal IV-E funds.  If funded, we will be 

executing a memorandum of understanding with ND DHHS to create the contracts for those 

public defense services, with the bills to be paid by the Department.  Therefore, it should be 

noted in our budget we have the ability to spend federal funds. 

 Additionally, the Commission must begin to seek alternative funding sources to 

implement our vision of providing holistic services.  This would require the ability to apply 

for and receive federal grants and to be subgrantees on formula grants already given to the 

State of North Dakota.  One such grant that has been identified is the Byrne Jag Formula 

Grant that flows through the Attorney General’s office.  The federal bureau sponsoring 

those grants has indicated the funds may be used for court systems of which certain public 

defense systems would be appropriate subgrantees.  In fact, many state and other 

governmental level public defender offices receive these grants in their respective 

governments.  We do not have an amount submitted with our budget but the use of potential 

grants and alternative fundings sources would need to be approved by the legislature.  At 

this time, we would be requesting a blanket approval to receive and expend other funds for 

the provision of public defender services. 
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XIII. OTHER BILLS BEING CONSIDERED AND POTENTIAL BUDGETARY 

IMPACT. 

There are several bills working their way through the legislative process possessing 

the ability to affect the budget of the Commission.  There are several bills dealing with 

penalty and punishment.  Any increase in penalty or punishment may result in defendant’s 

choosing to exercise their right to a trial versus pleading guilty.  If a case goes to trial, there 

is more time associated with the case and more time means more money expended.  One 

bill that has survived the first half of session that could case fiscal implications is Senate 

Bill 2128.   

Additionally, there are several bills dealing with the amount charged for the fees 

discussed above.  Senate Bill 2057 would increase the Court Administration/Indigent 

Defense Fee from $100 to $200.  However, we are unable to determine a fiscal impact as 

the fee can be waived and it is impossible to ascertain if increasing this fee will lead to any 

further collections.  House Bill 1417 eliminates the $35 indigent defense application fee.  

This would cause a special fund reduction but is offset by an appropriation of $310,000.   

Senate Bill 2226 creates a presumption of indigence for someone who is in custody 

and having an initial appearance.  This bill also has an appropriation of $615,734 or so 

much as may be necessary.  This amount of money will likely save the state from much 

more costly litigation.  Advocacy groups are closely watching an 8th Circuit Court of 

Appeals case that could mandate this type of service be provided by the State.  In fact, the 

American Bar Association has asked me to come out and be on a panel at the ABA Summitt 

on Public Defense discussing this very topic. 

XIV. ADDITIONAL INFORMATION. 

Indigent Defense is a constitutionally mandated program.  We have asked for 

increases  for employees and contractors in the past and have met varying degrees of 

success.  We are continuously asked to trim our requests or what programs we can live 

without.  This is a survival budget.  We would not have asked for any of these packages if 

we did not fee we needed them to survive.  Indigent defense systems around the country are 
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being sued for failure to provide adequate resources.  In Wisconsin, they state public 

defender has been in litigation for not having sufficient resources since 2022.  Idaho has 

been in middle of a lawsuit over their system since 2015.  Louisianna has been in middle of 

a lawsuit since 2017.  Just in 2024, Pennsylvania has been named a defendant in another 

suit alleging indigent defendants are not provided effective representation.  

The Commission is an integral part of the criminal, juvenile and civil legal system in 

the great state of North Dakota.  To continue the administration of the court system in the 

state, the budget we submitted is not a want budget, it is a survival budget.  In my time as 

director of this agency, we have consistently requested to be on a level playing field with 

prosecutors as required by the American Bar Association.  However, with the increases 

prosecutors have received from their respective county governments, we are not even in the 

arena.  Thus, we are at least trying to be competitive with other governmental agencies 

whose budgets are completed by this legislative assembly.  We have been and will always 

continue to be good stewards of the monies entrusted to us.  To meet the challenges of the 

day, we must work together. 

CLOSING 

I want to thank the Committee for your time.  I ask you consider the position in which the 

state finds itself regarding Indigent Defense.  The time is now to fully fund the agency to provide 

constitutionally required services. 

 
 

               Respectfully submitted: 
 
 
 

      _________________________________ 
             Travis W. Finck, Director 
             N.D.  Comm. on Legal Counsel for Indigents 
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Current Job 

Title 
Current Class Current 

Grade 
Proposed Class and Job 

title 
Proposed 

Grade 
Court Grade 

Admin. Asst. I Admin Svc III 103  
(2951-4918) 

Admin Svcs IV 
Admin Asst. - office 

104  
(3508-5847) 

10 
(4158-6106) 

Admin. Asst II Admin Svc 
IV 

104 
(3508-5847) 

Adm Svcs IV 
Adm Asst – Office 

104 
(3508-5847) 

10 
(4158-6106) 

Admin. Asst. II Admin. Svc 
IV 

104 
(3508-5847) 

Adm Svcs IV 
Adm Asst – Executive 

104 
(3508-5847) 

11 
(4480-6594) 

Legal Asst. II Admin. Svcs 
V 

105 
(4163-6938) 

Admn. Svcs. V – 
Legal Assistant 

105 
(4163-6938) 

12 
(4803-7087) 

Admin. Staff 
Officer I 

Admin. Svcs 
V 

105 
(4163-6938) 

Admin. Svcs. V 
Admin. Staff Officer 

105 
(4163-6938) 

12 
(4803-7087) 

Admin. Offcr II Admin. Svcs 
V 

105 
(4163-6938) 

Admin. Svcs. V 
Admin. Officer II 

105 
(4163-6938) 

12 
(4803-7087) 

Investigator 
Lead 

Protective 
Svcs. III 

105 
(4163-6938) 

Protective Svcs. III. 105 
(4163-6938) 

12 
(4803-7087) 

Attorney I Pro. Svcs II 106 
(4971-8285) 

Pro. Svcs III – 
 Attorney 

107 
(5973-9955) 

19 
(7072-10,099) 

Attorney II Pro. Svcs III 107 
(5973-9955) 

Pro. Svcs III – 
 Attorney 

107 
(5973-9955) 

19 
(7072-10,099) 

ACCT SPEC. 
III 

Fiscal Svcs V 106 
(4971-8285) 

Fiscal Svcs VI –  
Finance Director 

107 
(5973-9955) 

19 
(7072-10,099) 

ATTORNEY 
III 

Pro. Svcs. IV 108 
(7146-
11909) 

Pro. Svcs. IV – 
Supervising Atty 

108 
(7146-11909) 

21 
(7743-11603) 

Compensation Strategy for Classified Positions 
North Dakota Commission on Legal Counsel for Indigents

The Commission understands compensation for employment is not a one-time discussion and every year 
employees become more valuable to the agency and its mission due to their increase in skill and knowledge.  
Knowing how and when you may receive salary increases is a key factor in planning your future.  We believe 
consistently rewarding performance strengthens the employment relationship. 

Utilizing a step system for classified positions allows the Commission to hire at entry level, train employees 
while they earn a fair wage, and continuously reward employees for longevity and satisfactory performance.  
This allows for a fair, unbiased and transparent compensation system.  It further allows the Commission to 
compete with other public entities in recruiting and retaining candidates for employment. 

Unless there is a market exception, all new hires start at step one.  Employees who provide satisfactory 
performance are eligible to advance to the next step every odd year on the employee’s anniversary date in pay 
grade.  In addition, if the Legislature provides funding for employee increase, the Commission will adjust the 
step system to maintain market competitiveness.  When this happens, employees will receive the Legislative 
increase on July 1.  Generally, it will take 19 years to reach the final step, step 11. 

The example below shows how the compensation for a typical employee would change over the first 5 years 
of employment with the Commission. 



Attorney 
Employment Start Date of August 1, 2024 

Pay Grade 107 
(5973-9955) 

Step Date Salary Explanation 
1 8/1/2024 $7,355/month Hire step/Employment start date/Anniversary Date 

2 3/1/2025 $7,658/month  1st odd year step increase given on Completion of 
Probationary Period 

2 7/1/2025 $7,658 Legislative 4% increase 

2 7/1/2026 $7,964 (Legislative increase based upon 2025 session) 4% for 
example purposes only 

2 7/1/2027 $8,283 (Legislative increase based upon 2025 session) 4% for 
example purposes only 

3 8/1/2027  2nd odd year step increase given on anniversary date in 
pay grade 

3 7/1/2027  (Legislative increase based upon 2027 session) 

3 7/1/2028  (Legislative increased based upon 2027 session) 

4 8/1/2028  3rd odd year step increase given on anniversary date in 
pay grade 

Position 1 2 3 4 5 6 7 8 9 10 11 
Attorney – 

Public 
Defender 

7,355 7,658 7,973 8,304 8,642 8,999 9,378 9,762 10,166 10,558 11,027 

Supervising 
Attorney 

7,743 8,062 8,394 9,103 9,467 9,856 10,266 10,687 11,130 11,592 12,067 

Admin 
Asst. – PD 

Office 

4,324 4,491 4,670 4,847 5,038 5,236 5,441 5,652 5,878 6,110 6,350 

Admin 
Asst. – 
Exec. 
office 

4,659 4,842 5,032 5,226 5,434 5,648 5,871 6,102 6,343 6,595 6,858 

Legal Asst. 
- paralegal 

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370 

Investigator 
-PD Office 

4,659 4,842 5,032 5,226 5,434 5,648 5,871 6,102 6,343 6,595 6,858 

Investigator 
- Lead 

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370 

Admin 
Officer/ 

Admn Staff 
Officer 

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370 

Accounting 
Manager 

7,015 7,299 7,596 7,907 8,240 8,575 8,929 9,299 9,681 10,084 10,503 
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Purpose of Agency and North Dakota Century Code Implicated:

 - The Commission operating statute is N.D.C.C. 54-61

The Statutory responsibilities of the Commission are found in NDCC 54-61-02
 - The Commission is tasked with developing standards governing the delivery of 

   indigent services.  54-61-02(1)(a)
 - The Commission is tasked with implementing a process of contracting for legal  

  services for indigents.  54-61-02 (1)(b)
 - The Commission is tasked with establishing public defender offices in regions of 

  the state as it considers necessary and appropriate.  54-61-02 (1)(c)
 - The Commission is tasked with establishing a method for accurately tracking and 

  monitoring caseloads of contract counsel and public defenders.  54-61-02 (1)(d)
 - The Commission is tasked with approving and submitting a biennial budget to the 

  Office of Management and Budget.  54-61-02 (1)(e)

 -  The Commission is further given statutory authority to do the following:
  - Enter into agreements with a County or City to provide services in which 

    the County or city would have to provide. 54-61-02(2)
  - Adopt rules for the exercise of its authority.  54-61-02(3)
  - Request records from other agencies to verify indigence.  54-61-02(4)
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The Purpose of the Agency’s Various Programs 
- The Commission is the agency which provides the attorneys and related services to indigent 

persons when there is a constitutional, statutory, or rule-based right to counsel at public 
expense. 

- 54-61-01 provides that the Commission was “established for the purpose of developing and 
monitoring a process for the delivery of state-funded legal counsel services for indigents 
which are required under the Constitution of North Dakota and the United States 
Constitution and any applicable statute or court rule.  The commission shall provide indigent 
defense services for indigent individuals determined by the court to be eligible for and in 
need of those services pursuant to standards and policies of the commission governing 
eligibility for such services.”

- The North Dakota Commission on Legal Counsel for Indigents' mission is to provide high 
quality, professional, and effective legal representation to eligible clients, consistent with the 
guarantees of the constitutions of the United States and North Dakota, and applicable North 
Dakota statutes and rules, at reasonable cost to the community.

- The Commission consists of 7 members: 1 member of the legislature from each house, 2 
appointed by the Governor (one must be from a county of not more than 10 thousand), 2 
appointed by the Chief Justice (one must be from a county with a population of not more 
than 10 thousand) and one member appointed by the Board of Governors, State Bar Assoc.

- The Commission has 7 total offices: 6 regional public defender offices and the administrative 
office in Jamestown.  
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Delivery of Services
 The Commission is administered through the Administrative Office located in Jamestown
 We oversee 6 Regional public defender offices with a supervising attorney in each location:
 Williston Public Defender Office: VACANT
 Dickinson Public Defender Office: Mr. Kevin McCabe
 Bismarck-Mandan Public Defender Office: Mr. Justin Balzer
 Fargo Public Defender Office: Mr. Monty Mertz
 Grand Forks Public Defender Office: Mr. David Ogren
 Minot Public Defender Office: Mr. Eric Baumann
 We also contract with Private law firms to provide public defender services.
 North Dakota Century Code section 54-61-02.1 mandates the Commission “shall contract for 

public defender services at a minimum level of fifty percent of its biennial caseload.” During 
fiscal year 2024, 73% of case assignments were handled by private contractors with 27% 
handled by full time public defenders. 

Case Assignments
 Case assignments need to be limited to allow an attorney to provide a constitutionally effective defense
 Recently, new public defense workload standards were released, and we are nowhere near where we 

should be.  We use 1973 NACC standards, and even with those antiquated standards 66% of our 
attorneys or contractors exceeded case limits last fiscal year.

 Fiscal year 2023 remained high with a slight increase over Fiscal Year 2022.  Fiscal Year 2024 was our 
highest year ever with more of an increase then we predicted, outpacing the slight growth we had seen.
 One Concerning trend we have noticed is we are providing representation on more felonies than 

misdemeanors.
 Felony representation takes more time, and the more serious the felony, the more time the case 

assignment demands.  See Graph 1 NOR T H 
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Report on financial audit findings and actions taken
 The last audit of the Commission did not have any findings or recommendations.

Accomplishments
 Our Attorneys, Staff and Contractors handled a record number of case assignments and 

continue to do incredible work against all odds and for less pay than their counterparts
 Commission continues to work with Pre-Trial Services from the Dept. Of Corrections and 

Rehabilitation to expand that important program
 The Commission continues to be involved on committees and workgroups working to make 

the criminal and juvenile legal systems better in our great state.
 The Commission continues to give the state a presence on the national level. 
 Continued work with other public defense leaders across the country to insure we are 

providing the best possible services within our limitations.

Challenges
 The biggest challenges we face are the same we have been presenting to the Legislature 

since I have been in administration
 Continually our two biggest challenges are employee turnover due to lack of compensation 

and resource parity with other government entities and contractor rate of pay
 We are continually getting closer to constitutional failure due to not meeting the needs 

above
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Challenges: Employee turnover due to lack of compensation and resources
- The American Bar Association’s 10 Principles of a Public Defense Delivery System provide 10 

black letter rules for an efficient public defense system. 
- Principle 2 provides “Full-time public defender salaries and benefits should be no less 

than the salaries and benefits for full-time prosecutors”
- This does not exist in North Dakota. the six largest counties in the state appropriate 

$38,975,578 for prosecutors whereas our biennial budget for the whole state is 
$22,620,120.  Thus, we are not at parity, we are being funded at 53% of the six largest 
counties.  Graph 2

- With the limited resources, we are not able to pay the same as prosecutors and suffer 
unsustainable annual turnover.  Graph 3

- When our agency is fully staffed, we have 20 FTE attorneys.  Right now I have 6 vacant 
positions, with 30% of our attorney positions being vacant.  As I will show later, this 
doesn’t save us any money.

- The most frustrating part of this job is listening to employees in exit interviews talk 
about how they love their job but are leaving because they can make more money 
elsewhere, significantly more. 

Challenges: Contractor Rate of Pay
- Our statute requires us to use contractors on a minimum of 50% of case load.  Because of our 
high turnover, this is currently closer to 73%.  However, it is becoming harder to find persons 
willing to contract

NOR T H 

Dakota I Commission on Legal Counsel far Indigents 
Be Legendary.~ 



Challenges: Contractor Rate of Pay
- The 68th Legislative Assembly gave us funds to move from $75/hour on contract to $80.  
- For Comparison, the Federal Criminal Justice Act paid contract attorney’s $172/hour in 

calendar year 2024.  Thus, even though we got an increase, we fell further behind.  Graph 4
Challenges: Investigative Services 
- The Commission is tasked with not only providing an attorney when there is a right to 

counsel, but providing the necessary services to the attorney to effectuate a constitutionally 
adequate defense.

- As such, the National Association of Public Defenders recommended in 2020 public 
defenders should have access to investigators and “inadequate investigation is the most 
frequent reason courts find ineffective assistance of counsel.”

- American Bar Association 10 Principles of a Public Defense Delivery System, Principle 9 
provides “public defenders should have the assistance of investigators, social workers, 
mitigation specialists, experts and other professionals necessary to meet public defense 
needs”

- At this point we are only asking for the investigators and future plans will deal with 
social workers and mitigation specialists.

- Historically the Commission has relied on private sector investigators, however, the rate we 
can pay them does not lend itself to being able to procure services.

- Thus, we asked the 68th Legislative Assembly to start an investigator program in house asking 
for three FTE.  We received 1 FTE, we did hire that FTE and I believe you will hear about the 
effectiveness of that program.
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Next Biennum Plan and Goals to Address Challenges

- We requested $805,000 to implement a step program for payment of classified employees 
like those used by the Judicial Branch and County Governments

- To achieve this Goal, we developed a reclassification plan to go along with our budget asks.  
We have successfully worked on reclassifications with only one remaining.  Attachment 5.

- We developed a plan to have a benchmark for contractor compensation where all future 
budgets will be set at a percentage of the Federal CJA rate.  The Commission settled at 60% 
and we submitted a budget request ask to increase contractor compensation to $103/hr.

- We addressed the staffing and investigative requirements by asking for 5 additional FTE, 
which would be investigators.  This would place one investigator in each office.

Priori ty Form Name General Fund 

18800 - Commission on Legal 
7,608,474 t"ftun•al #ftp 

01 
Restore cut to General Fund 

643,040 
7,165 

FUND THE AGENCY TO 
IMPLE ENT TH E 

02 COMMISSIO 'S 805,000 
corv PENSAT ION STRATEGY 
7, 166 

3) SET A MOVING RATE OF 
THE FEDERAL 

03 GOVERNM T CO T RACT 5 ,255,134 
RATE AND FU D 
ACCORDINGLY 7,168 

04 Add Private Investigators 7,232 905,300 

State of North Dakota 

Dec•lslon Package Summary 

Biennium 2025-27 
Commission on Legal Counsel for Indigents 

2025-27 Agency Request 

Federal Spe<:ia l Tota l FTE 

- - 7,608,474 5.00 

. . 643,040 -

- - 805,000 -

- - 5,255,134 -

- - 905,300 5 ,00 

NOR TH 

2025-27 Ex.ecutive Recommendatio n 

General Fund Federal Special Total FTE 

3,337,648 - - 3,337,648 2.00 

643,040 - . 643,040 -

805,000 - - 805,000 -

1,500,000 - - 1,500,000 -

389,608 - - 389 ,608 2,00 
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Agency Request/Recommendations Totals compared to current.
Current 2023-2025 biennium level Requested level in 2025-2027 

budget

Burgum Recommendation Armstrong Recommendation Senate

41 Full Time Employees 46 Full Time Employees 43 Full Time employees 43 Full Time employees 43 FTE

Implement Step program to be 

competitive

$805,000 for employee 

increases

$805,000 for employee increases $805,000 for employee increases Didn’t give any additional 

beyond all State employees

Pay increase for contract 

attorneys, currently at $80 per 

hour

Increase to 60% of CJA Rate at 

cost of $5,255,134

Increase of $1,500,000 from General 

Fund to increase pay rate of contracted 

attorneys 

Increase of 2,000,000 from General 

Fund to increase pay rate of 

contracted attorneys

$2,000,000

Total funding levels

$21,137,085.88

General fund

$2,023,067 

Special fund

$28,400,805 General Fund

$2,035,087 in Special Fund 

spending authority

$24,815,568 

General Fund

$2,054,262 in 

Special Fund spending authority

$ 25,231,316 General Funds

$2,051,857 in Special Fund spending 

authority

$ 24, 294,666 General funds

$2,049,216 in

Special Fund

Spending authority
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Funding 
- The Commission is funded through one line 
- The one line consists of the general fund and the Indigent defense administration fund (282)
- Fund 282 is funded through the collection of statutory fees assessed in criminal cases:

1) A $35 indigent defense application fee pursuant to NDCC 29-07-01.1; and
2) A portion of the $100 court administration/indigent defense fee pursuant to NDCC 29-26-

22(2). This fee is split pursuant to statute between the indigent defense administration fund 
and the court facilities improvement and maintenance fund, with the first $750,000 collected 
per biennium going to the indigent defense administration fund, the next $460,000 going to 
the court facilities improvement and maintenance fund, and any additional collections are 
split equally between the two

- The fee’s are collected by the Judiciary and deposited with the State Treasurer.
- The Court may also order Attorney Fee reimbursement which is deposited in the general fund
 The Spending Authority out of the special fund has outpaced the collections.  Thus, there is 
concern we will not collect from fees the level of spending authority governor Burgum proposed. 
Expenses
- The Agency is a single line and must pay for all expenses out of the single line. 
- The major components making up the expenses for the Commission are salaries and benefits, 

professional fees and services (legal fees), ITD expense, and rent of office space
- As of November 2024, these totaled 96.5 % of our expenditures for the biennium. 
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New Positions Approved in 2023-2025 Biennium and Transfers from New FTE Pool
- The 68th Legislative Assembly provided the Commission with one additional full-time 

employee
- The position was hired as the Lead Investigator and was filled with a starting date of 

September 18, 2023.
- $137,781 was originally appropriated for the position and then was removed into the 

vacant/new FTE pool at the end of the last legislative session.
- We did transfer the $137,781 from the pool and anticipate spending all the appropriated 

amount.
Employee Turnover and The Number of Vacant Positions
- Employee turnover has been continually around 25% of our workforce over the last several 

calendar years
- During the 2023-2025 biennium we have turned over 19 full time employees of 41 FTE

- This is 46.3% of our agency has turned over so far this biennium.
- Of the 19 FTE that left our employ so far this biennium, 11 of those were attorneys.

- Forced to reassign all open cases
- Usually have to get a contractor to cover those cases at additional compensation as our 

other offices are too short or overwhelmed to cover
- When administrative staff leaves, our attorneys often end up doing administrative tasks and 

can not take as many cases, so we end up paying for additional contracts
- Governor Burgum restored any monies from the New/Vacant FTE pool seemingly recognizing 

it doesn’t work for our agency.
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Funding in Each Program/Line
- We are a one-time budget and do not have separate programs.
One Time Funding Requests
- The Commission did not submit any one-time funding requests in this budget.
Fees Charged by the Agency, Appropriateness of the Fees, and Amounts Deposited
- The Commission has three fees associated:
 1) A $35 indigent defense application fee pursuant to N.D.C.C. § 29-07-01.1; 
 2) The Commission's portion of a $100 court administration fee (the indigent   

    defense/facility improvement fee) pursuant to N.D.C.C. § 29-26-22(2). This fee is 
    split pursuant to statute between the indigent defense administration fund and the    
    court facilities improvement and maintenance fund, with the first $750,000   
    collected per biennium going to the indigent defense administration fund, the next 
    $460,000 going to the court facilities improvement and maintenance fund, and any 
    additional collections are split equally between the two; and

 3) The Judge may order reimbursement of attorney fees pursuant to N.D.C.C. § 29-07-
     01.1(2).  However, any fees collected pursuant to a judicial order to reimburse cost 

    of representation are deposited in the general fund.
- Collections of the fees are done by the clerk of court.  Collections from Fees 1 and 2 above 

are deposited in Fund 282 according to statutory scheme, Fee number three is deposited in 
the general fund

- Deposits are not keeping pace with spending authority and will need to be replaced with 
general fund dollars See Graph 5
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Fees Charged by the Agency, Appropriateness of the Fees, and Amounts Deposited
2019-2021 Biennium 2021-2023 

Biennium

2023-2025 

Biennium to date (End of November 

2024)

Collections 1,587,113.58 1,481,223.21 1,014,721.77

Amount expended 1,701,676.20 1,506,162.83 1,225,825.73

Spending Authority 1,990,035 1,994,850 2,011,220

The appropriateness of the collection of fees is an unsettled question.  The Commission has 

not yet taken a position on the fees and leaves it to the legislature for determination of 

appropriateness.  However, public defense is one of the only, if not THE only constitutionally 

guaranteed right given to individuals in which they are required to pay a fee.  When law 

enforcement wants to search your home, you don’t have to pay a fee to require them to get a 

warrant exercising your fourth amendment rights.  Likewise, when you want to say something at 

a legislative hearing as a citizen, you don’t need to pay a fee to exercise your first amendment 

right. NOR T H 
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Federal State Fiscal Relief Funds Remaining to Be Spent
- We did not receive any federal funds

Need for Other Sections to be Added to the Bill
- Ability to receive and spend federal and other grant funds

- IV-E Funds for families in Juvenile Court
- Subgrantee of other Formula Grants the State already receives

- Byrne Jag Grant
Other Bills Being Considered and Potential Budgetary Impact
- Any bills dealing with penalty and punishment enhancements or decreases

- Increased penalties we have found leads to more trials, costing more money and 
expenses

- Senate Bill 2128 has mandatory service time is sentenced to prison, which will likely 
cause more cases to go to trial

- Change to the Collection of Fees mentioned above
- Senate Bill 2057 increases the Court Administration/Indigent Defense Fee from $100 - 

$200
- House Bill 1417 Re-Entry study looking at the elimination of fees.

- Eliminates $35 application fee, replaces with $310,000 general fund appropriation
- Senate Bill 2226 Counsel at First Appearances through presumption

- Adds general fund appropriation of $615,734 
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Case type percentages have remained fairly consistent over the years.

Case Types Current Fiscal Year

Adult Criminal Juvenile Appeal/Post Conviction/Other Revocation
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Current Job Title Current Class Current Grade Proposed Class and Job title Proposed Grade Court Grade
Admin. Asst. I Admin Svc III 103 

(2951-4918)
Admin Svcs IV
Admin Asst. - office

104 
(3508-5847)

10
(4158-6106)

Admin. Asst II Admin Svc IV 104
(3508-5847)

Adm Svcs IV
Adm Asst – Office

104
(3508-5847)

10
(4158-6106)

Admin. Asst. II Admin. Svc IV 104
(3508-5847)

Adm Svcs IV
Adm Asst – Executive

104
(3508-5847)

11
(4480-6594)

Legal Asst. II Admin. Svcs V 105
(4163-6938)

Admn. Svcs. V – 
Legal Assistant

105
(4163-6938)

12
(4803-7087)

Admin. Staff Officer I Admin. Svcs V 105
(4163-6938)

Admin. Svcs. V
Admin. Staff Officer

105
(4163-6938)

12
(4803-7087)

Admin. Offcr II Admin. Svcs V 105
(4163-6938)

Admin. Svcs. V
Admin. Officer II

105
(4163-6938)

12
(4803-7087)

Investigator Lead Protective Svcs. III 105
(4163-6938)

Protective Svcs. III. 105
(4163-6938)

12
(4803-7087)

Attorney I Pro. Svcs II 106
(4971-8285)

Pro. Svcs III –
 Attorney

107
(5973-9955)

19
(7072-10,099)

Attorney II Pro. Svcs III 107
(5973-9955)

Pro. Svcs III –
 Attorney

107
(5973-9955)

19
(7072-10,099)

ACCT SPEC. III Fiscal Svcs V 106
(4971-8285)

Fiscal Svcs VI – 
Finance Director

107
(5973-9955)

19
(7072-10,099)

ATTORNEY III Pro. Svcs. IV 108
(7146-11909)

Pro. Svcs. IV –
Supervising Atty

108
(7146-11909)

21
(7743-11603)

Position 1 2 3 4 5 6 7 8 9 10 11
Attorney – 

Public Defender
7,355 7,658 7,973 8,304 8,642 8,999 9,378 9,762 10,166 10,558 11,027

Supervising 
Attorney

7,743 8,062 8,394 9,103 9,467 9,856 10,266 10,687 11,130 11,592 12,067

Admin Asst. – 
PD Office

4,324 4,491 4,670 4,847 5,038 5,236 5,441 5,652 5,878 6,110 6,350

Admin Asst. – 
Exec. office

4,659 4,842 5,032 5,226 5,434 5,648 5,871 6,102 6,343 6,595 6,858

Legal Asst. - 
paralegal

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370

Investigator -PD 
Office

4,659 4,842 5,032 5,226 5,434 5,648 5,871 6,102 6,343 6,595 6,858

Investigator - 
Lead

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370

Admin Officer/ 
Admn Staff 

Officer

4,995 5,193 5,396 5,610 5,829 6,057 6,300 6,550 6,810 7,080 7,370

Accounting 
Manager

7,015 7,299 7,596 7,907 8,240 8,575 8,929 9,299 9,681 10,084 10,503



back

2019-2021 Biennium 2021-2023 Biennium 2023-2025 

Biennium to date 

(End of January 2024)

Collections 1,587,113.58 1,481,223.21 1,113,279.27

Amount expended 1,701,676.20 1,506,162.83 1,276,750.18

Spending Authority 1,990,035 1,994,850 2,011,220

Collection Source 2019-2021 Biennium 2021-2023 Biennium 2023-2025 Biennium to date
(End of January 2025)

$35 Application Fee 308,053.17 312,277.91 230,391.98

$100 Facility Improvement / 
Indigent Defense Fee

1,279,060.41 1,168,945.30 882,887.29

1,587,113.58 1,701,676.20 1,990,035

1,481,223.21 1,506,162.83
1,994,8501,113,279.27 1,276,750.18

2,011,220

0.00

1,000,000.00

2,000,000.00

3,000,000.00

4,000,000.00

5,000,000.00

6,000,000.00

7,000,000.00

Total Collections Total Expenditures Spending Authority

Biennium Comparison

2019-2021 2021-2023 Current Through January 25
0

500,000

1,000,000

1,500,000

2,000,000

2,500,000

2019-2021 2021-2023 2023-2025

Shortfall
Amount Appropriated Amount Collected

Budgeted Shortfall
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l7 Commission on Legal Couns~I for Indigents - Budget No.188 

ilegislatweCooncil~ Agency Worksheet - Senate B1II No. 2022 

2025-27 Biennium Base Level 

2025-27 Onaoina Fundina Chanaes 
Salary increase 
Health insurance increase 
Adds private investigator FTE oositions 
Adds funding to implement a new compensation 
strategy 
Adds funding to replace the 2023-25 new FTE pool 

Adds funding to replace the 2023-25 vacant FTE pool 

Transfers funding for 2025-27 new and vacant FTE 
pool 
Adds funding to increase the contract rate paid to 
attorneys 

Adds funding for information technology rate 
increases 

Total ongoing funding changes 

One-Time Funding Items 

No one-time funding items 

Total one-time funding changes 

Total Changes to Base Level Funding 

2025-27 Total Funding 
Federal funds included m other funds 

Total ongoing changes - Percentage of base level 
Total changes - Percentage of base level 

FTE 
Positions 

41.00 

2.00 

2.00 

0.00 

2.00 

43.00 

4.9% 
4.9% 

Armstrong Executive Budget 

General 
Fund 

$20,999,305 

$377,323 
252,222 
362,120 
805,000 

137,781 
253,594 

2,000,000 

43,971 

$4,232,011 

$0 

$4,232,011 

$25,231 ,316 

20.2% 
20.2% 

Other 
Funds 
$2,023,067 

$10,765 
6,005 

7,134 

4,886 

$28,790 

$0 

$28,790 

$2,051,857 
$0 

1.4% 
1.4% 

Other Sections in Commission on Legal Counsel for Indigents - Budget No. 188 

Section Description Armstrong Executive Budget 

New and vacant FTE pool 

Employee classification 

Total 
$23,022,372 

$388,088 
258,227 
362,120 
805,000 

137,781 
260,728 

0 

2,000,000 

48,857 

$4,260,801 

$0 

$0 

$4,260,801 

$27,283,173 

18.5% 
18.5% 

FTE 
Positions 

41 .00 

2.00 

2.00 

0.00 

2.00 

43.00 

4.9% 
4.9% 

Senate Version 

General 
Fund 

$20,999,305 

$377,323 
252,222 
362,120 

137,781 
253,594 

(131,650) 

2,000,000 

43,971 

$3,295,361 

$0 

$3,295,361 

$24,294,666 

15.7% 
15.7% 

Other 
Funds 
$2,023,067 

$10,765 
6,005 

7,134 

{2,641) 

4,886 

$26,149 

$0 

$26,149 

$2,049,216 

$0 

1.3% 
1.3% 

Senate Version 

Total 
$23,022,372 

388,088 
258,227 
362,120 

0 

137,781 
260,728 

(134,291 ) 

2,000,000 

48,857 

$3,321 ,510 

$0 

$0 

$3,321,510 

$26,343,882 

14.4% 
14.4% 

Section 2 provides language regarding lhe use of funding in the 
new and vacant FTE pool line item. 

Section 3 adds a new subsection to Section 54-44.3-20 to exempt 
attorneys employed by the Commission on Legal Counsel for 
Indigents from the employee classification system. 

( 

FTE 
Positions 

0.00 

0.00 

0.00 

0.00 

0.00 

NIA 
NIA 

Senate Compared to Executive Budget 
Increase (Decrease) 

General 
Fund 

$0 

($805,000) 

(131,650) 

($936,650) 

$0 

($936,650) 

($936,650) 

NIA 
NIA 

Other 
Funds 

$0 

($2,641) 

($2,641) 

$0 

($2,641) 

($2,641) 
$0 

NIA 
NIA 

March 5, 2025 

Total 
$0 

0 
0 
0 

(805,000) 

0 
0 

(134,291) 

0 

0 

($939,291) 

$0 

$0 

($939,291) 

($939,291) 

NIA 
NIA 
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Le~islat1ve Council 

North Dakota Legislative Council 
Prepared for the House Appropriations Committee 

March 7 , 2025 

MAJOR RELATED LEGISLATION AFFECTING THE 
COMMISSION ON LEGAL COUNSEL FOR INDIGENTS 

AS OF CROSSOVER 

This memorandum provides information on major related legislation affecting the Commission on Legal Counsel 
for Indigents as of Crossover: 

House Bill No. 1417 - This bill eliminates fees for the reimbursement of indigent defense costs and expenses and 
provides for a Legislative Management study of court fines and fees. This bill also appropriates $310,000 from the 
general fund to the Commission on Legal Counsel for Indigents to replace revenue from the elimination of indigent 
defense application fees. 

Senate Bill No. 2057 - This bill increases the court administration fee from $100 to $200, a portion of which is 
deposited in the indigent defense fund. 

Senate Bill No. 2226 - This bill appropriates $615,734 from the general fund to the Commission on Legal Counsel 
for Indigents to provide legal counsel services for incarcerated individuals at initial appearances. 



2025 HOUSE STANDING COMMITTEE MINUTES 

Appropriations - Government Operations Division 
Brynhild Haugland Room, State Capitol 

SB 2022 
3/18/2025 

A BILL for an Act to provide an appropriation for defraying the expenses of the 
commission on legal counsel for indigents; relating to categories of positions in the state 
service. 

8:32 a.m. Chairman Monson called the meeting to order. 

Members Present: Chairman Monson, Vice Chair Brandenburg, Representatives: Bosch, 
Fisher, Kempenich, Meier, Pyle.  

Discussion Topics: 
• Application Fees for Legal Counsel
• Initial hearings requirements
• Other bills potential impacts
• Declassification of Attorney
• Salary breakdown for positions in Legal Counsel of Indigents
• Career Builders Loan Repayment

8:33 a.m. Travis Finck, Executive Director, North Dakota Commission on Legal Counsel for 
Indigents, testified in favor.  

8:51 a.m. Chairman Monson referenced previous long sheet #39520. 

8:52 a.m. Travis Finck, Executive Director, North Dakota Commission on Legal Counsel for 
Indigents, testified in favor and continued with previous testimony #39316.  

9:18 a.m. Representative Fisher moved to amend the items that were discussed on the 
long sheet #39520 with adding $310,000 for application fees and contract and 
compensation increased to $2,500.000.   

9:18 a.m. Representative Bosch seconded the motion 

Representatives Vote 
Representative David Monson Y 
Representative Mike Brandenburg AB 
Representative Glenn Bosch Y 
Representative Jay Fisher Y 
Representative Keith Kempenich Y 
Representative Lisa Meier AB 
Representative Brandy L. Pyle Y 

Motion carried 5-0-2. 



House Appropriations - Government Operations Division  
SB 2022 
03/18/2025 
Page 2  
   
9:25 a.m. Chairman Monson closed the meeting.  
 
Madaline Cooper, Committee Clerk 
 
 



2025 HOUSE STANDING COMMITTEE MINUTES 

Appropriations - Government Operations Division 
Brynhild Haugland Room, State Capitol 

SB 2022  
3/24/2025 

 
A BILL for an Act to provide an appropriation for defraying the expenses of the 
commission on legal counsel for indigents; relating to categories of positions in the state 
service. 

 
3:09 p.m. Chairman Monson opened the meeting.   
 
Members Present: Chairman Monson, Vice Chair Brandenburg, Representatives: Bosch, 
Fisher, Kempenich, Meier, Pyle.  

 
Discussion Topics: 

• Application Fee with Legal Counsel  
• Equity funding 
• Employee Declassification System  
• Legal Counsel name change  

 
3:09 p.m. Travis Finck, Executive Director, Commission on Legal Counsel for Indigents, 
testified in favor.  
 
3:30 p.m. Chairman Monson recessed the meeting.  
 
3:43 p.m. Chairman Monson reconvened the meeting.  
 
3:43 p.m. Representative Meier went over amendment LC# 25.0189.02001, #43686 and 
#43687.  
 
3:48 p.m. Representative Meier moved to adopt LC# 25.0189.02001, #43686 and #43687. 
 
3:48 p.m. Representative Bosch seconded the motion.  
 

Representatives Vote 
Representative David Monson Y 
Representative Mike Brandenburg Y 
Representative Glenn Bosch Y 
Representative Jay Fisher AB  
Representative Keith Kempenich Y 
Representative Lisa Meier Y 
Representative Brandy L. Pyle Y 

 
Motion carried 6-0-1.  
 
3:49 p.m. Representative Kempenich introduces amendment LC# 25.0189.02002, #43675.  
 



House Appropriations - Government Operations Division 
SB 2022  
03/24/25 
Page 2  

3:58 p.m. Representative Kempenich moves to further amend to add a study about changing 
the name from Legal Counsel for Indigents to North Dakota Public Defenders Office.  

3:59 p.m. Representative Bosch seconded the motion. 

Representatives Vote 
Representative David Monson Y 
Representative Mike Brandenburg Y 
Representative Glenn Bosch Y 
Representative Jay Fisher AB 
Representative Keith Kempenich Y 
Representative Lisa Meier Y 
Representative Brandy L. Pyle Y 

Motion carried 6-0-1. 

4:00 p.m. Representative Meier moved a Do Pass as further Amended. 

4:01 p.m. Representative Pyle seconded the motion.  

Representatives Vote 
Representative David Monson Y 
Representative Mike Brandenburg Y 
Representative Glenn Bosch Y 
Representative Jay Fisher AB 
Representative Keith Kempenich Y 
Representative Lisa Meier Y 
Representative Brandy L. Pyle Y 

Motion carried 6-0-1.  

Representative Meier will carry the bill. 

Additional written testimony:  

Alex Cronquist, Fiscal Analyst, Legislative Council, submitted testimony #43685, #43686, 
and #43687 

4:04 p.m. Chairman Monson adjourned the meeting. 

Madaline Cooper, Committee Clerk 
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25.0189.02002 
Title . 

Sixty-ninth 
Legislative Assembly 
of North Dakota 

Introduced by 

Appropriations Committee 

Prepared by the Legislative Council 
staff for Representative Kempenich 

March 21 , 2025 

PROPOSED AMENDMENTS TO 
FIRST ENGROSSMENT 

ENGROSSED SENATE BILL NO. 2022 

1 A BILL for an Act to provide an appropriation for defraying the expenses of the commission on 

2 legal counsel for indigents; a-Re-to create and enact a new subsection to section 54-44.3-20 of 

3 the North Dakota Century Code, relating to categories of positions in the state service: and to 

4 amend and reenact section 54-61 -03 of the North Dakota Century Code, relating to the creation 

5 of the public defenders office within the commission on legal counsel for indigents. 

6 BE IT ENACTED BY THE LEGISLATIVE ASSEMBLY OF NORTH DAKOTA: 

7 SECTION 1. APPROPRIATION. The funds provided in this section, or so much of the funds 

8 as may be necessary, are appropriated out of any moneys in the general fund in the state 

9 treasury, not otherwise appropriated, and from other funds derived from special funds and 

10 federal funds, to the commission on legal counsel for indigents for the purpose of defraying the 

11 expenses of the commission on legal counsel for indigents, for the biennium beginning July 1, 

12 2025, and ending June 30, 2027, as follows: 

13 

14 

15 

16 

17 

18 

19 

Commission on legal counsel 

for indigents 

New and vacant FTE pool 

Total all funds 

Less other funds 

Base Level 

$23,022,372 

_Q 

$23,022,372 

2,023,067 

Page No. 1 

Adjustments or 

Enhancements Appropriation 

$2,766,753 $25,789,125 

554,757 554,757 

$3,321.510 $26,343.882 

26 149 2,049.216 

25.0189.02002 



Sixty-ninth 
Legislative Assembly 

1 Total general fund 

2 Full-time equivalent positions 

$20,999,305 

41.00 

$3,295,361 

2.00 

$24,294,666 

43.00 

3 SECTION 2. NEW AND VACANT FTE POOL - LIMITATION - TRANSFER REQUEST. The 

4 commission on legal counsel for indigents may not spend funds appropriated in the new and 

5 vacant FTE pool line item in section 1 of this Act, but may request the office of management and 

6 budget to transfer funds from the new and vacant FTE pool line item to the commission on legal 

7 counsel for indigents line item in accordance with the guidelines and reporting provisions 

8 included in House Bill No. 1015, as approved by the sixty-ninth legislative assembly. 

9 SECTION 3. A new subsection to section 54-44.3-20 of the North Dakota Century Code is 

10 created and enacted as follows: 

11 Attorneys employed by the commission on legal counsel for indigents. 

12 SECTION 4. AMENDMENT. Sectiofl 54-S-1-03 of the Nor.th Dakota Ceritary Co.de is 

13 •amerade.d and reer1acted as follows: 

54-61-03. CemmissioA direetorPublic defenders office - Director - Responsibilities. 14 

15 

16 

17 

18 

19 

20 

" 1. The public defenders office is created under the commission on legal counsel for 

jQdigents. The commissi0n shall ap>point a directorwho must be chosen on the basis 

of tr.aining, exp.erience, and other q1s1alificatior:1s consicler:ed appropriate. The director 

m1s1st be an attorney licens.ed and eligible t0 .practice law ir:i this state at the time of 

appointmer:1t and at all times during service as director. The director may be removed 

for cause by a major;ity vote of commission member:s. 

I 
, ,l 

21 2. The director shall: 

22 

23 

24 

25 

26 

27 

28 

29 

30 

a. Assist tbe commission in developing standards for the delivery of ade(l!uate 

indigent defense servi.ces; 

b. Administer and co0rdinate delivery o.f indigent defense services and supervise 
,.11 , 

compliance with commissiom standards; 

c. Recornme.nd the establishment of public defeneer offices when cor:rsi<:lered 

mecessary and approp11iate to Ure deUvery of adequate indigeAt defer:ise servi•ces; . 

d. Conduct regulartraining pr::ograms for contract coumsel and public defendei;s.; 

e.. Subject to policies and pro.cedures established by the commission, lilire the · 

professional, technical, aml stipport per,sonnel, ir.icluding attorneys to serve as J 

Page No. 2 25.0189.02002 



1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

Sixty-ninth 
Legislative Assembly 

public defenders, considered reasonably necessary for the efficient delivery of 

indigent defense services; 

f. Prepare and submit to the commission a proposed biennial budget for the 

provision of indigent defense services; an annual report containing pertinent data 

on the operation, needs, and costs of the indigent defense contract system and 

any established public defender offices; and any other information as. the 

commission may require; 

g. Submit the annual report required under subdivision f to the legislative council; 

and 

h. Perform other duties as the commission may assign. 

Page No. 3 25.0189. 02002 



March 18, 2025

                  Commission on Legal Counsel for Indigents - Budget No. 188

                  Agency Worksheet - Senate Bill No. 2022

FTE

Positions

General

Fund

Other

Funds Total

FTE

Positions

General

Fund

Other

Funds Total

FTE

Positions

General

Fund

Other

Funds Total

2025-27 Biennium Base Level 41.00 $20,999,305 $2,023,067 $23,022,372 41.00 $20,999,305 $2,023,067 $23,022,372 0.00 $0 $0 $0

2025-27 Ongoing Funding Changes

Salary increase $377,323 $10,765 388,088 $377,323 $10,765 388,088 0

Health insurance increase 252,222 6,005 258,227 252,222 6,005 258,227 0

Adds private investigator FTE positions 2.00 362,120 362,120 2.00 362,120 362,120 0

Adds funding to implement a new compensation 

strategy

0 0 0

Adds funding to replace the 2023-25 new FTE pool 137,781 137,781 137,781 137,781 0

Adds funding to replace the 2023-25 vacant FTE pool 253,594 7,134 260,728 253,594 7,134 260,728 0

Transfers funding for 2025-27 new and vacant FTE 

pool

(131,650) (2,641) (134,291) (131,650) (2,641) (134,291) 0

Adds funding to increase the contract rate paid to 

attorneys

2,000,000 2,000,000 0 0 ($2,000,000) (2,000,000)

Adds funding to implement a new compensation 

strategy and to increase the contract rate paid to 

attorneys

0 2,500,000 2,500,000 2,500,000 2,500,000

Adds funding for information technology rate 

increases

43,971 4,886 48,857 43,971 4,886 48,857 0

Adds funding to replace special funds 0 310,000 310,000 310,000 310,000

Total ongoing funding changes 2.00 $3,295,361 $26,149 $3,321,510 2.00 $4,105,361 $26,149 $4,131,510 0.00 $810,000 $0 $810,000

One-Time Funding Items

No one-time funding items $0 $0 $0

Total one-time funding changes 0.00 $0 $0 $0 0.00 $0 $0 $0 0.00 $0 $0 $0

Total Changes to Base Level Funding 2.00 $3,295,361 $26,149 $3,321,510 2.00 $4,105,361 $26,149 $4,131,510 0.00 $810,000 $0 $810,000

2025-27 Total Funding 43.00 $24,294,666 $2,049,216 $26,343,882 43.00 $25,104,666 $2,049,216 $27,153,882 0.00 $810,000 $0 $810,000

Federal funds included in other funds $0 $0 $0

Total ongoing changes - Percentage of base level 4.9% 15.7% 1.3% 14.4% 4.9% 19.5% 1.3% 17.9% N/A N/A N/A N/A 

Total changes - Percentage of base level 4.9% 15.7% 1.3% 14.4% 4.9% 19.5% 1.3% 17.9% N/A N/A N/A N/A 

Other Sections in Commission on Legal Counsel for Indigents - Budget No. 188

Section 2 provides language regarding the use of funding in the

new and vacant FTE pool line item.

Section Description

House Version House Compared to Senate Version

House Version

Increase (Decrease)

Senate Version

Senate Version

Section 2 provides language regarding the use of funding in the

new and vacant FTE pool line item.

Employee classification Section 3 adds a new subsection to Section 54-44.3-20 to exempt

attorneys employed by the Commission on Legal Counsel for

Indigents from the employee classification system.

Section 3 adds a new subsection to Section 54-44.3-20 to exempt

attorneys employed by the Commission on Legal Counsel for

Indigents from the employee classification system.

New and vacant FTE pool

#43685



25.0189.02001
Title.
Fiscal No. 1

Prepared by the Legislative Council
staff for House Appropriations -
Government Operations Division
Committee

Sixty-ninth
March 18, 2025

Legislative Assembly
of North Dakota

Introduced by

Appropriations Committee

A BILL for an Act to provide an appropriation for defraying the expenses of the commission on 

legal counsel for indigents; and to create and enact a new subsection to section 54-44.3-20 of 

the North Dakota Century Code, relating to categories of positions in the state service.

BE IT ENACTED BY THE LEGISLATIVE ASSEMBLY OF NORTH DAKOTA:

SECTION 1. APPROPRIATION. The funds provided in this section, or so much of the funds 

as may be necessary, are appropriated out of any moneys in the general fund in the state 

treasury, not otherwise appropriated, and from other funds derived from special funds and 

federal funds, to the commission on legal counsel for indigents for the purpose of defraying the 

expenses of the commission on legal counsel for indigents, for the biennium beginning July 1, 

2025, and ending June 30, 2027, as follows:

Adjustments or

Base Level Enhancements Appropriation

Commission on legal counsel                   $23,022,372                $2,766,753          $25,789,125

   for indigents

Commission on legal counsel                   $23,022,372                $3,576,753          $26,599,125

   for indigents

New and vacant FTE pool 0 554,757 554,757

Total all funds                                            $23,022,372                $3,321,510          $26,343,882

Total all funds                                            $23,022,372                $4,131,510          $27,153,882

Page No. 1 25.0189.02001

ENGROSSED SENATE BILL NO. 2022

FIRST ENGROSSMENT
PROPOSED AMENDMENTS TO

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

#43686



Sixty-ninth
Legislative Assembly

Less other funds 2,023,067 26,149 2,049,216

Total general fund                                     $20,999,305                $3,295,361          $24,294,666

Total general fund                                     $20,999,305                $4,105,361          $25,104,666

Full-time equivalent positions 41.00 2.00 43.00

SECTION 2. NEW AND VACANT FTE POOL - LIMITATION - TRANSFER REQUEST. The 

commission on legal counsel for indigents may not spend funds appropriated in the new and 

vacant FTE pool line item in section 1 of this Act, but may request the office of management and 

budget to transfer funds from the new and vacant FTE pool line item to the commission on legal 

counsel for indigents line item in accordance with the guidelines and reporting provisions 

included in House Bill No. 1015, as approved by the sixty-ninth legislative assembly.

SECTION 3. A new subsection to section 54-44.3-20 of the North Dakota Century Code is 

created and enacted as follows:

Attorneys employed by the commission on legal counsel for indigents.
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Bill No. 2022 Fiscal No. 1 25.0189.02001s 03/18/2025

STATEMENT OF PURPOSE OF AMENDMENT:

Senate Bill No. 2022 - Comm. on Legal Counsel for Indigents - House Action

Base
Budget

Senate
Version

House
Changes

House
Version

New and vacant FTE pool $554,757 $554,757
Comm. on Legal Counsel for 

Indigents
$23,022,372 25,789,125 $810,000 26,599,125

Total all funds $23,022,372 $26,343,882 $810,000 $27,153,882
Less estimated income 2,023,067 2,049,216 0 2,049,216
General fund $20,999,305 $24,294,666 $810,000 $25,104,666

FTE 41.00 43.00 0.00 43.00

Department 188 - Comm. on Legal Counsel for Indigents - Detail of House Changes

Adds Funding 
to Replace 

Special Funds1

Adjusts 
Funding for 

Contract 
Attorneys and 

Employee 
Compensation2

Total House 
Changes

New and vacant FTE pool
Comm. on Legal Counsel for 

Indigents
$310,000 $500,000 $810,000

Total all funds $310,000 $500,000 $810,000
Less estimated income 0 0 0
General fund $310,000 $500,000 $810,000

FTE 0.00 0.00 0.00
_______________________

1 Funding of $310,000 from the general fund is added to replace special funds revenue not anticipated to be 
collected.

2 Funding of $500,000 from the general fund is added to provide a total of $2.5 million to increase the contract rate 
paid to attorneys and to implement a new employee compensation strategy.
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#43687



2025 HOUSE STANDING COMMITTEE MINUTES 

Appropriations Committee 
Roughrider Room, State Capitol 

SB 2022 
3/31/2025 

A BILL for an Act to provide an appropriation for defraying the expenses of the 
commission on legal counsel for indigents; relating to categories of positions in the 
state service.   

9:22 a.m. Chairman Vigesaa opened the meeting. 

Members present: Chairman Vigesaa, Representatives Anderson, Berg, Bosch, 
Brandenburg, Fisher, Hanson, Louser, Martinson, Meier, Mitskog, Monson, Murphy, Nathe, 
Nelson, Pyle, Richter, Sanford, Stemen, Wagner 

Members absent: Vice Chairman Kempenich, Representatives: O'Brien, Swiontek 

Discussion Topics: 
• Committee Action

9:23 a.m. Representative Meier explained Amendment LC #25.0189.02003, #44447. 

9:29 a.m. Representative Meier moved Amendment LC #25.0189.02003. 

9:29 a.m. Representative Monson seconded the motion. 

9:29 a.m. Roll Call Vote 
Representatives Vote 

Y 
AB 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 

AB 
Y 

Representative Don Vigesaa 
Representative Keith Kempenich 
Representative Bert Anderson 
Representative Mike Berg 
Representative Glenn Bosch 
Representative Mike Brandenburg 
Representative Jay Fisher 
Representative Karla Rose Hanson 
Representative Scott Louser 
Representative Bob Martinson 
Representative Lisa Meier 
Representative Alisa Mitskog 
Representative David Monson 
Representative Eric J. Murphy 
Representative Mike Nathe 
Representative Jon O. Nelson 
Representative Emily O'Brien 
Representative Brandy L. Pyle 
Representative David Richter Y 



House Appropriations Committee 
SB 2022 
3/31/2025 
Page 2  

Representative Mark Sanford Y 
Representative Gregory Stemen Y 
Representative Steve Swiontek AB 
Representative Scott Wagner Y 

9:29 a.m. Motion passed 20-0-3. 

9:30 a.m. Representative Meier moved Do Pass as Amended. 

9:30 a.m. Representative Monson seconded the motion. 

9:31 a.m. Roll Call Vote 
Representatives Vote 

Y 
AB 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 
Y 

AB 
Y 
Y 
Y 
Y 

AB 

Representative Don Vigesaa 
Representative Keith Kempenich 
Representative Bert Anderson 
Representative Mike Berg 
Representative Glenn Bosch 
Representative Mike Brandenburg 
Representative Jay Fisher 
Representative Karla Rose Hanson 
Representative Scott Louser 
Representative Bob Martinson 
Representative Lisa Meier 
Representative Alisa Mitskog 
Representative David Monson 
Representative Eric J. Murphy 
Representative Mike Nathe 
Representative Jon O. Nelson 
Representative Emily O'Brien 
Representative Brandy L. Pyle 
Representative David Richter 
Representative Mark Sanford 
Representative Gregory Stemen 
Representative Steve Swiontek 
Representative Scott Wagner Y 

9:31 a.m. Motion passed 20-0-3. 

9:31 a.m. Representative Meier will carry the bill. 

9:31 a.m. Chairman Vigesaa closed the meeting. 

Krystal Eberle, Committee Clerk 



25.0189.02003 
Title.03000 
Fiscal No. 2 

Sixty-ninth 
Legislative Assembly 
of North Dakota 

Introduced by 

Appropriations Committee 

Prepared by the Legislative Council 
staff for House Appropriations -
Government Operations Division l 0 
Committee 

PROPOSED AMENDMENTS TO 

FIRST ENGROSSMENT 

March 26, 2025 

ENGROSSED SENATE BILL NO. 2022 

1 A BILL for an Act to provide an appropriation for defraying the expenses of the commission on 

2 legal counsel for indigents; aRG-to create and enact a new subsection to section 54-44.3-20 of 

3 the North Dakota Century Code, relating to categories of positions in the state service: and to 

4 provide for a legislative management study. 

5 BE IT ENACTED BY THE LEGISLATIVE ASSEMBLY OF NORTH DAKOTA: 

6 SECTION 1. APPROPRIATION. The funds provided in this section, or so much of the funds 

7 as may be necessary, are appropriated out of any moneys in the general fund in the state 

8 treasury, not otherwise appropriated, and from other funds derived from special funds and 

9 federal funds, to the commission on legal counsel for indigents for the purpose of defraying the 

10 expenses of the commission on legal counsel for indigents, for the biennium beginning July 1, 

11 2025, and ending June 30, 2027, as follows: 

12 Adjustments or 

13 

14 Commission on legal oounsel 

15 for indigents 

16 Commission on legal counsel 

17 for indigents 

18 New and vacant FTE pool 

19 Total all funds 

Base Level 

$2a,022,a?2 

$23,022,372 

Q 

$2a,022,a?2 

Page No. 1 

Enhancements 

$2,766,75a 

$3,576,753 

554.757 

$a,a21 ,610 

Appropriation 

$25,789,125 

$26,599,125 

554.757 

$26,a4a,ss2 

25.0189.02003 



Sixty-ninth 
Legislative Assembly 

1 I Total all funds 

2 Less other funds 

3 Total general fund 

4 Total general fund 

5 Full-time equivalent positions 

$23,022,372 

2,023,067 

$20,999,805 

$20,999,305 

41.00 

z_cJf3 

$4,131 .510 $27.153,882 

26.149 2,049,216 

$8,295,861 $24,294,666 

$4.105,361 $25.104.666 

2.00 43.00 

6 SECTION 2. NEW AND VACANT FTE POOL - LIMITATION - TRANSFER REQUEST. The 

7 commission on legal counsel for indigents may not spend funds appropriated in the new and 

8 vacant FTE pool line item in section 1 of this Act, but may request the office of management and 

9 budget to transfer funds from the new and vacant FTE pool line item to the commission on legal 

10 counsel for indigents line item in accordance with the guidelines and reporting provisions 

11 included in House Bill No. 1015, as approved by the sixty-ninth legislative assembly. 

12 SECTION 3. A new subsection to section 54-44.3-20 of the North Dakota Century Code is 

13 created and enacted as follows: 

14 Attorneys employed by the commission on legal counsel for indigents. 

15 SECTION 4. LEGISLATIVE MANAGEMENT STUDY - COMMISSION ON LEGAL 

16 COUNSEL FOR INDIGENTS - NORTH DAKOTA PUBLIC DEFENDERS OFFICE. During the 

17 2025-26 interim, the legislative management shall consider studying the potential impacts of 

18 establishing the North Dakota public defenders office as an administrative agency under the 

19 authority of the commission on legal counsel for indigents. The legislative management shall 

20 report its findings and recommendations, together with any legislation required to implement the 

21 recommendations, to the seventieth legislative assembly. 

Page No. 2 25.01 89.02003 



Bill No. 2022 Fiscal No. 2 25.0189.02003s 

STATEMENT OF PURPOSE OF AMENDMENT: 

Senate Bill No. 2022 - Comm. on Legal Counsel for Indigents - House Action 

Base Senate 
Budget Version 

New and vacant FTE pool $554,757 
Comm. on Legal Counsel for $23,022,372 25,789,125 

Indigents 

Total all funds $23,022,372 $26,343,882 
Less estimated income 2,023,067 2,049,216 
General fund $20,999,305 $24,294,666 

House 
Changes 

$810,000 

$810,000 
0 

$810,000 

House 
Version 

$554,757 
26,599,125 

$27,153,882 
2,049,216 

$25,104,666 

FTE 41.00 43.00 0.00 43.00 

Department 188 - Comm. on Legal Counsel for Indigents - Detail of House Changes 

New and vacant FTE pool 
Comm. on Legal Counsel for 

Indigents 

Total all funds 
Less estimated income 
General fund 

FTE 

Adds Funding 
to Replace 

Special Fundsl 

$310,000 

$310,000 
0 

$310,000 

0.00 

Adjusts 
Funding for 

Contract 
Attorneys and 

Employee 
Compensation: 

$500,000 

$500,000 
0 

$500,000 

0.00 

Total House 
Changes 

$810,000 

$810,000 
0 

$810,000 

0.00 

03/26/2025 

JcYf) 

1 Funding of $310,000 from the general fund is added to replace special funds revenue not anticipated to be 
collected. 

2 Funding of $500,000 from the general fund is added to provide a total of $2.5 million to increase the contract rate 
paid to attorneys and to implement a new employee compensation strategy. 

This amendment also provides for a Legislative Management study of the potential impact of establishing the North 
Dakota Public Defenders Office as an administrative agency under the authority of the Commission on Legal Counsel 
for Indigents. 

1 of 1 



Com Standing Committee Report Module ID: h_stcomrep_51_006
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REPORT OF STANDING COMMITTEE
ENGROSSED SB 2022

Appropriations Committee (Rep. Vigesaa, Chairman) recommends AMENDMENTS
(25.0189.02003) and when so amended, recommends DO PASS (20 YEAS, 0 NAYS, 3
ABSENT OR EXCUSED AND NOT VOTING). Engrossed SB 2022 was placed on the Sixth
order on the calendar.
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25.0189.02003 
Title. 
Fiscal No. 2 

Sixty-ninth 
Legislative Assembly 
of North Dakota 

Introduced by 

Appropriations Committee 

Prepared by the Legislative Council 
staff for House Appropriations -
Government Operations Division 
Committee 

PROPOSED AMENDMENTS TO 

FIRST ENGROSSMENT 

March 26, 2025 

ENGROSSED SENATE BILL NO. 2022 

A BILL for an Act to provide an appropriation for defraying the expenses of the commission on 

legal counsel for indigents; aftEl-to create and enact a new subsection to section 54-44.3-20 of 

the North Dakota Century Code, relating to categories of positions in the state service· and to 

provide for a legislative management study. 

BE IT ENACTED BY THE LEGISLATIVE ASSEMBLY OF NORTH DAKOTA: 

SECTION 1. APPROPRIATION. The funds provided in this section, or so much of the funds 

as may be necessary, are appropriated out of any moneys in the general fund in the state 

treasury, not otherwise appropriated, and from other funds derived from special funds and 

federal funds , to the commission on legal counsel for indigents for the purpose of defraying the 

expenses of the commission on legal counsel for indigents, for the biennium beginning July 1, 

2025, and ending June 30, 2027, as follows: 

GommissioR OR legal OOURSel 

for iRdigeRtS 

Commission on legal counsel 

for indigents 

New and vacant FTE pool 

Total all fuRdS 

Base Level · 

$23,022,372 

$23,022,372 

Q 

$23,022,372 

Page No. 1 

Adjustments or 

Enhancements Appropriation 

$2,766,763 $26,789,126 

$3 576 753 $26 599 125 

554 757 554,757 

$3,321,610 $26,343,882 

25.0189.02003 



1 

2 

3 

4 

5 

Sixty-ninth 
Legislative Assembly 

Total all funds 

Less other funds 

Total general fund 

Total general fund 

Full-time equivalent positions 

~_23,022,372 ~4, 131 ,510 $27,1 53,882 

2,023,067 26,149 2,049,216 

$20,999,305 $3,295,361 $24,294,666 

~20,999,305 ~4, 105,361 ~25, 104,666 

41.00 2.00 43.00 

6 SECTION 2. NEW AND VACANT FTE POOL - LIMITATION - TRANSFER REQUEST. The 

7 commission on legal counsel for indigents may not spend funds appropriated in the new and 

8 vacant FTE pool line item in section 1 of this Act, but may request the office of management and 

9 budget to transfer funds from the new and vacant FTE pool line item to the commission on legal 

10 counsel for indigents line item in accordance with the guidelines and reporting provisions 

11 included in House Bill No. 1015, as approved by the sixty-ninth legislative assembly. 

12 SECTION 3. A new subsection to section 54-44.3-20 of the North Dakota Century Code is 

13 created and enacted as follows: 

14 Attorneys employed by the commission on legal counsel for i · 

15 SECTION 4. LEGISLATIVE MANAGEMENT STUDY - COMMISSION ON LEGAL 

16 COUNSEL FOR INDIGENTS - NORTH DAKOTA PUBLIC DEFENDERS OFFICE. During the '-.__/ 

17 2025-26 interim, the legislative management shall consider studying the potential impacts of 

18 establishing the North Dakota public defenders office as an administrative agency under the 

19 authority of the commission on legal counsel for indigents. The legislative management shall 

20 report its findings and recommendations, together with any legislation required to implement the 

21 recommendations, to the seventieth legislative assembly. ·--~-~~--~-~~--

Page No. 2 25.0189.02003 



Bill No. 2022 Fiscal No. 2 25.0189.02003s 

STATEMENT OF PURPOSE OF AMENDMENT: 

Senate Bill No. 2022 - Comm. on Legal Counsel for Indigents - House Action 

Base 
Budget 

New and vacant FTE pool 
Comm. on Legal Counsel for $23,022,372 

Indigents 

Total all funds $23,022,372 
Less estimated income 2,023,067 
General fund $20,999,305 

Senate 
Version 

$554,757 
25,789,125 

$26,343,882 
2,049,216 

$24,294,666 

House 
Changes 

$810,000 

$810,000 
0 

$810,000 

House 
Version 

$554,757 
26,599,125 

$27,153,882 
2,049,216 

$25,104,666 

FTE 41 .00 43.00 0.00 43.00 

Department 188 - Comm. on Legal Counsel for Indigents - Detail of House Changes 

Adjusts 
Funding for 

Contract 
Adds Funding Attorneys and 

to Replace Employee Total House 
Special Funds1 Compensation2 Changes 

New and vacant FTE pool 
Comm. on Legal Counsel for $310,000 $500,000 $810,000 

Indigents 

Total all funds $310,000 $500,000 $810,000 
Less estimated income 0 0 0 
General fund $310,000 $500,000 $810,000 

FTE 0.00 0.00 0.00 

03/26/2025 

1 Funding of $310,000 from the general fund is added to replace special funds revenue not anticipated to be 
collected. 

2 Funding of $500,000 from the general fund is added to provide a total of $2.5 million to increase the contract rate 
paid to attorneys and to implement a new employee compensation strategy. 

This amendment also provides for a Legislative Management study of the potential impact of establishing the North 
Dakota Public Defenders Office as an administrative agency under the authority of the Commission on Legal Counsel 
for Indigents. 

1 of 1 
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